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C h a p t e r 

1
 

Chapter 1 Introduction 
This reference manual is for the EDMI Atlas series of Energy Meters. 

• Mk10 Three Phase Energy Meter (includes Mk10A) 

• Mk10D Three Phase Energy Meter with Disconnect 

• Mk7A Single Phase Energy Meter 

• Mk7C Compact Single phase Energy Meter 

• Mk10E High Performance Three Phase Energy Meter 

It covers the usage and configuration of the meter from a software perspective. 
Examples are used to demonstrate application of the meter features. 

The meter is fundamentally an energy meter, measuring the basic quantities of Wh, varh 
and VAh.  Consumption data may be recorded in a load survey, and as time of use data.  
The meter can also measure a wide variety of instantaneous quantities.  The 
configuration is extremely flexible. 

This edition of the manual is based on version 4.21 of EziView, and version 1.40 of the 
Atlas firmware.  For hardware information on the meters see the Atlas Hardware 
Reference Manual, 1910-E-02.  The contents of this manual were previously published 
as part of that document. 

Using this Manual 
The Chapter 2 “EziView Basics” describes the basics of getting the meter up and 
running, installation, basic operation and meter reading.  The Chapter 3 “Configuration 
Basics” covers basic configuration and how to transfer setup information to the meter.   

These two chapters should be read first, and then the remaining chapters may be read in 
any order as required.   

Before you setup a large number of meters, you should decide how you will use the 
features of the meter consistently within your organisation.  This is particularly 
important in deciding security groupings, and basic setting such as TOU channels. 
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Conventions Used in this Manual 
All dates are in DD/MM/YY format. 

References to settings or controls are printed in Italics. 

The path to a specific menu option is written as: 

 Menu Level 1 →  Menu Level 2 →  Menu Level 3 

Information with special note (such as safety information) is marked with a . 

Additional noteworthy information is marked with a . 

Mk10 Specific information will be marked with a .  The name Mk10 refers to 
either the Mk10, Mk10D, MK10A, or the Mk10E 

Mk7 Specific information will be marked with a  .  The name Mk7 refers to 
either the Mk7A or the Mk7C. 

 “Clicking” on a button or field means using the left mouse button. 

Note that due to variations between computers and improvements in software, the 
screenshots shown in this manual may vary slightly from the appearance of the software 
on your system. 

For more information 
The best source of information should generally be this manual.  The table of contents 
has been organised to make finding information as easy as possible.  If you are still 
having problems though, EDMI support may be contacted via email at support@edmi-
meters.com The EDMI web site is located at http://www.edmi-meters.com/. 

The online help of EziView also has a wealth of information, and contains more 
information on advanced functions of EziView such as the scheduler, script files, and 
reading files. 

When contacting EDMI for support you may be asked for the meter serial number, 
firmware version and EziView version.  The serial number is printed on the label, and is 
the serial number used in EziView to identify the meter.  The EziView version is 
available under Help → About in EziView.   

All this information will help us help you. 
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Chapter 2 EziView Basics 
EziView is a 32 bit Windows application written by EDMI.  EziView is used to 
configure and retrieve data in a user-friendly manner from EDMI energy meters. It can 
keep track of multiple meters spread across multiple sites.  

This chapter covers the installation of EziView and configuring EziView to connect to 
your meters.  The online help in EziView is also a valuable source of information. 

Installation 
EziView version 3.32 or later is required to access the meter.  EziView version 4 or later 
is required for Mk7 meters.  EziView 4.21 is needed to fully support Mk10E and 
Mk10A meters.  It is strongly recommended to use EziView 4.21 or later, to ensure all 
meter features are supported by EziView. 

System Requirements 

• 486, Pentium, or above based personal computer 

• Microsoft Windows™ 98/ME or Windows™ NT4/2000/XP.  (Win3.1 is not 
supported).   

• Vista is supported, although help does not work in 4.08.  Install EziView as an 
Administrator, and run the first time as Administrator. After that it will operate 
properly as a standard user. Help operates correctly in 4.20. 

• At least 50 MB of HDD space, plus space for retrieved meter data. 

To install EziView 

1. Close all active applications. 

2. Insert the EziView software CD in the CD ROM drive, or download EziView from the 
EDMI web site. 

3. Run the setup.exe program from the install package. (In Vista run as Administrator) 
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4. The EziView Installer dialog box appears. Follow the instructions on the screen to 
progress through the installation. 

EziView Tutorial 
This section is a tutorial on using EziView.  Along the way it covers all of the 
information you need to know about the basic use of EziView.  You should have a 
meter connected directly to the computer using an Optical head or an RS-232 link to 
complete this tutorial.   

CD Keys 

EziView uses a system of CD keys to control use of the software. When EziView is first 
run the following screen will be displayed (Figure 2-1). 

 
• Figure 2-1 EziView welcome screen 

Clicking OK will display the CD Key entry dialog (Figure 2-2). 

 
• Figure 2-2 EziView CD key entry dialog 

CD keys may be provided with the CD packaging, on a separate disk or via email.  CD 
keys may either be typed into the Enter CD Key field, or if they are in a file the Load 
CD Keys From File button may be used. 

Depending on your area you should have one or more CD keys.  Each key is a series of 
26 letters or numbers, followed by a customer name.  The customer name must be the 
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same for all keys in use.  New keys may be added after the first run of EziView by using 
the Tools → CD Key option. 

To see what CD keys are in use, change to the View Keys tab (Figure 2-3).  The keys 
that have been entered will be listed in the Keys section.  The Status indicator shows 
whether the currently selected key is valid and active or not.  The Save CD Keys to File 
button may be used to save all the installed CD keys to a file. 

 
• Figure 2-3 EziView CD Key information 

The Meters pane displays any restrictions on what meters the CD keys may be used on.  
The Features pane displays what EziView features are enabled (shown in Bold) by the 
CD keys. 
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• Figure 2-4 EziView System Code confirmation 

With some CD keys EziView will ask for a system code confirmation.  In this case the 
dialog of Figure 2-4 will be displayed.  The indicated code needs to be sent to EDMI or 
your local agent, who will send you the corresponding unlock key.  Email is the easiest 
way to do this, but fax or phone may also be used.  This locks EziView such that it will 
run only on your system. 

Running EziView 

Upon running EziView the main EziView screen is shown, along with a login prompt 
(Figure 2-5).  Use the name “EDMI” and the password “IMDEIMDE” to log into 
EziView.  Stars will be displayed instead of the password for security.  Ignore the Link 
Security field.  Click OK after the username and password has been entered. 

 
• Figure 2-5 EziView login 
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This brings you to EziView’s main screen (Figure 2-6). 

 

 
• Figure 2-6 EziView main screen 

The screen consists of several parts.  The left hand pane shows a diagram of meter sites, 
the right hand pane shows the meters at the selected site (discussed later).  Above each 
pane is a toolbar of actions for the pane.   

Sites 

A meter site represents a connection point to a meter (or meters).  It defines such things 
as the phone number and baud rates.   

Each site contains meters.  The meters in the selected site are listed in the right hand 
pane.  Most connections will have only one meter, but an RS-485 multi-dropped site 
may have many more, all on the same connection defined by the site. 

Clicking on MySite selects it, showing in the Meters pane that it has a single meter (as 
shown in Figure 2-6).  This is a default site installed with EziView as an example, with a 
serial number of 10000000 to indicate that it is not a real meter.  The meter’s name 
defaults to its serial number, which is shown in the second column.  The Address 
column is not used with the Atlas meter. 
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Sites may be nested, like the directory structure on a computer’s disk.  New sites may be 
created within any other site.  Which site a site resides in has no effect, and is purely to 
enable sites to be organised easily.  To this end sites do not need meters, they can simply 
be used for organisation.  For example, a “substations” site might contain a series of 
sites like “substation 543” etc. (See Figure 2-7).  The plus and minus icons on the tree 
diagram may be used to expand and collapse the tree. The Tree menu also contains 
options to expand and collapse the whole tree or parts of it. 

 
• Figure 2-7 EziView main screen with complex site setup 

To create a new site select the site to place the new site under.  Then either right-click 
and select New from the popup menu (Figure 2-8), or click on the New Site button on 
the Sites toolbar (3rd button from the left), or use the File→ New → New Site menu 
option (Figure 2-9).  For this tutorial create a site off the Local site, the root of all sites. 

 
• Figure 2-8 EziView tree diagram new site menu option 
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• Figure 2-9 EziView File menu new site menu option 

This will create a site called SIT0.  To change the name either right-click on it and select 
Rename, or click on the name while it is highlighted.  A new name can then be entered.  
All site names must be unique.  If a site of the same name already exists, a number is 
added to the end to differentiate it.  Site names may contain spaces, and may be any 
length.  Rename the site to “Tutorial Test” (Figure 2-10). 

 
• Figure 2-10 Renaming a site 

Sites may be deleted by choosing delete from the right-click menu, or by pressing the 
delete key, or by selecting File→Delete→Delete Site, or by using the delete toolbar 
button (4th button on the Sites toolbar).  A site may not be deleted if it contains any other 
sites.  Those sites must be deleted first.  A site may also not be deleted if EziView is 
connected to a meter within the site. 
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The properties of the site can now be configured.  Select the site then select properties 
from the right-click menu, or the File menu, or the Site toolbar (2nd button from the left).  
This will display the Site Properties dialog box. 

Site Properties 

 
• Figure 2-11 EziView Site Properties, Name page 

There are four pages to the Site Properties dialog.  The first page, Name (Figure 2-11), 
shows the site name.  This is yet another way to change the site name.  

 
• Figure 2-12 EziView Site Properties, Connection page 

The Connection page (Figure 2-12) allows the method of connection to the meter to be 
configured.  The Connect Using box allows the type of connection to be picked. 

The _Direct option shown in Figure 2-12 uses a serial port on the computer to connect 
directly.  This includes use with optical reader heads, or null modem cables, connected 
to the RS-232 port.  With this option the Port and Baud Rate fields are used to select the 
details of the serial port.  The Baud Rate must be set to the same rate as the meter, which 
defaults to 9600 baud.  The Configure button allows the number of data bits, stop bits, 
parity and flow control to be set.  Unless the meter settings have been changed, these 
may generally be left as their default values of 8 data bits, 1 stop bit, no parity, and no 
flow control.  8 data bits must be used for correct operation with the meter at all times. 
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If using a smart read head with the meter, use this screen to set DTR to be low. This will 
cause the read head to be properly configured for the meter. When using with Genius or 
MK3 meters, DTR should be set to high.  

If any modems are installed in Windows these will appear as options in the Connect 
Using field.  Selecting a modem to use allows properties such as phone number to be 
set.  These settings are not covered in detail in this guide. 

The _Socket protocol option is for connection to a port redirector or Ethernet to serial 
converter using a network.  Enter the network address of the converter, the port number, 
and whether the converter is TCP or UDP based. 

The _ModemPool option is a special option to allow use of EziView modem pools, to 
allow one modem to be allocated from a pool of available modems.  Use of this option 
is not covered here. 

 
• Figure 2-13 EziView Site Properties, Advanced page 

The Advanced page allows a number of specialised settings to be changed that may be 
used to tweak a connection.  Table 2-1 lists the options. 
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Setting Description 
Protocol There are several options listed, but only a few are relevant for this 

meter. 
The “MultiDevice” protocol should be used for the Mk10 or Mk7 meter.  
It allows many different devices to be on the site and the correct 
protocol chosen for each device. For example, Mk3, Mk6, and Mk10 
can all be on the same RS485 bus and communicating simultaneously 
i.e. one message for one device using one protocol, then the next 
message for the next device using another protocol. 
The “AnyDevice” protocol can also be used for the Mk10 or Mk7 meter, 
but is designed for single meters.  It allows any device to be on the site 
and the correct protocol chosen for that device. The serial number is not 
used for EDMI meters allowing it to communicate with any meter. For 
other devices, if the serial number is a general serial number, the 
message is sent as a broadcast message (unit address is 0). Not all 
devices will respond to a broadcast message. 
Other selections are available under the “Custom” option.  
The “General Protocol” protocol is a generic protocol to all EDMI 
meters.  This is the protocol to be used for mapping a site (discussed 
later).  Not all features can be used with this mode, but it does not 
require the serial number to be correct.   
“IEC1107” may be used if the meter has been configured for autoswitch 
to IEC1107, or is in IEC1107 mode. 
Other protocols listed are only useful for other meter types besides the 
Mk10 or Mk7. 

Max Packet Size When using a GPRS communications session, the packet size needs to 
be reduced to make sure the packets can get though.  Default allows 
EziView to generally pick the correct one, but GPRS can be used to 
force smaller packets, and Full can be used to force standard size 
packets.  LON DLC forces very small packets for use with IK30 
concentrators and PLC meters. 

Transmission Mode While the EDMI command line protocol generally only requires a half 
duplex communications link, if the link is known to be full duplex then 
certain optimisations can be made, particularly in upgrading firmware 
remotely.  Normally this can be left in the Default setting, but the Full-
Duplex and Half-Duplex settings can be used to override this. 

Error Count This is the total number of errors counted while communicating with any 
meter on this site. By checking this value, problems such as cable faults 
and bad modem connections will become obvious. 

Timeout EziView waits for a response to a message.  If no response occurs it 
sends the message again. This wait time is called the timeout period 
and is calculated by adding the timeout for the site and the timeout for 
the meter. 
By changing the timeout for the site, the timeout is changed for all 
meters. This is most useful if a site has special characteristics e.g., 
using a low speed mobile modem. 

Retry Count 
Retry Delay 

These options fine-tune the connection to a site. 
Connecting to a site involves dialling a modem or opening a serial port. 
If the serial port is in use by another application, or if the modem does 
not answer, EziView will retry Retry Count number of times.  The delay 
between retries is Retry Delay milliseconds. The settings can be 
overridden per meter. 

Dialback Wait This is the time to wait in milliseconds for a dialback from a meter.  
Failed Logon Delay This is the time to wait after a logon has failed to try the alternate logon. 

• Table 2-1 Site Properties, Advanced page settings 

These settings can generally be left at their default values.   
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• Figure 2-14 EziView Site Properties, Script page 

Finally, the Script page (Figure 2-14) allows a login script to be specified, along with 
parameters for the script.  Login scripts allow EziView to navigate past devices such as 
“Datagates” that allow a single modem connection to be shared.  Details of their usage 
are not covered in this guide. 

Automatically Creating a meter file in a Site 

After creating a site as shown in Figure 3-10, right-click on it and select Map Site.  If the 
option is not available, check the site has no meters in it, and that the protocol is set to 
“General Protocol”.  EziView will automatically look for an attached meter, and add a 
meter to the site.  Note that this will not work for 485 multi-dropped meters – they must 
be added to the site manually.  The Map Site 485 option does not detect Mk10 or Mk7 
meters. 

Manually Creating a meter file in a Site 

This may be used when the automatic method is not possible, for instance on a multi-
dropped site or configuring EziView without access to the meter.   

Create a site, and make sure the connection properties are correct. Setup of connection 
properties is as shown earlier in this section. Make sure that the baud rate and com port is 
set correctly, and set protocol to MultiDevice.  

 
• Figure 2-15 Dropdown menu to create a new meter file 

After creating the site right-click on the right pane.  A dropdown menu as shown in Figure 
2-15 should now be displayed.  Click on New Ins, and a new icon for an MTR file will be 
created.  A default filename will be assigned starting from 1000000000 onward. EziView 
will make sure that the number will be unique and no newly created meter file will be 
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assigned with the same number. Rename the MTR file to the serial number of the meter to 
be connected. Right-click on the newly created meter and select Rename to rename it.  
Note that if the meter name is not 1000000000 or bigger, this operation will just change 
the name, not the serial number, which is also used as an address for the meter. 

 
• Figure 2-16 Meter Properties 

Right-clicking on the meter and selecting Properties brings up a dialog which allows a 
number of properties of the meter itself to be configured.  The first page of this screen 
(Figure 2-16) allows the meter Name to be changed, as well as allows the Model and 
Protocol to be selected.  Model should be set to Mk10 or Mk7 as appropriate.  Protocol can 
generally be left as Default, as it should select the appropriate protocol from the Site 
Properties and other settings.  The other protocol options are listed in Table 2-2 

Protocol Setting Description 
Default The recommended option, which will autoselect the best option 

generally. 

EDMI Command 
Line 

This is the native protocol of the Atlas meters. 

IEC1107-> 
EDMICommandLine 

This attempts to log into the meter through the optical port using 
IEC1107 and then negotiate into EDMI command line.  The meter must 
have IEC1107 functionality and must be configured for autoswitch.  It 
will fall back to trying EDMI command line if IEC1107 fails. 

EDMI MiniE Only generally used for EDMI internal testing. 

EDMI MiniE Packet Used for GPRS communications in combination with UDP. 
LON DLC This is used with an IK30 PLC concentrator to communicate with the 

emter via the concentrator. 

• Table 2-2 General Meter Properties, Protocol settings 

The Logon page allows specific User ID and Password settings to be made.  The Location 
page (Figure 2-17) allows the serial number to be changed, which also acts as the address 
of the meter in multi-drop communications.  The Site can also be changed from here, and 
the site properties can be displayed.  The Address setting has no effect. 
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• Figure 2-17 Meter location 

The Advanced page (Figure 2-18) keeps track of communications errors, and allows per 
meter settings of Timeouts and Retries.   

 
• Figure 2-18 Meter Advanced settings 

The Use Defaults option will get the settings for Retry Count, Timeout and LogTimeout 
from the settings in Tools → Options → General → Connection Screen settings (Figure 
2-22 shows this page).  Use Defaults is the default for a new meter. 

The Advanced Debug option is currently used in conjunction with MultiDrive COM 
Server. So if the meter is connected through the COM Server, ticking this option will 
return the meter schedule log 

The Clear Error button will clear the error statistics. 

The meanings of the fields are listed in Table 2-3. 
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Setting Description 

CRC Count This is the count of errors found during the transfer of data to and from 
the meter by CRC. This value can be cleared. 

Timeout Count 
This is the number of times the meter time outs before logging on or 
during a communication. See Timeout below. This value can be 
cleared. 

NAK Count  This is the number of times the meter does not acknowledge the 
message sent to it by EziView. This value can be cleared. 

Timeout  

EziView waits for a response to a message. If no response is received, 
it sends the message again. This wait time is called the timeout period 
and is calculated by adding the timeout for the site and the timeout for 
the meter.  
By changing the timeout for the site, the timeout is changed for all 
meters. This is most useful if a site has special characteristics e.g., 
using a low speed mobile modem.  

Log Timeout 
When the meter has already been logged into and connection is broken 
midway through a function, the Log Timeout is the period to wait before 
the meter is automatically logged out. 

Retry Count  
These options fine-tune the connection to a meter.  
If the meter does not respond to a message sent by EziView, EziView 
will retry Retry Count number of times.  

• Table 2-3 Meter Advanced settings 

The Multidrive page allows the Multidrive DeviceID to be set.  Set the DeviceID of the 
meter to map it to the MultiDrive database.  Leave this blank if you do not have the 
MultiDrive package installed. 

MultiDrive is a complete meter/data management and data accumulation software 
package that allows the collection of a large range of data from a meter or measuring 
devices using Automatic Meter Reading (AMR) communications technology. For more 
details, please contact EDMI or your local vendor. 

Meters in EziView 

 
• Figure 2-19 A newly created meter in EziView 
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A site’s meters appear in the Meters pane when the site is selected.  The meter may be 
renamed or deleted in a similar way to sites.  The right hand four icons on the tool bar 
control how the pane is displayed, with the Details view being the preferred method. 

Each meter in the Meters pane represents what is called an MTR file.  This is kept by 
EziView, and primarily consists of the configuration for the meter.  EziView allows the 
configuration in this file to be edited, and offers a set of tools to send the configuration 
to the meter. 

The cut, paste and copy tools can be used to move meters between sites.  This is useful 
if the physical location of a meter changes.  It is also a useful way to create a new meter 
without going through the mapping process.  Simply copy an existing meter, paste it 
into a new site, and then set the serial number of the meter and the protocol of the site 
appropriately. 

Another way to create a new meter is to use the File→New→New Meter option (or 
toolbar icon or right-click menu in the Meters pane or the Ins key).  This creates a new 
meter in the selected site with the default properties.  To change the default properties 
simply select an existing meter and select the Default Meter option from the right-click 
menu, or the File menu.  New meters will be created with the same settings as the 
default meter. 

The use of Setup is covered in Chapter 3. 

Connecting to a meter 

To connect to a meter, double click on the meter or its site.  Alternatively the right-click 
menus have a Connect option (as shown in Figure 3-16), as does the File menu and the 
tool bars (icon furthest to the left).   

If a site has multiple meters such as an RS485 multi-dropped site, EziView will always 
try to connect to the meter with the lowest address number and treat it as the master.  If 
several meters have the same address, it will pick the lowest serial number.  This can 
cause some confusion if that meter is off-line as EziView will not connect.   

EziView treats this lowest address/serial number meter as the master meter and stays 
logged into it until the connection is broken.  If this is not the master meter then the 
connection can be broken if the real master is communicated with then its window is 
closed – since EziView logs out of the real master and it hangs up the modem.  
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• Figure 2-20 EziView connecting to a meter 

A screen similar to Figure 2-20 is shown while EziView is attempting to connect.  The 
Hide button hides this screen, but has no effect on operation.  

 
• Figure 2-21 EziView connection Status page 

If the meter does not connect immediately the Status page can give useful information 
as to what is failing.  The screen of Figure 2-21 was generated by disconnecting the 
serial connection to the meter.  Clicking the Close button will abort the process. 
EziView tries to make sure that the meter is logged off before disconnecting, so the 
disconnection sequence may take some time if the meter is not responding. 
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The times at which the Connect screen is shown may be controlled using the Tools 
→ Options → General → Connection Screen settings (Figure 2-22). 

 
• Figure 2-22 EziView Connection Screen options 

Visibility controls when the connection screen is displayed.  Hide Always never shows it, 
Hide on Connect hides it after connection is established, Minimise on Connect 
minimises it after connection is made, and Show Always shows it until the connection is 
broken. 

The Operation setting controls when interactive mode is used.  In interactive mode the 
connection details are displayed before the connection is attempted (Figure 2-23). 

 
• Figure 2-23 Interactive connection 

Automatic never uses interactive mode, Interactive Modem uses it only for modem 
connections, and Interactive Always uses it for all connections. 
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Quick Connect 

This option causes EziView to connect to a meter it finds on the serial port defined in 
the Quick Connect Site.  Generally this would be used with an optical read head.  Since 
EziView does not know the serial number and needs to ask the meter for it, this method 
does not work on RS485 connected meters unless connecting to the meter directly via 
its optical port. 

To use Quick Connect, click the quick connect button .  The meter may be in any 
site in EziView, not just the Quick Connect site.  If the meter does not exist, a meter is 
created in the Quick Connect site. 

Online Functionality 
Once the meter is connected and online, extra options become available on the meter’s 
menu.  Figure 2-24 shows these options.  Most obvious is the Disconnect button, which 
terminates the connection with the meter. 

 
• Figure 2-24 EziView online options 

The Screens group provides a range of status screens updated in real time, along with 
those settings that can only be performed online such as setting the clock. 

The Transfer Setup group allows transfers between the setup in the MTR file kept by 
EziView and the setup in the meter itself. 

The Special group allows registers in the meter to be changed directly, and allows the 
meter to be restarted, simulating a momentary loss of power. 

The use of these menu options is explained in the following chapter. 
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Live Measurement Display 

EziView can display live readings from a connected meter.     

 
• Figure 2-25 EziView Status screen example 

Selecting Screens→ Status gives a real time display of the meter’s basic measurements 
Figure 2-25).  In this example the meter is reading 0.128  kW per phase – this same set 
of input conditions in maintained though the rest of the measurement displays in this 
chapter.  These readings will update as fast as they can be read from the meter.  Note 
that the per phase power factor is calculated by EziView. 
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• Figure 2-26 EziView Phasor Diagram example 

The Phasor Diagram page shows a phasor diagram of the system, indicating the relative 
magnitude and angle of the voltages and currents (Figure 2-26).  In this example it can 
be seen that there is a 30 degree phase shift on all the currents, but otherwise the system 
is well balanced. 
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Waveform Display 

 
• Figure 2-27 EziView Waveform example 

The Waveform tab shows a variety of detailed information on the meter measurements.  
The Waveform page displays a capture of 5 cycles of the waveform as measured by the 
meter.   Individual channels can be hidden to clarify the display.  Note that the captures 
of the 6 waveforms happen in sequence, not simultaneously – keep this in mind when 
looking at non-repetitive signals. 

To display the Waveform tab and its sub tabs the meter must be a Mk10E. 

In this example it can be seen that the waveform looks quite good, but there are some 
small distortions. 
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Harmonics 

 
• Figure 2-28 EziView Harmonics example 

The Harmonics page displays an analysis of harmonics, calculated from the waveform 
display. In this case it can be seen that the levels of second harmonic are present on both 
voltage and current.  Changing the display options allows a closer look at the harmonics. 

 
• Figure 2-29 EziView Harmonics example with finer detail 
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Power Quality 

 
• Figure 2-30 EziView Power Quality example 

The Power Quality page displays a variety of power quality figures calculated from the 
waveform capture.  We can see the THD caused by the 2nd harmonic influence.  Note 
that which channels are displayed on this screen are affected by the settings on the 
Harmonics/Waveform screens. 

Disconnecting 

To disconnect from the meter simply choose Disconnect from either the site or the 
meter’s right-click menu, or from the File menu, or by using the Connect/Disconnect 
icon on the left hand end of each tool bar. 
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Measurement Conventions 
The convention for energy directions is as shown in Figure 2-31 below. 

0°

Quadrant 2
Capacitive load

Current lags voltage
Lead power factor

Quadrant 3
Inductive load

Current leads voltage
Lag power factor

Quadrant 4
Capacitive load
Current leads voltage
Lead power factor

Quadrant 1
Inductive load
Current lags voltage
Lag power factor+θ 

−φ

−θ
+φ

+ve Watts & VA
(pos. active power)

-ve Watts & VA
(neg. active power)

+ve VArs
(pos. reactive power)

-ve VArs
(neg. reactive power)

 
• Figure 2-31 Energy Directions 

Export is exporting or delivering energy to the customer’s load, import is importing or 
receiving energy from the customer.  All conventions are from the point of view of the 
supply authority. 

θ is the impedance angle of voltage with respect to current. φ is the admittance angle of 
current with respect to voltage.  The meter measures the angle in terms of current with 
respect to voltage (φ, admittance). 

Since conventions change around the world, there is a setting called Naming Convention 
in the EziView Tools → Options → General page (Figure 2-32).   The colour used for 
each phase may also be edited here. 

 
• Figure 2-32 Naming Convention settings 
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The naming conventions are as in Table 2-4. 
 

Standard Positive 
Energy 

Negative 
Energy 

Abbreviated 

ANSI Export Import Exp/Imp 
IEC Import Export Imp/Exp 
+/- + - +/- 

Rec/Del Delivered Received Del/Rec 
Fwd/Rev Forward Reverse Fwd/Rev 

• Table 2-4 Naming conventions 

See Import/Export Conventions on page 5-5 for meter options affecting measurement 
convention. 
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Chapter 3 Configuration Basics 
The Setup option for a meter allows the configuration for the meter to be changed.  
What is edited is the copy of the configuration kept by EziView in the MTR file for the 
meter.  This chapter deals with the basics of setting up, and ways of transferring this 
information between EziView and the meter. 

Editions 
Editions allow multiple builds of the same firmware version to be released.  Each 
edition tailors the functionality available to support certain applications.  For instance 
support for GPRS communications may be omitted in one edition to make room for a 
different protocol.  

Since different editions have different capabilities it is important to let EziView know 
what edition is in use, so that only the available setup options are displayed.  If the setup 
has been read from a meter then EziView will have this information, but for new MTR 
files and pre v4.05 MTR files EziView will ask for the edition as shown in Figure 3-1. 

 
• Figure 3-1 Edition selection screen 
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The default selection is Edition Not Found in File, which prompts for EziView to ask.  
The All option causes EziView not to restrict any of the setup options based on edition, 
although the edition will still be checked when the setup is actually written to a meter.   

The edition options that EziView knows about for that meter type (eg Mk7) are listed to 
allow a specific edition to be selected – this is the recommended approach if the edition 
that will be used is known, to avoid errors being generated when the setup is written to 
the meter. 

The edition code is represented as a hexadecimal number, eg D10000.  Each part of the 
edition code represents a different feature.  The bottom 4 digits are related to a hardware 
platform (eg the Mk10 and the Mk7 are different) – in this case, only the edition 
designed for your hardware may be used. The top 4 digits are for software functionality 
(such as supporting certain communication protocols) – different editions can be loaded 
into the same meter, as long as the hardware part of the edition matches.  The edition 
code and the version uniquely identify the firmware. 

For information on changing editions, see Appendix A: “Upgrading Firmware”.  The 
available editions may be viewed on the SystemParameters setup page (Figure 3-2).  No 
meter has all features, and the features that may be present together in a firmware 
edition are determined by the size of each feature and the hardware. 

Table 3-1 lists the hardware options, and Table 3-2 lists the software options. 

Feature Description 
Disconnect Relays The meter has physical disconnect relays.  This enables 

configuration of the Relay system 

Enhanced 
Processor 

Meters with an Enhanced Processor have more firmware and RAM 
space in the meter’s processor.  This allows for more features in the 
one firmware edition, and is a requirement for some features. 

LCD Type This indicates meters with a special LCD (at this time, a Chinese LCD 
is the only option besides the standard display)  
(Not shown in EziView) 

Meter Type Mk10, Mk7A, Datahub, Mk7C, Mk10D, Mk10E 
(not shown in EziView) 

Power Management 
for Capacitive 
Power Supplies 

Meters based on capacitive power supplies such as low end mk7C 
variations have this option to control the amount of power used by the 
meter itself. 

Reconnect Button If set then the 2nd button is a reconnect button.  Otherwise it is a 
Billing reset button. 

SPI Flash A higher density flash option, this is set when the meter has this 
memory option (commonly used with 2 Mbyte flash devices). 

Third Serial Port This indicates that a third serial port exists in the hardware.  This 
enables configuration of the ‘SCADA’ port. 

UPS The meter has UPS functionality and hardware.  This also enables 
Current in TOU, push alarming, and LCD alarming. 

• Table 3-1 Hardware Edition Features 
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Feature Description 
Alarms Push 
UPS Alarming 

Either code enables Alarms to be pushed to a server using GPRS 
when they occur. 

China Features This includes Chinese Protocol and several other features specifically 
related to the Chinese market. 

Command Line 
Redirect 

This enables the option for packets to be redirected between serial 
ports of the meter, enabling the meter to be a gateway to other 
meters. 

Commissioning This enables the commissioning process for use with MultiDrive. 

Coronis This adds support for talking to Coronis radio devices, used in the 
DataHub product 

Daily Billing Resets This allows Billing Resets to be performed daily. 

Disconnect Via IO Allows disconnect functionality to be used via outputs on meters with 
no hardware disconnect relay. 

DLS This enables the meter to make allowances for Daylight Saving Time. 

Gating This enables the meter to be tested on an EDMI accuracy testing 
system 

GPRS/PPP This feature is required for the meter to operate on GPRS, which 
uses the PPP, IP, and UDP protocols. 

IEC1107 This enables IEC1107 communication, which gives basic access to 
the meter using the IEC1107 protocol, also known as IEC62056-21. 

Load Limiting This feature enables the load limiting features on relays, where a load 
can be turned off if certain limits are exceeded. 

Modem Support This enables support for modems, both PSTN and GSM. 

New File Access This extends the command line protocol to allow larger packets for 
setup changes, remote firmware upgrades, and IHD updates – 
substantially speeding up communications. 

Tamper This enables the Tamper Log which can detect a wide range of 
tamper attempts. 

Tariff Input This enables an input to be used to control the active tariff rate. 

TOU Freeze This allows some of the TOU register to be frozen – this feature is not 
actively supported. 

TOU Rate Timer Enables the option to record the time spent in each TOU rate. 

Transformer 
Corrections 

This enables errors in measurement transformers to be corrected by 
the meter. 

Persian Calender This provides support for the Persian Calender, as opposed to the 
Gregorian Calender. 

Power Quality Power Quality, this enables measurement of THD, fundamental 
quantities, and sequence components. 

PLC This adds an interface to the PLC circuit in PLC meters, along with 
smaller versions of some registers, integer TOU readout, and some 
special LCD screen handling.   

Relay Change On 
Input 

Allow the state of a disconnect relay to be controlled by an input. 

Rising Demand This feature calculates rising demand and makes it available in 
several registers for display on the LCD. 

Seasonal Day 
Types 

This allows TOU daytypes to be configured differently for each 
season. 

Simple Fragments Used with ZigBee, this allows a command line packet to be 
fragmented for transmission over the network. 

Wide Surveys This allows TOU channels to be recorded in the Load Survey. 
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ZigBee Master This allows the meter to act as a ZigBee master in a Mini-Mesh 
network. 

• Table 3-2 Software Edition Features 

 

Changing Configuration 
To change the configuration/setup of a meter select Setup from its right-click menu.  
The meter may be connected or off line.  A screen similar to Figure 3-2 will be 
displayed. 

 
• Figure 3-2 Meter Configuration Setup screen 

The data shown in the fields is the data in the MTR file maintained by EziView.  
Changing the data and clicking OK saves the changed data back to the MTR file and 
closes the setup screen.  Clicking Apply saves the data to the MTR file but does not 
close the screen.  The Cancel button will exit the screen and cancel any changes made 
since the last Apply.  The Help button is currently non-functional – refer to this manual 
when help is required. 

Most configuration changes are made using the Setup pages.  The tree on the left side 
shows the available pages, and clicking on the tree moves to the selected page. 

Changing data in the Setup pages may be performed when connected to the meter or 
offline.  The changes will not be sent to the meter in either case unless they are 
transferred (discussed next). 
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The Firmware Edition section on this page shows the available features in the selected 
firmware edition. 

Transferring Configuration 

Read Setup from Meter 

This is the most basic option.  It simply reads the entire setup from the meter into 
EziView.  To change the setup of an existing meter use this option first to ensure that the 
EziView copy of the meter configuration is complete.  The setup can then be edited and 
sent back to the meter. 

EziView first asks for confirmation to proceed with the download (Figure 3-3). 

 
• Figure 3-3 Read all setup values dialog 

Continuing, EziView checks the meter’s time against the computer’s time.  If it is 
different by more than the amount set in Tools → Options → General → Max Time 
Error, EziView will prompt you to set the clock in the meter (Figure 3-4).  Clicking Yes 
will set the time in the meter to the same as the computer.  Clicking No will skip the 
time set, and clicking Cancel will abort the read operation. 

 
• Figure 3-4 Set time dialog 
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EziView will now download the entire setup from the meter (Figure 3-5).  This 
operation may take some time, depending on the speed of the communications link. 

 
• Figure 3-5 Read setup in progress 

If any problems occur during the transfer you will be notified.  The most likely problem 
is that you do not have permission to read some of the setup values.  Any values that 
could not be read will be listed.  For these values EziView will retain its existing 
settings. 

EziView caches reads and writes to setup registers in the meter.  As a result, if the setup 
is read again without disconnecting, the data will “transfer” very quickly.  EziView is 
simply using its cached values.  To force EziView to clear the cache, disconnect from 
the site and reconnect. 
 

Write Setup to Meter 

This option writes all of the setup to the meter.  You should be sure that you want to 
overwrite all existing settings in the meter before using this option.  EziView will 
prompt before sensitive sections (TOU Setup and Security) are written.  Meter 
calibration is never written. 
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Compare Setup with Meter 

This is the most sophisticated of all of the transfer methods.  It compares the setup in the 
meter with the setup maintained by EziView, and then allows fine control over how to 
resolve the differences.   

 
• Figure 3-6 Compare setup 

The comparison is done in two parts.  The first part compares the meter and EziView 
without making any changes.  A screen such as that shown in Figure 3-6 is displayed, 
which details any differences between the meter and the EziView file.  The top left pane 
lists the properties that had differences.  Selecting one of these properties displays the 
differences in the right hand pane.  The radio button allows the method of resolving the 
difference to be set. 

The first option Data in Meter read into File will read the setting from the meter and 
write it to the EziView file.  The second option does the reverse.  A meter or disk icon is 
displayed next to each setting to indicate its selection.  The All File and All Meter 
buttons may be used to change the settings of all parameters. 

The bottom pane lists any critical data that may be affected by the change.  This covers 
load surveys, TOU, and pulsing outputs.  In this example the size of load survey 1 has 
changed, and this has also affected load survey 2.  Thus both would be cleared if the OK 
button was pressed.  By selecting the load survey setup to come from the meter, the 
clearing of the surveys can be avoided. 

Once the method of resolving the differences has been finalised, click the OK button.  
This performs the writes and reads as selected.  Clicking the Cancel button will abort the 
operation without making any changes. 
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Automatic Transferral 

EziView may be configured to automatically initiate setup transfers.  This option is 
configured using the Tools → Options → General → Auto Transfer option (Figure 3-7). 

 
• Figure 3-7 Auto Transfer options 

The None option is the default, which disables auto transfer.  The Prompt option causes 
EziView to prompt whenever the setup pages are opened while the meter is connected.  
The prompt asks if the setup should be transferred from the meter to ensure that the 
current meter setup is edited.  EziView will also prompt when the OK or Apply buttons 
are clicked on the setup pages to ask if the new setup should be written to the meter 
immediately. 

The Auto option performs a similar function, but performs the transfer without 
prompting. 

Copying Setup 
EziView also provides tools to copy setup from one meter and transfer it to another.  
This is useful where the setup for one meter needs to be copied to a number of other 
meters.  Select Edit→Copy Setup from the right-click menu (or Edit menu) of the meter 
to copy setup from.  A copy icon will appear next to the meter as a reminder which 
meter is being copied from.  
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• Figure 3-8 Copy setup 

Now select the meter or meters to paste the setup to and select Edit→Paste Setup from 
the right-click menu (or Edit menu).  The following screen will be displayed (Figure 
3-9).  

 
• Figure 3-9 Paste Setup 

The source and destination meter are listed at the top of the dialog.  If multiple 
destination meters have been selected they will all be listed.  Multiple meters may be 
selected at a site by holding the control or shift key down while selecting, following 
standard windows conventions. 

The bottom part of the dialog selects what parts of the setup will be copied.  Where the 
box is unchecked, that part of the setup will remain unchanged.  Where the box is 
checked, the setup will be copied from the source meter to the destination meter.  The 
All and None button provide an easy way to select all boxes or clear all boxes. 

The Restricted Setup options may require information such as load surveys to be cleared 
in the destination meter if written.  Warnings are given that setting the option may 
“impair” operation of the meter, in that data may be cleared.  This does not mean the 
meter will not operate correctly. 

Clicking OK performs the copy of the selected parameters. 
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Protected Setup 
Certain setup pages are protected from accidental editing.  These are the transformer 
ratios, the TOU setup, the load surveys, pulsing inputs and outputs, and the event logs.  
Changing many of the items on these pages can result in data being cleared in the meter, 
as it may change scaling factors, or require memory to be reallocated.  Just because a 
page is protected does not mean that any change on the page will cause things to be 
cleared, but there is a risk, and caution must be used when writing setups to the meter 
that warnings are taken heed of if data clearing is to be avoided.   

If a page is unprotected, the settings can be changed and the message shown in Figure 
3-10 will be shown at the bottom of the page.  Click on the message to turn on 
protection. 

 

• Figure 3-10 Protect setup 

If a page is protected, the settings will be greyed out and the message shown in Figure 
3-11 will be shown at the bottom of the page.  Click on the One time only message to 
turn off protection just for this editing session.  Click on the Everytime option to turn off 
protection all the time. 

 

• Figure 3-11 Unprotect setup 

These settings are global – they are not per setup page or per meter. 

 

Print Setup 

A summary of a meters setup can be produced, useful where a printed report is required.  
Select the meter to print the setup for and select Print Setup File from the right-click 
menu.  EziView will generate a html document of the report (Figure 3-12), which may 
then be printed or saved.   
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• Figure 3-12 Setup File Report 
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Setup Level 
EziView supports two levels of user – standard and advanced.  When in standard mode, 
certain options are hidden to reduce the complexity of setting up a meter.  This option is 
configured using the Tools → Options → General → Level option (Figure 3-7). 

 
• Figure 3-13 Level options 

 

Some of the items hidden are the options for firmware upgrade, dial test mode for LCD 
display, and specialised TOU options. 
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Chapter 4 Memory Usage 
This section describes how the meter manages memory usage.  The meter only has 
finite resources of memory for processing and storing information.  The memory usage 
page (Figure 4-1) for allows the usage of these resources to be managed.  It is updated 
when the setup pages are closed or applied. 

This chapter discusses advanced topics.  In most cases simply looking at the graphs 
gives enough information to resolve low memory conditions. 
 

 
• Figure 4-1 Memory Usage page in EziView 
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Memory Usage  
The following sections explain the different memory resources, what uses memory, and 
how to manage it.  

Calendar/LCD 

The TOU calendar definition, LCD screens configuration, daylight savings setup and a 
few other settings share the same memory space.  The meter has 900 bytes of memory 
reserved for this usage. 

Each LCD screen uses 10 bytes of memory, thus a maximum of 90 LCD screens may 
be defined. 

Each TOU calendar “entry” uses 2 bytes of memory.  What is defined as an entry?  
Each special day or annual day is one entry.  When defining day types, each rate change 
point is one entry.  Another entry is needed if the day starts with a rate other than A.  
The rate change points from each day type in each time controller and changeover set 
must be added. 

The maximum number of special days is thus over 400, but since some LCD screens 
must generally be defined 200 is a more reasonable limit to keep in mind.  Season, week 
type, billing reset, and changeover settings do not use memory. 

Daylight saving uses 4 bytes of memory, plus 4 bytes per year the daylight saving 
calendar is defined for.  Thus if daylight saving is programmed for the next ten years, 44 
bytes are used.  No memory is used if daylight saving is disabled. 

Miscellaneous strings (SystemParameters page) use in addition to the number of 
characters in the strings 1 byte, plus 2 bytes overhead per string. 

Tamper Alarms are also configured in this space.  It uses 2 bytes when enabled, plus 6 
bytes for each tamper criteria. 

There is also some additional setup usage of this block.  The second set of EFA’s  uses 
20 bytes, and the over current alarm uses 12 bytes. 

Accumulator Setup/RAM Usage 

Each definition of TOU channel, load survey channel, and pulsing output uses both 
setup and RAM memory.  There are 314 bytes of RAM, and 240 bytes of setup memory 
available. 

Each pulsing output uses 4 bytes of RAM, and 2 bytes of setup memory. 

Each load survey channel uses 8 bytes of RAM, and 4 bytes of setup memory, plus 4 
bytes extra of RAM per survey.  Thus a 4 channel load survey uses 36 bytes of RAM, 
and 24 bytes of setup memory. 

Each TOU channel uses 16 bytes of RAM and 8 bytes of setup memory.  If the channel 
has more than one rate, add 10 bytes of RAM per extra rate.  If rolling demand is used 
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on a channel, add 2 bytes of RAM and 2 bytes of setup memory per extra subinterval.  
Thus if a channel has 4 rates and 3 subintervals, it will use 50 bytes of RAM and 12 
bytes of setup memory. 

Transformer corrections use 8, 24, or 48 bytes of setup memory depending on whether 
simple, intermediate, or advanced mode is used.  Relay support uses 20 bytes of setup 
memory. 

EziView does some optimisation of these settings, so the actual memory used may be 
less than that listed here.  To optimise memory usage, set the rate limits for TOU groups 
appropriately.  If some channels need more rates than others, split them up into separate 
groups. 

Some quick setups based on these figures: 

TOU – 2 channels, 8 rates each, uses 172 bytes of RAM, 16 bytes of setup memory. 

TOU – 8 channels, 3 rates each, uses 288 bytes of RAM, 64 bytes of setup memory. 

TOU – 4 channels, 3 rates each, 15 subintervals, uses 256 bytes of RAM and 144 bytes 
of setup memory. 

If space is reserved for pulsing outputs, 2 bytes of memory will be reserved for each 
fitted pulsing output. 

The meter will do a backup to flash of these running system variables and several others 
at the modem power cycle time.  If no time is set, the backup will occur at 23:33. 

Flash/EEPROM Memory Usage 

This type of memory is used for billing history, event logs, and load surveys. The 
amount fitted to the meter is specified at the time of order.  The meter’s Screens→ 
Online Variable → Memory Map Screen (Figure 4-2) shows the available memory, as 
well as a map of what the memory is used for.  
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• Figure 4-2 Memory Map screen in EziView 

The LastRecord field is the last entry number stored for event logs, and is the time/date 
of the last entry for load surveys – these can be useful if watching for a new entry to be 
saved.   

The Start and Size fields give the starting offset (in bytes) and the size (in bytes) of each 
section of memory.  The summary at the bottom of the page gives an overview of 
memory usage.  The RegID column is useful to track default names of downloaded data. 

Low level users (without setup read access) will not see the Start and Size columns, or 
the Reserved, Billing History and Blank entries since this data is unavailable. 

The Reserved section is a block of memory reserved by the meter for internal use.  

The size of the Billing History in bytes will be:  

((Number of TOU channels × number of rates) + 1) × 10 × (previous periods + 2) 

The size of an event log is 6 bytes per entry allocated. 
The size of a load survey in bytes is: 

((Number of Survey channels × 2) + 1) × number of entries  + 10    

Reserved EEPROM 

The Available Memory indication on the setup page indicates roughly how much 
memory is available.  This memory may be used by special functions in the meter such 
as remote firmware upgrade.  The reserved option allows up to 255kB of this “spare” 
memory to be reserved, so that space can be guaranteed for these special functions.  A 
minimum of 56kB available memory is required for a remote firmware upgrade, 115kB 
for enhanced processor meters.  Of course memory that is reserved cannot be used for 
load surveys, TOU history, or event logs. 
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Chapter 5 External Transformers 
This section is dedicated to configuring the meter for its voltage and current 
connections. 

In many applications external measurement transformers are used between the meter 
and the system to be measured.  The values at the input to the meter are defined as 
secondary quantities and the values on the high voltage/current side of the measurement 
transformers are defined as primary quantities.  The meter allows the ratios of these VTs 
and CTs external to the meter to be accounted for.  This way the meter will read out all 
values in primary quantities. 

Changing the transformer ratios in a meter will generally clear all existing load survey 
and TOU data.  
 

EziView automatically determines appropriate scaling factors for TOU, load surveys 
and LCD displays.  This includes the determination of the unit multiplier to use – e.g. 
Wh, kWh, MWh, GWh.  The “k” multiplier will generally be used when possible.  This 
automatic setting can be overridden for LCD screens.  Not all meters have M and G 
multipliers on the LCD. 
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Transformer Ratios 

 
• Figure 5-1 Transformer ratios page in EziView 

To set up the connection characteristics of the meter: 

1. Go to the TransformerRatios page of the Meter Configuration Setup screen 
(Figure 5-1). 

2. Measurement Configuration allows only for 3 element measurement method.  
2 element method is only supported in the Mk10E at present.  

3. Set the External CT ratio.  This is the ratio of an external measurement CT.  
Set to 1:1 if no external CTs are used, such as for whole current meters. 

4. Set the External VT ratio.  This is the ratio of an external measurement VT.  
Set to 1:1 if no external VTs are used. 

Note that like all changes to the setup pages, these changes take effect when written to 
the meter (see Chapter 3). 

Only whole numbers may be entered for CT and VT ratio. 

 

This page may be protected from editing to reduce the risk of accidental change.  To 
unprotect it select one of the Edit options at the bottom of the page.  See “Protected 
Setup” on page 3-10 for more information. 
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Transformer Corrections 

This requires the transformer corrections edition of firmware to have an effect. 

 
• Figure 5-2 Simple Transformer Corrections page 

Transformer corrections allow for errors in external CT’s or VT’s to be corrected for.  
There are 3 modes controllable via the Transformer Correction Mode setting – Simple, 
Intermediate, and Advanced.  A setting of Disable turns off this function. 

In Simple mode (as shown in Figure 5-2) a single gain and phase correction for current 
can be made.  This will be applied to the measurement of current on all phases in an 
equal amount.  Of course this will thus also apply to power and energy measurements. 

A Gain setting of 0.5% will apply a correction of : 

  ( 1 / (1 + 0.005) ) * measured_reading = final_reading    <EziView 4.01 and later> 

(1 – 0.005) * measured_reading = final_reading   <EziView 4.00 1> 

A Phase setting of 0.3 degrees will apply a correction of: 

measured_reading  - 0.3 = final_reading 1 

                                                 
1 The method was changed after EziView 4.00 to better reflect expected operation.  Reading out settings 
from a meter programmed using EziView 4.00 using EziView 4.01 will show a slightly different reading to 
the original setting (in the above example, a difference of 0.002%).  While it will generally be insignificant, 
it is noted here for completeness.  The meter setting is unchanged, only EziView’s display of it changes. 
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• Figure 5-3 Intermediate Transformer Corrections page 

In the Intermediate mode individual factors can be set for each current phase – see 
Figure 5-3. In Advanced mode individual factors can be set for each current and voltage 
phase, however the ability to correct voltage measurements separately is not 
implemented in firmware as at version 1.38.  Configuring it will do no harm, but it will 
have no effect on the voltages. 

For the Mk7 only the used elements will be shown. 

 

 

 

 

 

 

 

 

                                                                                                                                        

1 Angle is measured as φ, admittance.  See , page 2-24 for more details. Measurement Conventions
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Import/Export Conventions  

 
• Figure 5-4 TOU Quadrant Import/Export conventions page 

There are several definitions for Import and Export energy in use around the globe.  
Version 1.41 firmware introduces the ability to use alternate definitions.  These are 
configured on the TOU Quadrants tab on the TOUSetup page (Figure 5-4). 

The options for Watts are: 

• Export (Q1+Q4), Import (Q2+Q3) 

• Import (Q1+Q4), Export (Q2+Q3) 

• Capacitive (Q2+Q4), Inductive (Q1+Q3) 

The options for vars are: 

• Export (Q1+Q2), Import (Q4+Q3) 

• Import (Q1+Q2), Export (Q4+Q3) 

• Capacitive (Q2+Q4), Inductive (Q1+Q3) 

• Capacitive (Q1+Q4), Inductive (Q2+Q3) 

The Allow sum of absolute of each phase checkbox changes the way the individual 
phases are processed.  Normally the meter sums all phases before deciding on import or 
export.  This avoids certain types of load from recording both import and export energy 
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during their normal operation.  Checking this option means the meter will calculate 
import and export energy per phase, so it is possible for a meter to have import and 
export energy accumulating at the same time. 

See Measurement Conventions on page 2-24 for more information on normal 
conventions.
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Chapter 6 LCD Display 
The LCD is primarily for displaying information from the meter’s registers for meter 
readers.  It is also useful during installation, configuration, and diagnosing problems.   It 
has 8 seven-segment digits to display values and up to 7 seven-segment digits to display 
description.  It has arrows to indicate import and export for active and reactive energies, 
indicators for phase voltage, indicators for display sets A and B, battery indicator, 
connection type indicator for connection through local or remote port and units and 
multipliers. 

The enunciators are covered in Chapter 13: “Outputs and Enunciators”. 

LCD Variations 
There are several variations of the LCD display for different meters, mostly varying in 
the number of enunciators and id digits.  They all operate in a very similar manner 
though, presenting a series of pages of information.  Each page can display a single 
register’s contents.  On the display the smaller digits at the left are the label for the 
display, and the larger digits to the right are the value.   

The Mk10 and Mk10E display (Figure 6-1) has 7 label digits, and 12 enunciators. 

 

• Figure 6-1 LCD with all segments turned on 

There is also a Chinese version of the LCD as shown in Figure 6-2. 
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• Figure 6-2 Chinese LCD with all segments turned on 

The Mk10D LCD is the same as the Mk10, but some of the segments are unused 
(Figure 6-3).  It has only 5 label digits, and 11 enunciators. 

 

• Figure 6-3 Mk10D LCD with all segments turned on 

The Mk10A LCD (Figure 6-4) is similar to the Mk10, but has 6 label digits and 10 
enunciators. It adds a currency symbol and a SCADA port symbol, but drops the G and 
M multipliers, and limits the decimal places to 4. 

 
  

• Figure 6-4 Mk10A LCD with all segments turned on 
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  LCD/Select Button Usage 

The Mk7 LCD is very similar to the Mk10, but has fewer features and is physically 
smaller (Figure 6-5).   There are 4 label digits, and 5 enunciators. 

 

• Figure 6-5 Mk7 LCD with all segments turned on 

LCD/Select Button Usage 
The data is displayed on the LCD as a series of pages, up to a maximum of 90.  The 
number of maximum pages depends on the number of Specials and Annuals days 
specified in the calendar in the Tariff Setup, daylight saving entries, miscellaneous 
strings and other data in this space. Each page displays a single quantity from the meter.  
The left seven-segment characters show the description and the right seven-segment 
characters show the value, with an optional unit showing above the value.   

If the display is too long to fit into the 8 characters of seven-segment, the display will 
scroll a character every second to show the entire line.  An underscore “_” shows the 
start of the line. The 7 characters of the seven-segment display on the left will not scroll. 
Thus a description will have to be abbreviated to a maximum of 7 characters. 
 

To progress to the next page, press the Select button.  Each time the button is pressed the 
display moves to the next page.  The display may also be setup to automatically cycle 
the display through the pages, pausing if the Select button is pressed. 

The LCD can come with or without a backlight.  The backlight may be set to only 
activate while the LCD is in use, which is recommended to reduce power consumption. 
The turn on time of the backlight can be configured using EziView.  The backlight does 
not operate when running on the UPS battery. 

If the meter is off (no voltage applied), pressing and holding the Select button will wake 
up the meter using its internal battery (it may take up to a second for the meter to wake 
up).  All LCD screens may be viewed in this mode, including alternate display sets.  
This allows a manual meter reading even if power is lost.  The display will 
automatically turn itself off after the No Power Timeout (Figure 6-7).  

Note that the meter does not measure in the wakeup state, and the communication ports 
do not operate.  The time the meter is woken up is still counted as off time (“Time 
Statistics” page 10-8). 

Display Sets 

In order to make it easier to find a certain page and to allow for different users of the 
LCD, each page belongs to a display set.  Only pages from the current display set are 
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shown.  There are two display sets – A and B.  Firmware 1.40 introduces 4 display sets 
– A, B, C, and D.  To change display sets press and hold the Select button for a second. 
Set D cannot be entered unless the terminal cover or lid is open, to effectively restrict 
access to meter installers.  

The LCD will indicate the change in display set as seen on the LCD as either SetA for 
A, SetB for B, flashing SetA for C, flashing SetB for D,   The LCD will then 
change to display the new display set, starting with the first page in the set.   

Holding the Select button down for 10 seconds takes the display to a special predefined 
set (Set AB, both SetA and SetB are lit).  This includes screens such are serial 
number and time/date to facilitate diagnostics.  Holding the button as per changing 
display sets will revert to Set A. 

EziView can also force the LCD to display a particular page, in which case neither 
SetA nor SetB are lit. 

Default Display 

If there is no LCD screen setup in the meter, the time will be shown as a default page. 

The example display of Figure 6-6 shows Import active energy, which is a page in 
Display Set A. 

 
• Figure 6-6 Example of first page of Set A LCD display 

If there is an LCD setup, the first display page in display set A will be shown when the 
meter is powered up.   

Display Organisation 
In general, the organisation of the display from the top left is as follows (Table 6-1): 

 

The four arrows with characters and plus/minus sign at the 
top left display the direction of Watts and vars respectively.  
A plus sign indicates positive/export/delivered energy, 
while a minus sign indicates negative/import/received 
energy3.   

 The three characters show presence of phase voltage. L1 
represents phase A voltage, L2 represents phase B voltage 

                                                 
3 Please refer Figur  for Measurement Convention. e 2-31



 

  Display Organisation 

and L3 represents phase C voltage.  Not present on Mk7. 

 Low Battery indicator. Please refer to the section on the 
battery earlier this chapter. 

 
L shows local communication or login on the local port. R 
shows remote communication or login on the modem port.  
The R will flash if the meter is connected to the GPRS 
network in persistent mode but no one is logged in. 

 
S shows local communication or login on the SCADA port, 
Mk10A only. 

 
Currency indicator, Mk7 and Mk10A only. 

 
GMk is the multiplier. G for Giga, M for Mega and k for 
kilo.  M and G are not available on Mk7. 

 
These segments allow for display of units. The units are W, 
var, VA, Wh, varh, VAh, V and A. 

 Display set as explained in the Section LCD/Select Button 
above. 

 
Label in seven-segment characters. There can be a 
maximum of 7 characters to describe the value shown in the 
value digits on the right side of the LCD.  The Mk10 has 7, 
the Mk7 has 4, the Mk10D and Chinese displays have 5, 
and the Mk10A display has 6.  The size of each seven-
segment character is 7.75 mm x 3.45 mm for a Mk10 size 
display, 6.15 mm x 3.23 mm for a Mk7 size display.  

 
8 characters of seven-segment displays register contents as 
setup in LCD setup. The size of each seven-segment 
character is 10.7 mm x 4.67 mm for a Mk10 size display, 
9.30 mm x 4.35 mm for a Mk7 size display. 

 The enunciators allow various meter states to be displayed, 
and may be paired with a customised label. See Chapter 13: 
“Outputs and Enunciators” for more information. 

• Table 6-1 Sections of the LCD   

The energy direction arrows, battery, communication status, and phase presence 
indicators are not related to the register being shown, they are a display of the meter’s 
state.   

As the LCD is a numeric type, alphabetic characters are difficult to display.  The meter 
will attempt to display them as best it can, but readability will vary depending on the 
letter. 
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LCD Setup 

 
• Figure 6-7 EziView LCD setup 

The LCDScreens page in EziView (Figure 6-7) has the setup for the LCD pages. Each 
line of the table is the setup for one page.  The displays higher up the table are shown 
before those shown further down.  

To add an LCD screen: 

1. Double click on the first blank register field of the table.  This displays the register 
selection screen (Figure 6-8). If there is no channel in TOU Setup, the LCD setup 
form will not show the TOU tab. 
 

The Mk7 has slightly different measurements available than the Mk10, but the process 
is the same.  The LCD description is only 4 characters on the Mk7. 
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  LCD Setup 

 
• Figure 6-8 EziView Register Selection Dialog with “Phase A Instantaneous 

Voltage” selected 

2. Select the register to display.  If the register to display is known, is can be entered 
directly using the Register Tab on the LCD Setup Form. 

3. To add a register to the list of screens click on the OK button. The LCD Setup 
button will disappear. 

4. To display leading zeros check the 0 Fill box. 

5. The meter knows the units of all registers, although not all registers have units, the 
units will be automatically written on the LCD together with the register content. 

6. IEC Readout is set to allow readout using IEC 1107 protocol.  When a data read is 
requested via a communication port, all the LCD screens with this option selected 
will be transmitted.  Note that IEC 1107 support is an optional firmware feature 
controlled by editions. 

7. Select the display set the register belongs to from the list in the Set field.  There are 
four display sets Set A to Set D.  Set D can only be entered if a lid or terminal cover 
tamper is active.  In firmware before 1.40 there are only 2 display sets – sets C and 
D on these meters will map to sets A and B. 

8. Enter a description of the register, which will be displayed at the 7 seven-segment 
characters at the left side of the LCD (Figure 6-1).  A default description is entered 
when a register is selected from the LCD Setup Form.  Descriptions may be up to 7 
characters long.  If the description is blank, the description “XXXX” is used, where 
the Xs represent the register number in hexadecimal.  To the right of the description 
is a preview of how the description will look on the LCD.  
Chinese displays and the Mk10D have only 5 digits for the description, Mk7 meters 
have only 4 digits, and the Mk10A has only 6 digits. 
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To delete an LCD screen: 

1. Select the screen to remove. 

2. Click the Delete button (or press the delete key). 

To move an LCD screen: 

1. Select the screen to move. 

2. Use the up and down buttons to move it. 

Other Display Parameters 

Set the Cycling Rate to a non-zero number of seconds to enable display cycling.  The 
display will automatically step to the next screen after the Cycling Rate period has 
passed.  The range is 1 to 250 seconds.  A setting of zero disables display cycling. 

Set the Hold Time to the time in seconds to pause automatic display cycling when the 
Select button is pushed.  The range is 0 to 255 seconds.  

The backlight of the display is usually configured to light only when the meter is being 
read. Set the Backlight On Time to the time in seconds (1 to 254) that the backlight 
should remain on after the Select button is pressed.  A setting of 0 disables the backlight.  
A setting of 255 keeps the backlight on permanently. 

Setting the backlight to light on permanently is not generally recommended since it 
increases power consumption of the meter 

Set the No Power Timeout field to a non-zero number to allow the LCD to be woken up 
(using the Select button) when there is no power from mains. The range for this time is 1 
to 250 seconds. The time is the duration the LCD will be powered up, though every 
press of the Select button will restart the timeout. A setting of zero disables No 
Power operation. If the meter is not fitted with any battery, set this value to zero. 

The Date Format option allows the order of date fields on the LCD to be set to different 
conventions.  Options are DD-MM-YY, MM-DD-YY, or YY-MM-DD.  The YY-MM-
DD (P) option displays the Persian Calender date, and requires a firmware edition with 
the Persian Calender feature. 

The Revert Time field sets a time in minutes after which the LCD will go back to set A.  
A setting of 0 disables this function.  Note that the meter only checks this once a minute, 
so the actual revert time may be up to a minute less than the setting – thus it is 
recommended to use a setting of at least 2 minutes. 

The Lock TOU Display Format option allows the default formatting for TOU energy 
registers to be changed.  Note that this does not change how the value is stored, only 
how it is displayed.  The multiplier is forced to be “k”.  The number of decimal places to 
show can be set separately for Energy and for Demand values. 
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  LCD Formatting 

Note that changing the number of decimal places can reduce the resolution or range of 
readings shown. E.g. Showing 3 decimal places when the meter is only recording 1 
decimal place will effectively “lose” the top two digits. The meter still keeps them in its 
registers though.  Note that for energy there are 9 digits of precision, but normally only 
the top 8 digits are shown on the LCD.   

The Enable Dial Test setting has a similar effect.  If disabled the meter shows the top 8 
digits of precision for energy, and the bottom decimal place is not shown (as long as 
there was a decimal place to hide).  If enabled then it is effectively a ‘dial extend’ – the 
top digit is hidden to enable the bottom decimal place to be shown for energy.  The 
enabled setting only has an effect if Lock TOU Display Format is not used. 

The Number of Visible Digits allows the number of digits shown on the LCD to be 
adjusted.  This will hide higher digits to leave the selected number of digits only.  This 
can be useful where meters readers are familiar with a certain number of decimal places.  
These settings can be used along with Lock TOU Display Format.  

With versions below 1.35 of firmware the rollover settings of 7 digits and less are not 
supported (they have the same effect as a setting of 8). 

This setting is only shown in the Advanced EziView user mode. 

LCD Formatting 
There is a range of formatting options available which affect how a register’s contents 
are displayed.  All displays are right justified. 

Base Data 
Type 

Name Display Format 

A  String Displayed as is, letters are displayed as best as possible.   

F Float Displayed as a number with decimal point (automatically placed) 

I  Short Displayed as a number from -32768 to 32767.   

L Long Displayed as a number from to –2147483648 to 2147483647. 

Q Time Displayed in the form “HH:MM:SS” 

R Date Displayed in the form “DD.MM.YY” 

T Time/Date Displayed as alternating “HH:MM:SS” and “DD.MM.YY”. 

S Special Cannot be displayed.  “Undefined” is shown instead. 

• Table 6-2 LCD data type formatting 

If a value is longer than 8 characters it will scroll across the screen to show the whole 
value, with an underscore (“_”) marking the start.  

If the number is shorter than set by the parameter it is padded with spaces from the left.  
If the 0 Fill parameter is set then the number is padded with zeros instead of spaces.  
This option should not be used with numbers that may be negative.  The zero fill option 
is useful for duplicating the look of mechanical counters. 
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Units and Multipliers 

The meter knows the units of all registers and will display the unit automatically.   

The multiplier will be automatically assigned to the value. The number will be scaled 
with the correct multiplier and up to 3 decimal points for voltages and currents, 4 
decimal places for powers and angles, and 2 decimal places for energies. 

Registers with a Unit of Q (Power Factor) use the sign of the number to indicate lead 
and lag. 

LCD Status and Control 

EziView has an Online Variables page for the LCD.  Go to the Online Variables → 
LCD Screen as shown in Figure 13-6. 

 

• Figure 6-9 LCD online status 

The top part of the page displays what is actually being shown on the LCD of the meter 
at present.  If this part of the page is not shown, check that you have the 
“Mk7LCD.bmp” and “Mk10LCDxx.bmp” files in your EziView directory – contact 
EDMI if they are missing.  This is an EziView v4.03 and later feature, and also requires 
meter firmware version 1.18 or later. 

The bottom section of the page allows any register to be displayed on the LCD of the 
meter.   Enter the register to display in the Reg: field, enter the description to display in 
the Desc: field, and then click the Set button to update the LCD.  The indicated register 
will be immediately shown.  Pressing the Select button on the meter will change back to 
the normal display, as will normal automatic display cycling timeouts. 
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  System Parameters 

The Info: field controls a few parameters.  The default is zero, but a setting of 4 will 
cause the display to be zero filled.  

System Parameters 

 
• Figure 6-10 System parameters 

The SystemParameters page in EziView (Figure 6-10) has the setup for assorted strings.  

The Plant Number is a general string that may be used to set the plant number of the 
meter.  This is effectively a serial number allocated by the customer, and may contain 
letters and punctuation.  A factory option is to have the plant number set by the factory.  
In this case the plant number will be displayed here, but will be greyed out and cannot 
be changed.  It may be up to 19 characters. 

The Miscellaneous String is a general string that can be entered and displayed on the 
LCD screen, often used for things setup identifiers.  It may be up to 19 characters. 

Setup Version stores the minimum version of EziView needed to properly use this setup. 

The Misc String Information block provides a number of additional strings.  Vendor 
Name and Vendor Phone Number are shown on LCD of the meter when the main 
disconnect relay is disconnected, to indicate to a customer who they should call to 
arrange reconnection.  If Vendor Name is blank then nothing special is shown on the 
LCD.  The maximum length of each is 20 characters.  This display is only supported on 
firmware version 1.31 and later. 
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Device Config is a place to put a name for this meter setup to identify it.  This can be 
useful in tracking meter configurations.  This is only supported for access via a register 
or LCD screen on firmware version 1.31 and later, though it may be stored in the meter 
on earlier versions. 
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Chapter 7 Communications 
This chapter covers the setting of serial communication settings in the meter.  

The communication parameters are configured using the Communications → Ports 
setup page (Figure 7-1). 

 

• Figure 7-1 Communications ports setup 

Optical Communications Port 
The optical communications port on the front of the meter may be ordered with either a 
FLAG or ANSI physical standard port.  The protocol used is primarily EDMI’s 
command line protocol.  Standard FLAG or ANSI read heads may be used to connect 
the meter to a computer.  EDMI can also supply read heads. 
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Set Baud Rate to the baud rate of the connection, up to 19200 baud. The default and 
recommended setting is 9600 baud.  The recommended setting for the optical port is 
EDMI command line mode, as connection to the meter will be faster and the meter will 
automatically detect an IEC1107 login if attempted.   Autoswitch can be disabled by 
unchecking the Enable Autoswitch checkbox, though normally it should be left enabled. 

IEC1107 requires the IEC1107 firmware edition to function. 

 

 

• Figure 7-2 Default Login 

When in EDMI Command Line mode, the Default Login option (Figure 7-2) allows for 
a user to gain access to the meter at the selected user level – without having to enter a 
password.  This is useful for automatic systems, or simple meter readers.  A normal 
login overrides this level. 

Modem Port 
The Modem port is the generic name for the second communications port of the meter.  
It is designed for connection to a modem, or a direct connection to a SCADA system.  
The physical port can be either RS232 or RS485, which will affect how the meter is 
configured. 

The Protocol may be set to either Modem or EDMI command line.  The configure 
button gives access to advanced options relevant to the selected protocol.  The Modem 
option requires the Modem Support (Protocol) Edition feature, and for GPRS use the 
GPRS/PPP edition feature is also required. 

Modem Setup 

To work with a modem, the Protocol should be set to Modem.  The Baud Rate setting 
should match that of the modem if the modem has a fixed DTE speed.  For modems set 
to DTE autobaud, a setting of 9600 or 19200 should give good performance.  Speeds 
higher than this are not recommended for general use. 

Handshaking should be set to Normal.  The Initialisation string is designed to send a 
configuration AT command to the modem.  The “AT” does not need to be included, and 
the command “E0” (echo off) is always included.  On newer modems “+CRC=0” is 
needed to make the modem return conventional RING messages.  The command 
“&D1” will allow the modem to more quickly respond to the meter in GPRS modes.  
For meters with passive serial ports, “+IFC=0,0” and “&C0” will enable CTS and DCD 
respectively to help power the port. 

Thus the recommended initialisation string is “ATE0&D0&C0;+IFC=0,0;+CRC=0”.  
For meters with a passive serial port, the modem must be set with this initialisation 
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string before connecting it to the meter – otherwise communication can never be 
established. 

Note that for Intercel SAM modems auto answer should definitely not be enabled (eg 
“S0=3” causes problems), as it interferes with that modems GPRS operation. 

The Power Cycle Time sets a time of day each day that the modem should be turned off 
for briefly (30 seconds).  This can recover a modem from a latch up condition.  This 
only works if the modem is powered from the serial port, or if the modem supply is 
switched using an output configured for modem control. 

The meter will also do a backup of the running system variables to flash at this time.  If 
no time is set, the backup will occur at 23:33. 

In version 1.30 firmware and later, a dither has been added when used with a GPRS 
connection.  This is a delay from when the modem is turned on, to when the meter tries 
to attach to the GPRS network (used in persistent mode).  The delay is a number of 
seconds based on the last 7 bits of the meter serial number (ie 0 to 127 seconds). 

The XON/XOFF Enabled checkbox enables XON/XOFF handshaking with the modem 
for flow control.  This allows the meter to slow down transmission if the modem is not 
transmitting fast enough, and is recommended for use if the modem supports it.  The 
feature also has to be present and enabled for the modem.  The EDMI command line 
protocol is transparent to XON/XOFF signalling.  The normal AT command to enable 
XON/XOFF handshaking is /Q1 on most modems. 

The GSM option enables extended support for GSM modems, which allows readout of 
the modem signal strength and other functionality related to GSM connections (such as 
GPRS).  It should not be checked for PSTN modems. 

The Packet Size option is used with a ZigBee network, though it can be used with any 
network with a packet size limit.  When the meter is redirecting messages to another 
meter, this setting limits the size of the packet transmitted and will fragment the packet 
if it is larger than this.  It is only used between meters, and it requires the “Simple 
Fragments” edition feature. 

The 2-Wire RS485 option limits the command line messages to extended command line 
only (ie addressed commands).  This prevents looping of messages on 2-wire RS485 
bus.  It does not generally need to be used with a modem. 

The Configure button gives access to advanced options related to GPRS connectivity 
(Figure 7-3).   
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• Figure 7-3 Modem communications advanced Network Settings 

Table 7-1 gives a brief description of the options.  If you have problems configuring the 
meter for GPRS please contact EDMI. 

Setting Description 
Network This is the APN for the GPRS network to connect to.  Up to 29 characters. 

QOS Quality of Service setup information for the network.  This will be 
something like “1,0,0,3,0,0”, and may be up to 23 characters.  The same 
value is used by the meter for requested (AT+CGQREQ) and minimum 
(AT+CGQMIN) QOS.  It is not editable. 

UserName This is the username that the PPP login sequence uses to access the 
network.  Up to 11 characters long.  This should not be left blank - still put 
something here even if the network does not require a username. 

Password This is the password that the PPP login sequence uses to access the 
network.  Up to 11 characters long.  This should not be left blank - still put 
something here even if the network does not require a password. 

Extended String 
Enable 

This allows the strings in this box to be longer, useful for some countries 
with long usernames.  This option should only be used on meter with 
firmware version 1.09 or later.  It allows the total length of the Network 
APN, QOS, Username and Password fields to be 74 characters all 
together, rather than the individual limits. 

Primary IP 
Address 

The IP address of the server for the meter to connect to.  

Secondary IP 
Address 

A fallback IP address in case the Primary address fails.  This setting is 
currently not used by the meter v1.09 firmware.  Firmware 1.38 uses it as 
a fallback for commissioning and for alarm pushing. 

UDP Server Port This is the UDP port to connect to on the server. 

UDP Meter Port This is the UDP port that the meter will accept connections on, and used 
as the source port in meter initiated messages. 

• Table 7-1 GPRS Network settings 

 

 

 7-4  EDMI Atlas Software Reference Manual  



 

  Modem Port 

The GPRS Options tab allows a number of options in the way GPRS works to be 
finetuned (Figure 7-4).  Table 7-2 describes the options. 

 

• Figure 7-4 Modem communications advanced GPRS Options 

Setting Description 
Enabled Setting this option will make the meter stay online after sending data – 

Persistent mode.  This is useful where the meter has a fixed IP address 
and allows an external server to connect to the meter.  It is recommended 
that DTR support is enabled in the modem (generally &D1) in this mode 
for Mk10 meters, though it works fine without it. 
Without the option checked, the meter will disconnect from the GRPS 
network when it is not sending data. 

Enhanced 
support for ETM 
Modems 

This enables enhanced support for ETM brand modems using a Siemens 
module in persistent mode.  The option is useful when persistent mode is 
enabled. 

Check for 
incoming CSD 
calls 

This options makes the meter check for signal strength and for a GSM 
data call while on a GPRS connection.  It should generally be enabled.  
Disabling it is useful with certain 3G modems to avoid incompatibilities. 

Send AT 
commands in 
UDP packets 

An alternative to Check for incoming CSD calls, this is for modems where 
AT commands can be sent while on a GPRS connection using UDP 
(some 3G modems) 

Detach from 
GPRS while in 
data mode to 
answer incoming 
CSD calls 

When enabled the meter will return to data mode to terminate the GPRS 
session after detecting an incoming call.  This is needed for some 
modems (eg the SAM2W). 

Commissioning 
Required 

If set a new meter will start the commissioning process as soon as it is 
turned on.  If not set then the commissioning process needs to be 
manually started – useful if commissioning is not being used. 

• Table 7-2 GPRS Options settings 
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The Data Push tab allow configuration of data push timing (Figure 7-5). Table 7-3 gives 
a brief description of the options.   

 

• Figure 7-5 Modem communications Data Push timings 

Setting Description 
Interval The meter will try to connect at this interval.  E.g. set to 15 minutes for 

regular updates, or 1 day for daily reads.  Setting it to zero will disable 
pushing of data from the meter (a bug in EziView 4.08 prevents it from 
being cleared though). 

Clear Interval Clicking this button clears the Interval, and thus disables pushing of data 
from the meter. 

Offset Time This allows the interval to be offset. E.g. To do a daily read at 1am, set 
this to 1 hour. 

Window This gives a window after the connect time that the meter can delay within 
so that simultaneous connection from a lot of meters can be avoided.  
E.g. set to 1 hour to allow a connection to be attempted between the 
connection time and 1 hour after that. 
When EziView writes the setup to the meter, a random value is chosen 
within this window.  The maximum is 1275 minutes, which is just over 21 
hours.  A setting of 0 disables the window. 

• Table 7-3 GPRS Data Push settings 

Note that to disable automatic pushing of data, clear the interval settings (using the 
Clear Interval button) 

In GPRS mode the meter will make at most 8 attempts to connect during an hour.  This 
counter is reset if a successful attempt is made, or the meter is logged into.  This limits 
the call costs the meter can cause if there is a problem with the network or server. 

When the meter is in persistent mode and is connected to the GPRS network the  on 
the LCD will flash.  When the meter is actually logged into by a user the indicator will 
stay on. 
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RS-485 Setup 

To work on an RS-485 multi-drop connection, the EDMI command line protocol should 
be selected.  Handshaking should be set to Transmit Enable.  The Initialisation string 
and other modem related settings are not used and are hidden.  XON/XOFF 
handshaking has an effect, but should normally be disabled.  The Baud Rate setting 
should be the same for all meters on the RS-485 bus, and match the device talking to the 
meter.  Speeds higher than 19200 are not recommended for general use.  

The Default Login option allows the security level of the port when no user is logged in 
to be raised, useful for simplifying access for SCADA systems. 

The 2-Wire RS485 option limits the command line messages to extended command line 
only (ie addressed commands).  This prevents looping of messages on 2-wire RS485 
bus.  It must be enabled for reliable 2-wire bus operation, and is recommended for 4-
wire bus operation.   

 

Other Options 

The option EDMI CmdLine Redirect will redirect command line packets between ports 
configured with this option, if the packet is not directly addressed to this meter.  This is 
useful where a meter is connected to a modem, and other meters are connected to the 
other port. 

The Coronis option is for use with the wireless datahub, which has a Coronis module 
connected to the SCADA port. 

The Wireless Device option is used for ZigBee MiniMesh networks, and is tied to the 
ZigBee Master Edition feature. 

These protocols require their respective firmware edition codes to be present. 

ZigBee 

ZigBee connectivity is still in ongoing development.  To use the meter with a ZigBee 
network an EDMI ZigBee modem is connected to the MODEM port of the slave 
meters, and the SCADA port of the master meter.  These ports should be set to Wireless 
Device, and the Packet Size should be set to 60 bytes, Baud Rate 9600, Handshaking 
Normal. 

The slave meters need the serial number of the master device entered into the Wireless 
Device field under the Configure button settings.  A setting of 0 will use the first 
network it finds. This lets the meter calculate the Extended PAN ID of the master meter.  
On firmware before 1.40 the PAN ID of the master meter is entered. 

The coordinator Extended PAN ID is set from the serial number of the master meter.  In 
version 1.40 of firmware and later the PAN ID is set as <EDMI OUI (24-bits)> <0x00 
(8-bits)> <Master meter serial number (32-bits)>.  If firmware before version 1.40 the 
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value is the bottom 14-bits of the serial number. The easiest way to work out the PAN 
ID is to do the following: 

1. Using windows calculator in scientific mode (or other appropriate calculator), enter 
the serial number in decimal. 

2. Now select Hex to change the serial number into hexadecimal format. 

3. Next press the ‘And’ button, then enter ‘3FFF’ and press ‘=’. 

4. The resulting answer is the PAN ID in Hexadecimal format, which is what is needed 
for the slave meter setup explained later in the document. 

So for example, given the serial number 207750016 (in decimal). This converts to 0C 
62 03 80 in hexadecimal. Therefore 0C 62 03 80 ‘And’ 3F FF = 380 in hexadecimal = 
PAN ID. 

An EziView site needs to be created with all the meters.  The master meter should have 
the Address set to 0, and the other meters should have the address set to non-zero (to 
ensure EziView talks to the master meter first). 

SCADA Port 
Some meters have the option of a 3rd serial port, which we call the SCADA port as this 
is frequently what it is used for.  Settings are similar to those for the Modem port, but 
this port does not support operation of a modem. 

In present hardware the SCADA port will be power cycled at the same time as the 
Modem port.  The exception is the Mk10E, which can power cycle the ports separately.  
The other exception is a MK10A with two RJ45 ports, which can use power from the 
next meter in an RS485 chain to keep the RS485 port running while the meters own 
modem power is cycled. 

In all Atlas meters but the Mk10E there is one DTR/transmit enable signal shared by 
both ports.  The handshaking settings need to be made to control is appropriately.  If the 
SCADA port is set to Normal handshaking, the signal is used to control DTR on the 
modem port.  If the SCADA port is set to Transmit Enable or Always Active, the signal 
is used for the SCADA port. 

This means if the SCADA port is an RS485 port, the SCADA port handshaking setting 
must be set to Transmit Enable or Always Active.  If the SCADA port is an RS232 port, 
the handshaking of the SCADA port should be set to Normal.  

On the MK10A the modem port is always RS232, and the SCADA port is RS232 or 
RS485.  On the Mk7C and Mk10D the Modem port may be RS232 or RS485, and the 
SCADA port is always RS232.  This means that on a Mk7C/Mk10D with an RS485 
port a modem cannot be used, as the only RS232 port is the SCADA port. 

On the Mk10E the SCADA and Modem ports are independent. 
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The MK7A has no RS485 option, and does not support DTR. 

Support for the 3rd serial port requires the physical port to be fitted, and the Third Serial 
Port firmware edition code. 

Commissioning & Heartbeat 
The meter has a system of automatically commissioning GPRS meters in the field.  This 
works in conjunction with Multidrive and other backend software, and was introduced 
in v1.31 firmware.  The system allows a meter to be easily connected to the network, 
and confirmation given that the connection is working. 

The meter has a number of states, from uncommissioned though to commissioned.  
Register FF19 indicates the current state, from 0 to 7.  This register can be displayed on 
the LCD to provide a useful state display.  Pressing and holding the Select button for 6 
seconds while on this display will force the commissioning process to be restarted (as 
does writing a 0 to this register).    

Table 7-4 covers the commissioning process by commissioning state. 

State Description 
0 The meter will connect to GPRS, and send a commissioning packet to the server 

(Primary IP Address).  This packet has the meter serial number, plant number, 
modem IMEI number, device config string (from SystemParameters page), meter 
type, firmware version and edition.   
The LCD will show “SEND INSTALL” when a commissioning packet is sent. 
Once the packet is sent the meter goes to state 1. 

1 The meter expects to get an acknowledgement from the server, which then displays 
“GOT RESPONSE” and moves the meter to state 2.  If no acknowledgement is 
received, the meter will retry 3 times.  If this still doesn’t work it will try again next 
time the connection is re-established (ie after a power up) or the push interval occurs 
(as configured on the Communications Modem page).  Alternatively restarting the 
commissioning process will force the meter to try again. 

2 The server will log into the meter and writes a 4 digit commissioning code to it.  The 
meter displays this code followed by the word “COMPLETE”.  The meter then moves 
to state 3.  
The commissioning code is designed to be recorded by the installed on site.  This 
gives proof that the installer was on site until the process was complete, and acts as 
a method of confirming job paperwork and meter. 

3 The commissioning code will be displayed until the push button is pressed for 2 
seconds, or the meter power is cycled.  When this happens the meter moves to state 
7. 

4,5,6 Reserved 

7 The meter is commissioned.  It will not try to commission itself again unless 
instructed to do so. 

• Table 7-4 Commissioning States 

Heartbeat 

Heartbeat messages are used to keep in touch with the server in a GPRS system.  A 
heartbeat message contains the serial number, plant number, and modem IMEI number. 
The UPS meter sends a variation which includes more system status information. 
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The heartbeat message is sent when either: 

1. The connection is re-established and the IP address has changed. 

2. On the push interval IF the meter hasn’t been logged into since the last push 
interval. 

3. Writing to register FF14 or pressing the Select button for 6 seconds while 
display the FF14 register on the LCD.  

The meter will display “SENT HEARTBEAT” when sending, and “GOT RESPONSE” 
when an acknowledge comes in.  The meter will retry 3 times. 
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In Home Display 
To configure the meter to operate with a Millennium In Home Display (IHD) the port 
with the ZigBee modem connected should be set to Command Line.  Load Survey 1, 
channel 1 should be the same quantity and interval as TOU channel 1.   

Online Variables has a File Handling page (Figure 7-6) that allows files to be sent to 
and retrieved from the meter, which the IHD can pick up.  Note this uses the same 
memory are (user space) as is used for firmware upgrades, so do not perform both 
operations at once. 

 

• Figure 7-6 File handling controls 

To upload a file to the meter click the  button and select a file.  Address should 
generally be left as 0, and Use File System should be selected as this uses the correct 
semaphores to avoid data contention.  Clicking the Upload button will start the transfer. 

To download a file specify the size of the file to download, Address should generally be 
left at 0, and Use File System should be checked.  Click the Download button to start the 
transfer.
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Chapter 8 Time of Use 
This chapter covers the setting of Time of Use (TOU) in the meter, which includes the 
TOU Channel Setup and Tariff and Rates Setup. 

An energy quantity such as import Wh is recorded in a TOU channel.  Each TOU 
channel records both accumulated energy, and the maximum demand and the time the 
maximum demand occurred.  It can record these quantities separately for different times 
of the day, thus the term Time of Use.  These are called different rates, as generally a 
different price rate is applied by the utility to each. 

A calendar determines when these rates occur.  The meter supports up to 8 rates.  In 
addition the meter can take a reading of all these quantities, generally once a month or 
when the Billing Reset button on the front of the meter is pushed.  It can store up to 13 
of these, as well as total values. 

The calendar allows different rate structures for different days of the week, and for 
different special days during the year.  It can take account of seasons or complete 
changes in the rate structure. 
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TOU Channel Setup 
Each quantity to be recorded by the TOU system is recorded in a TOU channel.  The 
TOUSetup page allows selection of what is recorded in each channel from a selection of 
over 80 sources.  Up to 32 channels can be defined, but this is usually limited by 
available memory.  Figure 8-1 shows the channel definition page. 

 

• Figure 8-1 Time of Use setup 

The TOU source column describes what is being recorded in that channel.  The TOU 
group column lists which one of the two TOU groups the channel belongs to.  Each 
group can be separately configured for the maximum number of rates, the demand 
interval, for block or rolling demand, and for calendar setup.  A wide variety of 
quantities can be selected from to record in a channel (Figure 8-2). 

 

• Figure 8-2 Types of energy available for TOU Channel Setup 
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The Mk7 has Main, Load, and Neutral instead of Phase A, B, and C.  Total is the sum of 
Main and Load. 

Double click on a channel to edit the settings, or on the last blank entry to add a new 
channel.  Use the Delete button to delete the selected channel.  Editing a channel brings 
up the Setup TOU Channel form as shown in Figure 8-3.  

 

• Figure 8-3 Setup TOU channel 

The Energy tab has all the energy quantities that the meter can measure.  The first 
column selects which quadrant(s) the energy comes from.  The Absolute setting reads 
positive energy for import or export energy. See then end of any of the hardware chapter 
Figure 2-31 on page 2-24 for clarification of import, export and quadrant conventions.  

The second column selects the type of energy, Wh, varh, or VAh.   

Finally the third column selects which phase to record the energy from.  Total is the sum 
of all three phases.  The individual phase selections allow energy from only one phase to 
be recorded, useful if there are separate loads on each phase or for tamper monitoring. 
Figure 8-2 summarises these selections. 

The order that some of the channels appear is determined by EziView for optimal 
memory usage.  Thus after setting a series of channels EziView may rearrange them 
slightly. 

 

Changing TOU channel configurations will generally result in clearing of all TOU data, 
and possibly load survey data since the meter optimises memory usage between these 
systems.  It may also clear load surveys and reinitialise pulsing outputs, depending on 
the exact configuration. 

The channel setup page may be protected from editing to reduce the risk of accidental 
change.  To unprotect it select one of the Edit options at the bottom of the page.  See 
“Protected Setup” on page 3-10 for more information. 
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When there are pulsing inputs configured in the meter a Pulsing Input tab becomes 
available.  This shows the available pulsing inputs for selection (Figure 8-4). 

 

• Figure 8-4 Pulsing input channel selection 

The Test Energy tab allows selection of a phantom energy source, useful for testing 
when no load is available.  

The LS linked column indicates if a TOU channel is being recorded in a load survey. 

There is an additional feature in the UPS meter which allows current to be recorded in 
the TOU system.  This gives a reading in Ah for accumulated data, and a reading in 
Amps for demand data.  Figure 8-5 shows the options. 

 

• Figure 8-5 Current in TOU channel selection 

The Enable Rate Timer option is used if the exact time each rate is active is needs to be 
recorded.  Enabling this option records the time spent in a rate instead of the time of 
maximum demand for that TOU channel.  The unified maximum demand returns the 
total time across all rates.  Channels with this option selected are identified by an ‘X’ in 
the Rate Timer column. 
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An edition of firmware with the TOU Rate Timer feature is needed to use this feature. 
 

TOU Groups 

A TOU group defines how many rates are available, and how demand is calculated.  It 
also allows for different day configurations in the calendar.  TOU group settings are 
under the TOU Group 1 Settings and TOU Group 2 Settings tabs at the bottom of the 
TOUSetup page (Figure 8-6). 

 

• Figure 8-6 TOU group settings 

Each TOU channel belongs to one of two TOU groups, called TOU Group 1 and TOU 
Group 2.  All channels that belong to a rate group have the settings of that rate group.  
Changing a TOU group’s settings will affect all channels that belong to it.   

Reasons for splitting channels into different groups include conserving memory (eg 
could have 3 rates for Wh channels, but only 2 rates for varh channels), applying 
different demand calculations (eg running a demand interval of 15 minutes and 60 
minutes), and allowing different rate structures (eg could have two separate rate setups 
for Wh and varh, or calculate Wh under two different rate structures).  If this flexibility 
is not needed, simply use TOU Group 1 for all channels. 

The Number of Rates setting determines the maximum number of different rates that 
can be recorded.  When setting up the calendar you will be restricted to this many rates.  
Only set this to as many rates as you are likely to need, as larger settings use 
significantly more memory. 

Interval and Sub-Interval are used to configure how maximum demand is calculated. 
Both Interval and Sub-Interval are given in minutes.  

Scaling is discussed later on page 8-8 under “Scaling, Units and Overflows”. 

Accumulation and Demand 

Each TOU channel records accumulated energy, maximum demand, and time of 
maximum demand for its source.  It has a separate set of registers for each rate, as 
illustrated in Figure 8-7.  At any time only one of the rates of a TOU channel is active, 
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determined by the calendar.  Channels belonging to different TOU groups may have 
different rates active. 

 Channel 1  Channel 2 Channel 3 Channel … 

Rate A Accumulated 
Max Demand 
Time of Max 

   

Rate B     

Rate C     

Rate …     

Unified     

• Figure 8-7 TOU Channel and Rate structure 

The unified rate is an extra set of registers that are calculated without rate switching.  
The accumulated register is the sum of all the rates’ accumulated registers.  The 
maximum demand is the maximum of the other rates’ maximum demands, and the time 
is the time of this maximum. 

Accumulated Energy 

Energy is added to the accumulation register for the active rate as it is measured.   

Maximum Demand and Time of Maximum Demand 

Demand calculations effectively calculate the average power over a short time period 
called the demand Interval, generally 15 to 30 minutes.  Demand is measured in order to 
give an indication of the peak loading on the network. 

At the end of every demand interval, the measured demand of each TOU channel is 
compared against the maximum demand value for the active rate of that channel.  If it is 
larger, the maximum demand is replaced with the new maximum, and the time is 
recorded as the time of maximum demand. 

Block and Rolling Demand 

There are two ways to calculate demand.  The simplest method is called Block Demand, 
where the demand is simply calculated at the end of each demand interval.  In this case 
the Interval is set to the demand interval, and the No. of Sub Intervals is set to 1.  
Demand intervals of 1, 5, 10, 15, 30 or 60 minutes can be selected. 

For Rolling Demand, a series of demand intervals begin sequentially, overlapping one 
another.  Figure 8-8 illustrates a 15 minute demand interval with 3 sub intervals.  
Effectively a new demand interval starts every 5 minutes in this case.  Up to 15 sub 
intervals can be selected using the No. of Sub Intervals setting, depending on how many 
can evenly fit into the demand interval.   Rolling demand is generally used to get a better 
indication of demand for intermittent loads. 
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• Figure 8-8 Demand periods example 

Billing History 

Billing History keeps records of previous accumulated energy, maximum demand and 
time of maximum demand for every rate of every TOU channel.  Whenever a Billing 
Reset occurs, all these values are stored as a previous billing period, and the current 
values are reset to zero.  Generally a Billing Reset is generated automatically once a 
month. 

There are a maximum of 13 previous periods stored, though meter firmware 1.40 
increases the maximum number of periods from 13 to 61.  If this is the Nth billing reset 
then Previous 1 records the values gathered between the Nth billing reset and the (N-1)th 
billing reset. The same way, Previous 2 keeps the record of values from (N-1)th billing 
reset to the (N-2)th billing reset, etc. 

A brief illustration of the Billing Reset concept is that if an automatic billing reset is 
done every first day of a month, and 3 Previous is selected under Billing History, the 
meter will keep a record of the end of month values for the last three months.  E.g. 
January (Previous 3), February (Previous 2) and March (Previous 1). When April ends 
the previous periods slide down by one, and the values for January are discarded.  The 
new order would be February (new Previous 3), March (new Previous 2) and April 
(new Previous 1). 

In addition to these previous periods, the billing history keeps a record of the total values 
for all time either including the current period (total) or excluding the current period 
(billing total).  For these values the accumulated energies are added, and the maximum 
demands are added from each period. Time of maximum demand is not available as it 
has no meaning in this context. 

The time of each billing reset is stored with the data for that billing period, so it gives the 
time of the end of the billing period.  This is in addition to any event log entries.  When 
automatic Billing Resets occur is controlled by the “Billing Reset” settings on page 8-19 

The number of previous billing periods to store may be set on the main TOUSetup page 
(Figure 8-9).  The maximum number it can be set to based on available memory is also 
displayed.  The diagram at the bottom of the setting page illustrates how all the periods 
are organised in time. 
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• Figure 8-9 Billing History options 

Choose at least one previous period to allow Billing Total to record energy and 
maximum demand values upon billing reset.  If there are no previous periods, a billing 
reset will effectively clear all TOU registers. 
 

Normally the accumulated energy stored in a previous period is the amount of energy 
accumulated over the billing period.  This is what happens when the Previous Period 
Energy is set to Energy During Period.  Setting this option to Cumulative Total Energy 
changes this so that the previous period stores the total energy accumulated, rather than 
just the energy recorded in the billing period.  Previous period maximum demand is 
unaffected. The diagram on the bottom of the settings page shows the different 
operation (Figure 8-10). 

 

• Figure 8-10 Billing History Cumulative Total Energy 

Scaling, Units and Overflows 

The Scaling settings allow for the default settings that EziView makes to be overridden.  
These can be used to increase the resolution of accumulated readings, or set a certain 
multiplier. 

The meter records energy as pulses, each pulse representing an amount of energy.  If the 
meter is showing Wh to 1 decimal place, each pulse is 0.1 of a Wh.  The meter can 
record up to 65535 pulses in a demand period.  Beyond this it will “saturate” at 65535 
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until the end of the period, and flag a pulsing overflow EFA.  It can record up to 
999999999 pulses (9 digits) in an accumulator before rolling over.  Saturation of the 
demand period should be avoided. 

 

• Figure 8-11 Time of Use Scaling setup, User Defined Scaling enabled 

Figure 8-11 shows the TOU channel scaling setup.  The Default Scaling sections 
indicate what EziView recommends based on the interval and maximum voltage and 
current.  The indicated Overflow amount is designed to give an indication of the 
maximum power the meter can record continuously before overflow occurs.  The 
decimal places shown on the LCD for accumulated energy is one less than set here, as 
only the top 8 digits are displayed (unless decimal places is set to zero, where the 
bottom 8 digits are displayed). 

E.g. in Figure 8-11 the Overflow is 26.214kW.  With the 15 minute period, this means 
that a maximum of 6.5535 kWh can be recorded in a demand interval before the 
demand calculation overflows.  On a 3 phase, 240V system this would represent a 
continuous load of around 36 amps.  At the meters full rated load of 20 amps, the 
accumulators would roll over after 289 days. 

It is strongly recommended not to use the override controls.  The User Defined Scaling 
section is normally hidden, as incorrect use can lead to overflows and truncation.  Do 
not use User Defined Scaling unless you are very sure of what you are doing.  Beware 
of situations such as setting a user defined figure, then changing transformer ratios.  If 
you do need to use it, contact EDMI. 
 

If the load is known to be less than 3.6 amps on average, the scaling can be overridden 
to something like a unit scaling with 2 decimal places.  This is done by checking the 
User Defined Scaling box and setting a new scaling.  EziView will warn that the 
changes are different to the recommended settings. 

The unit factor and the number of decimal places apply to the display of demand.  
Accumulated energy is also recorded to this accuracy, but is displayed with one less 
digit of resolution on the LCD.   

The other usage is to change the multiplier.  If in the example the energy is wanted to be 
shown as kWh rather than Wh, EziView can be overridden.  Set the Unit factor to “k” 
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and the decimal places to 4 to get the same effective scaling, but with a scaling factor of 
k.  It is better and safer to do this using the scaling tools on the LCD setup page. 

Advanced TOU Setup 

The TOU Integer Readout setting (Figure 8-12) when enabled means that when the 
TOU registers for accumulated energy and maximum demand are read from the meter, 
they are read as integers rather than as floating point.  This is designed to make it easier 
to interface with certain external units such as PLC.  The integer values will match the 
scaling of the LCD.  This option can be enabled per port, since it would generally only 
be enabled for communication with certain devices. 

 

• Figure 8-12 TOU advanced settings 

Tariff Calender Setup 
The structure of the calendar system is illustrated in Figure 8-13 below.  For simplicity it 
shows only one branching route since the other branches are identical. E.g. Alternate has 
the same structure as Normal; and, similarly Season3 has the same structure as Season4, 
etc.  

ChangeOver

Normal Alternate

Season1 Season2 Season3 Season4

WeekType

TimeControl4TimeControl3TimeControl2TimeControl1

DayType4DayType3DayType2DayType1 DayType8DayType7DayType6DayType5

Rate1 Rate2 Rate3 Rate4 Rate5 Rate6 Rate7 Rate8  
• Figure 8-13 Structure of Tariff 

The two TOU groups already mentioned in earlier sections are part of the Time Control 
system. In addition to these two there are another two called Ex1 and Ex2.  Ex1 and Ex2 
are designed for time clock type operations, where an output is controlled to switch at 
various times of the day.  If this functionality is not required they can be ignored. 
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The meter has a limited amount of memory for calendar entries.  If the meter is out of 
memory, you will not be able to add more entries.  On the MemoryUsage page the 
Calendar/LCD Memory Usage bar shows how much memory is used.   If you run out of 
entries, either remove some other calendar entries, LCD screens, or future daylight 
saving changeover times. 
 

Day Type 

A “Day Type” defines the switching of rates during a 24 hour day, midnight to 
midnight.  Up to 8 Day Types for a time controller (TOU group) may be defined.  Each 
time controller has its own independent set of up to 8 day types.  The DayType setup 
page (Figure 8-14) allows the Day Types to be defined.   

 

• Figure 8-14 Day Type setup 

To configure a particular Day Type, select the Time Controller, and then the Day Type 
number from the left hand column.  Its current configuration is indicated by the graph at 
the bottom of the screen.  The colours correspond to the rates, a legend is shown to the 
right.  

There are a maximum of 8 rates, from Rate A to Rate H. To set a particular rate, say 
Rate B, highlight the time in Switching Time box and click on Rate B in the Rate box. 
Please refer to Figure 8-14.  Using the shift and control keys in combination with the 
mouse allow ranges to be specified (in standard windows usage). 

A rates can be setup with a default resolution of 30 minutes.  A finer resolution that 30 
minutes may be used by selecting a resolution from 1 min to 30 min using the radio 
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buttons above the table.  Note that if a resolution smaller than the demand interval is 
used it is recommended not to have a rate change in the middle of a demand interval.  
This will avoid maximum demand calculations being skipped due to crossing a rate 
change. 

EX2 is used for relay tariff control – if this functionality is used, EX2 should not be 
configured here. 
Click the Clear All Day Types button to clear rate arrangement for every Day Type, and 
for every Time Control group. 

Change Over Set 

If there is no Change Over date selected, the Change Over will be disabled on this page. 
See the section on Change Over for details.  If change over is enabled two completely 
independent configurations can be made on this page, normal and alternate. 

Use Seasonal Day Type 

Normally the Day Type settings are the same for every season.  The Use Seasonal Day 
Type option allows different Day Type configurations for each season.  The compromise 
is that the finest resolution is 5 minutes, rather than 1 minute. 

 

• Figure 8-15 Seasonal Day Type setup 

The Seasonal Day Type option requires an edition of firmware with the Seasonal Day 
Type feature. 
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Week Type 

Week Type configures which Day Type occurs by default on each day of the week.  Day 
Type selected for a particular day affects all the 4 Time Control groups. 

For instance, Day Type 1 is selected for Monday, all the Time Control groups will use 
Day Type 1 for Monday. However, since Day Type definitions for a Time Control group 
is independent of the other, Monday for each Time Control group can be different in 
terms of tariff rate arrangement.  

 

• Figure 8-16 Week Type setup 

Figure 8-16 shows Day Type selection for every day of a week. Select the Day Type for 
each day of the week using the drop down boxes.   

Season 

If more than one season is defined an independent week setup is made for each season.  
Select the season to display its current settings.  The number of seasons shown depends 
on the number of seasons configured in Season Setup page. See details in the next 
section. 

Day Types are only unique for every Time Control group, BUT are NOT unique for 
every Season unless seasonal day types are used (page 8-12).  Week Types are unique 
for each Season. 

 

Change Over Set 

As with Day Type definitions, a completely alternate definition can be made using the 
change over setting. If there is no Change Over date selected, the Change Over will be 
disabled on this page. See the section on Change Over for details. 
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Season 

Season allows a portion of a year to have a different arrangement of Week Type than the 
other portion(s) of the year.  

There are a maximum of 4 seasons. To add another season simply click the Configure 
Season button and set the season start date. Figure 8-17 shows a configuration of 2 
seasons. 

To remove a season click its Clear button.  

 

• Figure 8-17 Season setup 

The Use Persian Calendar option allows the dates to be set using the Persian Calendar.  
The default is the Gregorian Calender (January, February, etc).   

Persian Calendar edition firmware must be used if using Persian Calendar dates. 
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• Figure 8-18 Week Type in a season 

All seasons are using the same set of Day Types. If a completely different rate scheme is 
wanted for a season, use different Day Types. A simple example is: Season 1 uses Day 
Type 1 and Day Type 2; and, Season 2 uses Day Type 3 and Day Type 4. Figure 8-18 
illustrates this example – compare with Figure 8-16. 

 

Relay Daytype 

This option is available on meters fitted with load control relays.  See Chapter 16: 
“Relay Outputs” for more information.  
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Change Over 

Tariff Change Over defines a date in which the whole tariff scheme reverts to an 
alternative scheme. Tariff Change Over is applicable for a specific date in the future.  

To set this date, tick Tariff Change Over as shown in Figure 8-19. Choose the date from 
the calendar. 

 

• Figure 8-19 Tariff Change Over setup 

If Tariff Change Over is implemented, on the selected date the whole tariff scheme will 
be changed to the alternative scheme. 

The scheme affects Day Type, Week Type, and season. Annuals and specials (discussed 
below) remain undisturbed. 
 

The Use Persian Calendar option allows the date to be set using the Persian Calendar.  
In this case the date is entered as a day/month/year.   

Persian Calendar edition firmware must be used if using Persian Calendar dates. 
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Annuals 

A specific day of a year can be programmed to have a different tariff scheme than the 
week configuration would select.  Each year on the selected day the meter will use the 
indicated day type rather than that selected in the Week Type definitions.  The number of 
annual days that can be set depends on available configuration memory, but will 
generally be at least 200.  See Chapter 4 – “Memory Usage”. 

 

• Figure 8-20 Schedule of Annual Days setup 

Double clicking on an entry for a specific day of a year will pop up an Annual Day 
Setup page (Figure 8-20).  Choose the date from the calendar.  From the 8 Day Types at 
the bottom of the page, select the one that should be applied on that date. 

 

• Figure 8-21 Annual Day setup 
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The Use Persian Calendar option allows the date to be set using the Persian Calendar.  
In this case the date is entered as a day/month/year.   

Persian Calendar edition firmware must be used if using Persian Calendar dates. 
 

Specials 

Particular dates can be selected to have different tariff schemes. Unlike annual days, 
these days will not be repeated annually.  If it coincides with a day chosen in Annuals 
Setup, priority will be given to Specials Setup. 

Figure 8-22 shows the setup page.  The actual number of allowable special days 
depends on memory availability, as for annual days.   

 

• Figure 8-22 Schedule of Special Days setup 

To add a special day, double-click on the entry row. A form will pop up similar to the 
annual version, except that the year can be chosen. 

The Use Persian Calendar option allows the date to be set using the Persian Calendar.  
In this case the date is entered as a day/month/year.   

Persian Calendar edition firmware must be used if using Persian Calendar dates. 
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Billing Reset 

Billing Reset setup allows a manual reset or an automatic reset to be done periodically. 

 

• Figure 8-23 Billing Reset setup 

Mode 

Mode allows billing reset to be done on monthly basis by selecting either End of Month, 
Beginning of Month, or Special Dates.  The first two select whether the Day and Time 
are measured from the start of the month or the end.  The Special Dates option allows 
the exact date (including the year) and time to be specified for each billing reset (See 
Figure 8-24) – up to 449 entries (limits by calendar/LCD memory) each up to 499 days 
apart may be configured.  Select None if automatic billing resets are not required. 

A Daily Reset option was added in firmware version 1.31 which allows a reset to 
happen every day at a nominated time.   

A firmware edition with the Daily Billing Reset feature is needed to use Daily Reset. 
 

Day and Time 

Set the desired day and time for the meter to automatically perform a billing reset. 

Lockout Time 

Lockout Time specifies the number of minutes after one billing reset before another can 
occur. Lockout Time prevents accidental extra billing resets from being performed, 
particularly when manually pressing the Billing Reset button. If Lockout Time is not 
required, the value should be set to 0. 

Demand Settings 

Setting a Forgiveness Time means that if the power has been off for longer than the Off 
Time then the meter will block the recording of a new maximum demand until the 
Forgiveness Time has elapsed. 
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• Figure 8-24 Billing Reset special dates setup 

The Use Persian Calendar option allows the special dates or the repeating date to be set 
using the Persian Calendar.  In this case the date is entered as a day/month/year.   

Persian Calendar edition firmware must be used if using Persian Calendar dates. 
 

Disabling Billing Reset Button 

If manual billing reset is not required on meters with a billing reset button, go to 
Security Setup and tick Billing Reset Button Disable. Please refer to Figure 8-25.  The 
Hide Billing Reset message from LCD option simply stops the “Billing Reset” phrase 
from being displayed on the LCD. 

 

• Figure 8-25 Disabling the Billing Reset button 
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Viewing TOU 
When connected to the meter there are a number of information pages available.  
Selecting Screens →  Status on the Time Of Use tab brings up the main TOU status 
page (Figure 8-26). 

 

• Figure 8-26 TOU status 

The information is updated continuously from the meter, and displays the current meter 
time at the top.  The screen automatically adjusts to the number of channels and rates.  
Selecting the Type will select which TOU readings are displayed.  Fields that are not 
available will be marked as N/A – e.g. if a channel does not have a listed rate, or a time 
of maximum demand has not been set.  Mode has no effect for Atlas meters. 

The Save As buttons allows the TOU information to be saved to a file.   

 

• Figure 8-27 TOU Status period selection 

The Period setting in Figure 8-27 allows the billing period to be selected.  Note that 
only the number of billing periods that are available for viewing are shown in the list.  If 
a billing period occurs while this screen is shown the list may not be updated - exiting 
the screen and reopening it will refresh the list. 

 Time of Use 8-21   



 

   

8-22 

The Billing Reset will perform a billing reset.  The Clear button will clear all TOU 
information, including all previous periods.  Note that this does not do a billing reset – it 
clears everything.  

 

• Figure 8-28 TOU Online Variables 

The TOU Information tab (Figure 8-28) provides some status information about the 
TOU system – number of billing resets, date of the last reset, and the active rate for the 4 
rate groups.  

 

• Figure 8-29 TOU Online Variables 

Similar system information is available under the Online Variables → Tariff page 
shown in Figure 8-29.  The active rate for each rate group is shown, 1 being rate A, 2 
being rate B and so on.  The number of billing resets since the TOU system was last 
cleared is listed, along with the time and date of the last two billing resets.  Note that 
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since these dates come from the stored billing periods themselves, if no previous periods 
are configured to be stored (Figure 8-1) they will not be available. 

The Billing Reset button will ask the meter to do a billing reset immediately. 
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Chapter 9 Load Survey 
A load survey, otherwise known as a load profile, is designed to give a detailed record 
of energy usage.  The meter has two load surveys available, each independently 
programmable.  Each can record up to 32 channels, although generally this is limited by 
memory.  The load surveys in the meter also have the ability to record instantaneous 
figures such as voltage and current.  

Survey Setup 

 
• Figure 9-1 Load Survey Configuration page. 

Selecting LoadSurvey → LS1 or LoadSurvey → LS2 will bring up the configuration 
page (Figure 9-1).  The list shows the configured channels.  The Interval setting 
configures how long each recording interval is.  The Recording Time allocates enough 



 

   

9-2

memory to the survey to record for the specified time.  The maximum recording time is 
indicated, based on available memory and the survey configuration.  The scaling factors 
are discussed later (page 9-9), but default to sensible values. They operate in a similar 
way to TOU scaling factors. 

To add a channel, double click on the last “blank” entry.  To change a channel, double 
click on it.  Both these actions will being up the source selection page (Figure 9-2).  To 
delete a channel, select it then click the delete button. 

This page may be protected from editing to reduce the risk of accidental change.  To 
unprotect it select one of the Edit options at the bottom of the page.  See “Protected 
Setup” on page 3-10 for more information. 

 
• Figure 9-2 Load survey source selection 

The channel setup works in a similar way to TOU channel setup, except that there are a 
few more options.  

As with TOU, the Mk7 has Main, Load, and Neutral instead of Phase A, B, and C.  
Total is the sum of Main and Load.  Unfitted elements are not shown, or listed as 
Unused. 

The Energy tab has all the energy quantities that the meter can measure.  The first 
column selects which quadrant(s) the energy comes from.  The Absolute setting reads 
positive energy for import or export energy. See Figure 2-31 on page 2-24 for 
clarification of import, export and quadrant conventions. 

The second column selects the type of energy, Wh, varh, or VAh. 

Finally the third column selects which phase to record the energy from.  Total is the sum 
of all three phases.  The individual phase selections allow energy from only one phase to 
be recorded, useful if there are separate loads on each phase or for tamper monitoring.  

The order that some of the channels appear is determined by EziView for optimal 
memory usage.  Thus after setting a series of channels EziView may rearrange them 
slightly.  The Preserve Channel Order option will stop this optimisation from 
happening, but it may result in more memory usage. 
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  Survey Setup 

When there are pulsing inputs configured in the meter a Pulsing Input tab becomes 
available.  This shows the available pulsing inputs for selection (Figure 9-3). 

 

• Figure 9-3 Pulsing input channel selection 

The Instantaneous tab allows the recording of measured quantities such as voltage and 
current. 

 

• Figure 9-4 Instantaneous channel selection 

The first column selects the quantity to measure.  Average Current is an average of the 
three phases, as is Average Voltage.  Watts Sum is a sum of the three phases, as are Vars 
Sum and VA Sum. 

Fundamental measures the fundamental component only of the selected phase of either 
voltage or current.  Unbalanced measures the zero, positive, and negative sequence 
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components in a three phase system.  THD measures the THD expressed as a 
percentage of the fundamental.  Fundamental current, Unbalanced current and THD of 
current are not available in the current firmware (v1.31). 

Fundamental, Unbalance, and THD readings are only available with the Power Quality 
firmware edition code. 

Signal Strength was added in version 1.30 firmware.  It allows the signal strength of the 
modem to be logged.  A signal strength of 99 (unknown strength) is interpreted as 0. 

Temperature is the internal temperature of the meter in degrees Celsius. 

The second column selects the phase to record.  The Operation column selects how to 
process the data.   

When Average is selected, the meter averages the quantity over the interval.  If the 
meter is turned off during part of the interval that time is ignored in calculating the 
average.  The Demand Average option means that if the meter is turned off during part 
of the interval, that time will be counted as if the reading was zero for that period.  E.g. 
A meter measuring 240W, and the meter is off for half of the interval.  Average will 
report 240W, while Demand Average will report 120W.     

Since Demand Average is more relevant for power quantities, the voltage and current 
Demand Average options are unavailable in Power Quality editions of firmware, to 
make room for the new Power Quality features – there use should thus be avoided.  In 
newer versions of EziView (4.07) the voltage and current demand average options have 
been removed. 

When Minimum or Maximum are selected, the meter calculates the minimum or 
maximum of the quantity over the interval, based on 5 cycle readings. 

When Instantaneous is selected, the meter takes a single 5 cycle reading at the end of 
the interval. 
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• Figure 9-5 Miscellaneous channel selection 

The Miscellaneous tab allows selection of special options. Test Energy uses a phantom 
Wh energy source, useful for testing when no load is available.   

Changes to the channel setup will cause the load survey to be cleared in the meter.  It 
may also clear the other load survey, the TOU system and reinitialise pulsing outputs, 
depending on the exact configuration. 
 

 

• Figure 9-6 TOU channel selection 

The TOU tab allows TOU accumulated unified rate totals to be recorded in the load 
survey.  Each one takes up the space of 2 normal channels.  This requires a firmware 
edition that supports this feature.  Figure 9-6 shows an example of the options. 

You MUST have the “Wide Surveys” firmware edition that enables this feature.  If the 
meter does not properly support it, you will get corruption of the load survey and TOU. 
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Retrieving a Survey 
Surveys can be downloaded using a readings file (advanced usage), from the Status 
screen, or from the memory map page of online variables.  Only the latter two are 
discussed here. 

 

• Figure 9-7 Online Status 

The Status screen Surveys tab (Figure 9-7) allows selected periods to be downloaded, or 
the entire survey.  The data is displayed in the lower part of the page, or can be saved to 
a tab delineated file using the Save as… button. 

 

• Figure 9-8 Online Variables Memory Map 
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To use the Online Variables screen (Figure 9-8, see Flash/EEPROM Memory Usage on 
page 4-3 for more information) right-click on the survey to download, and select either 
Download and select a filename to download to, or use the Send to option.  Programs to 
use with Send to can be entered using the Make New… command in the Send to menu. 

The survey is downloaded as a text file with a tab delimited format, similar to Figure 
9-9.  The header section is used by EziView to track download progress.  Each record 
has a unique number starting from when the survey was started, which is only reset if 
the survey is cleared.  The time and date is of the end of the interval that the value was 
recorded over. 

[LoadSurvey] 
LastRecord=000000007 
StartTime=20/01/2004 10:56:00 
 
Record No Date/Time V PhC Min  V  PhC Max  V PhC Inst  V PhC Acc Status 
    (0x00002185)(0x00002285)(0x00002385)(0x000000A5)  
0 20/01/2004 10:56:00  243.00 249.96 246.91 236.91 .I..... 
1 20/01/2004 10:57:00  246.83 246.96 246.86 246.88 ....W.. 
2 20/01/2004 10:58:00  246.83 247.31 246.88 247.05 ....W.. 
3 20/01/2004 10:59:00  246.80 246.94 246.84 246.88 ....W.. 
4 20/01/2004 11:00:00  246.82 247.25 246.89 247.02 ....W.. 
5 20/01/2004 11:01:00  246.82 246.93 246.86 246.87 ....W.. 
6 20/01/2004 11:02:00  246.82 247.19 246.88 247.02 ....W.. 
7 20/01/2004 11:03:00  246.85 247.00 246.93 246.91 ....W.. 

• Figure 9-9 Downloaded survey 

The status channel records a series of flags about the interval, mostly for use with data 
validation.  Table 9-1 lists the options. 
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Bit EziView 
Code 

Meaning 

0 A Absent Reading - Filled entry - no data.  All data values to be ignored (they 
will generally be zero) 

1 I Incomplete interval. 
Normally this specifies any interval where the interval was short or long, 
whether due to a time change or power outage, or the very first interval. 
When the Load Survey I Flag on all Intervals with a Time Change option is 
set (See Figure 11-2) then the I flag only flags intervals where a time change 
occurred (or that a time change skipped over).  Usually used with the P flag 
option on the same page, this separates the P and I flags to indicate 
short/long intervals due to time changes, or short/long intervals due to power 
outage. 

2 P Power failed during interval.  This is set in the interval where power was lost, 
not where it just continued to be lost or was restored. 
The operation can be changed to indicate the P flag in all intervals where 
power was lost, restored, or continued to be lost, using the Load Survey P 
Flag on all Intervals with a Power Outage setting. See Figure 11-2. 

3 L User programmable flag derived from the active EFA status. 
MV90 labels this as a critical error using interval bit 5. 

4 W User programmable flag derived from the active EFA status. 
MV90 labels this as a clock error using channel bit 7. 

5 U User programmable flag derived from the active EFA status. 
MV90 labels this as a VT failure using channel bit 9. 
May also be configured to indicate a setup change using the Load Survey U 
Flag Records Setup Changes.  See Figure 11-2. 

6  Reserved 

• Table 9-1 Survey status byte information format 
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Scaling, Units and Overflows 
The Scaling settings allow for the default settings that EziView makes to be overridden.  
These can be used to increase the resolution of survey entries, or set a certain multiplier.  
They only affect energy quantities – the scaling of instantaneous quantities is always 
controlled by EziView. 

The meter records energy as pulses, each pulse representing an amount of energy.  If the 
meter is showing Wh to 1 decimal place, each pulse is 0.1 of a Wh.  The meter can 
record up to 65535 pulses in an interval.  Beyond this it will “saturate” at 65535 until the 
end of the period, and flag a pulsing overflow EFA.  

 

• Figure 9-10 Survey scaling setup 

Figure 9-10 shows the survey scaling setup.  The Default Scaling sections indicate what 
EziView recommends based on the interval and maximum voltage and current.  The 
indicated Overflow amount is designed to give an indication of the maximum power the 
meter can record continuously before overflow occurs.   

E.g. in Figure 9-10 the Overflow is 26.214kW.  With the 15 minute period, this means 
that a maximum of 6.5535 kWh can be recorded in an interval before saturation occurs.  
On a 3 phase, 240V system this would represent a continuous load of around 36 amps. 

Do not use User Defined Scaling unless you are very sure of what you are doing.  
Incorrect use can lead to overflows and truncation.  Beware of situations such as setting 
a user defined figure, then changing transformer ratios.  Due to the risks, User Defined 
Scaling settings are now hidden.  If you need to use them contact EDMI. 
 

If the load is known to be less than 3.6 amps on average, the scaling can be overridden 
to something like a unit scaling with 2 decimal places.  This is done by checking the 
User Defined Scaling box and setting a new scaling.  EziView will warn that the 
changes are different to the recommended settings. 

The unit factor and the number of decimal places apply to the display and resolution of 
an interval. 
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The other usage is to change the multiplier.  If in the example the energy is wanted to be 
shown as kWh rather than Wh, EziView can be overridden.  Set the Unit Factor to “k” 
and the decimal places to 4 to get the same effective scaling, but with a scaling factor of 
k. 
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Chapter 10 Date and Time 
Time is a fundamental quantity.  The management of time is extremely important, 
especially in how time changes are handled.  For example, having two 2pms in the one 
day is not physically possible, but is possible for the meter to experience when a time 
change occurs. 

Changing the Time 

Time and date information from the meter is accessible from the Screens → Online 
Variables → Date Time dialog in EziView (Figure 10-1). 

 
• Figure 10-1 EziView Date and time page. 

The top panel displays the time on your computer (PC) and the time read from the 
meter.  To set the time on the meter to the same as the computer click the Set Meter 
button. 

Changing the time may have an effect on stored data.  Make sure you understand the 
possible consequences before changing the clock by large amounts (see below). 
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The time displayed is daylight saving time.  As such, the computer time should be set to 
daylight saving time – not standard time. 

Note that EziView checks the time difference between the meter and the computer when 
transferring setup with the meter.  If the time difference is too large, it will ask if it 
should synchronise the time.  See Chapter 3 – “Configuration Basics” for more 
information. 

Consequences of Changing the Time 
Changing the time may affect the time of use and load survey systems.   

For TOU, if a billing reset is skipped, it will be performed.  If multiple billing resets are 
skipped, only one will be performed.  Setting the time backwards will not cause a billing 
reset to be performed as it is assumed to have already happened.  Energy accumulation 
and maximum demand calculations will immediately change to the rate of the new time, 
though the first maximum demand periods will be skipped since they represent partial 
intervals. 

For load surveys if the time is changed forward the affected period at the start and the 
end (for a large change) will be marked as incomplete intervals.  Any periods skipped 
over will be marked as absent.  If the time is set back by less than an interval it will 
result in a longer than normal interval.  If the time is set back by more than one interval 
(ie one complete interval is skipped over), the load survey will be cleared.    

Year 2000 Issues 
The meter is fully year 2000 compliant.  It uses two-digit year, with a defined pivot date 
of 96.  Years from 96 to 99 are treated as 1996 to 1999.  Years from 00 to 95 are treated 
as 2000 to 2095.  The year 2000 is treated as a leap year.  The meter keeps time 
internally as the number of seconds since the start of 1996, using 32-bit numbers to 
ensure operation beyond 2050.   

Timing Source 
The reference for timekeeping may come from one of two sources.  The first is an 
internal crystal clock.  This clock is also maintained during loss of power by the meter’s 
battery.   

The second time source synchronises the time to the system frequency of the measured 
voltages and currents, any phase.  Many generation authorities adjust the system 
frequency slightly over the course of the day to ensure that clocks based on the system 
frequency read correctly in the long term.  There may be some short-term variations that 
will depend on the generation authority. 
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The meter may be set to operate only on the internal crystal clock (called Internal 
operation), or to operate in the system frequency (called Line operation).  In Line mode 
the clock will revert to Internal operation if there is no signal to extract the system 
frequency from. 

 
• Figure 10-2 EziView date and time setup page 

The time source is configured via EziView’s TimeSetup page (Figure 10-2).  Set the 
Time Source field to the required mode of operation.  The System Frequency field 
allows the base system frequency to be specified. 

Time Calibration 

The Time Calibration setting allows the internal clock accuracy to be adjusted.  The 
clock is calibrated in the factory, but external factors such as average temperature can 
affect accuracy.  The setting may be made here in seconds per month (for a 30 day 
month).  A positive value will make the clock run faster. 

Time Change Control 

The Time Control settings allow the effect of time changes to be lessened.  Change 
Limit is the time in seconds that a low level user can change the time by in one go. 

If a time change is less than the number of seconds in Slide Limit, the time change is not 
made straight away.  Instead the time is sped up or slowed down by up to 2 seconds per 
minute to catch up with the programmed time.  When changing the time it will appear 
that the time has not changed, but after the time has been allowed to slide the time will 
be correct. 
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The Boundary setting is used to minimise the effect of time changes on load surveys and 
demand calculations.  The setting is in seconds, and should generally be set to match the 
demand and/or survey period.  If a time change would cross an interval the meter will 
delay the time change so that it will only affect one interval.  If the time change would 
cross more than one boundary a normal time change is made.  If the meter can slide the 
time, then the boundary functionality will not be used. 

For example: a meter with 30 minute load survey and demand intervals, using the 
recommended Boundary setting of 30*60 = 1800 seconds.  This creates boundaries at 
half hour intervals (eg 8:00, 8:30, 9:00).  A time change from 8:25 to 8:35 would be 
delayed until 8:30, when the time would change to 8:40.  A time change from 8:35 to 
8:25 would be delayed until 8:40, when the time would change to 8:30.  A time change 
from 8:10 to 8:20 would occur normally, since it does not cross a 30 minute boundary. 

In this way only the 8:30 – 9:00 interval is affected by the time change, rather than both 
the 8:00 – 8:30 interval and the 8:30 – 9:00 interval. 

Loss of Power 

If no battery is fitted or it is discharged the meter will use the time that the meter 
powered off, or if that is not available then it reverts to 1/1/1996.  A Clock alarm will 
also be raised.  Restarting with the “power off” time reduces the possible “loss” of data 
that changing the time could cause. 
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Daylight Saving 
The meter fully supports daylight saving.  Figure 10-3 shows the setup page. 

 
• Figure 10-3 EziView date and time setup page – Daylight Savings. 

Check the Enable Daylight Savings box to enable the other settings.  When unchecked 
daylight saving is not used, and daylight saving time is always the same as standard 
time.  

Daylight Saving requires an edition for firmware that supports it (DLS).  If this is not 
present, daylight saving setting will be ignored by the meter.  
Start Date: The date on which daylight savings will begin.  The exact date on which 
daylight savings will occur will be the day (Start/End Day) on or after the set date, 
unless it is set to fixed day.  

Start Hour: This is the hour during the day when daylight savings will become active on 
the specified date, generally 2 or 3 am. This is always specified as standard time. 

Start/End Day: This is the day of the week on which daylight savings will begin or end.  
In most cases this will be Sunday. The Fixed Day option makes the changeover occur 
on the exact date. 

The End Date is the date on which daylight savings will end.  The exact date on which 
daylight savings will occur will be the day (Start/End Day) on or after the set date, 
unless it is set to fixed day.  The End Date must follow the start date and be within 12 
months.  For Southern Hemisphere use this means the End Date will be a date in the 
year following the Start Date. 
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The End Hour is set to the standard time at which time should revert back from 
summer time.  This means if the rule is to change the clock back an hour at 3am 
(making it 2am), the setting would be 2am. 

The Hours To Skip setting specifies in whole hours the number of hours to jump 
forward on the Start Date and the number of hours to jump back on the End Day. 

No of Years specifies how far ahead EziView calculates daylight saving time.  Beyond 
this time the meter will stop changing into daylight saving time.  The View/Edit DLS 
button brings up a page (Figure 10-4) to edit the exact dates of change. 

 
• Figure 10-4 Daylight saving details  

The exact switchover times that EziView will write to the meter are listed.  The Auto 
Calculation button will recalculate them based on the previous page’s settings (and they 
will generally recalculate when the page settings change).  These dates can be edited, to 
allow for cases where daylight saving was different (e.g. for the Sydney 2000 Olympic 
games the daylight saving start date was changed for that year only). 

Example  

To set the start time to be 2 a.m. (Standard Time) on the first Sunday in February: 
 Start Hour = 2, Start Day = Sunday, Start Date = 01/02/xx 

 To set the end time to be 2 a.m. (Summer Time) on the last Sunday in October: 
  End Hour  = 1, End Day  = Sunday, End Date = 25/10/xx 

Register F061 reports the system time after any daylight savings corrections have been 
added.  The register cannot be written. The meter time can only be set to standard time 
through the normal registers. 

Persian Calendar allows the start and end date to be entered using the Persian Calendar 
system.  This requires an edition that supports the Persian Calendar. 
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How DLS affects meter operation 

1) The actual time change will occur as follows in Table 10-1 for the previous example 
of start/end times in 1999 using a jump of one hour: 

Time Time Mode 
01:59:58  07/02/99 Standard 
01:59:59  07/02/99 Standard 
03:00:00  07/02/99 Summer Started 
03:00:01  07/02/99 Summer 
… Summer 
01:59:58  31/10/99 Summer 
01:59:59  31/10/99 Summer 
01:00:00  31/10/99 Standard Started 
01:00:01  31/10/99 Standard 

• Table 10-1 DLS example 1 

2) Load surveys and event logs will always use standard time for the date stamp.   The 
record of Billing Reset in the event log is in standard time. 

3) The TOU system (billing resets, rates, seasons and changeover) will run off summer 
time if daylight saving is active and standard time if it is inactive.  All TOU registers 
including time of maximum demand and date/time of billing resets are recorded in 
summer time. 

4) Avoid setting billing resets to occur in the period over which the time jumps. From 
the example, a billing reset set to occur at 2:30:00 07/02/99 (standard time) will not 
occur since there is no actual 2:30 on that day. Similarly, a billing reset set to occur at 
1:30:00 31/10/99 (summer time) will occur twice, since there are two instances where 
the time is 1:30.  

5) Settings such as rates and seasons will work correctly. However if a range begins 
during the period in which time is changed back, the results may seem odd. In the case 
of a season or a rate beginning at 1:30:00 31/10/99 (summer time) the following would 
result (Table 10-2). 

DLS Active? Time Active Rate 
D 01:29:59  31/10/99 Rate 1 
D 01:30:00  31/10/99 Rate 2 
D 01:30:01  31/10/99 Rate 2 
D … Rate 2 
D 01:59:59  31/10/99 Rate 2 

Ending 01:00:00  31/10/99 Rate 1 
 01:00:01  31/10/99 Rate 1 
 … Rate 1 
 01:29:59  31/10/99 Rate 1 
 01:30:00  31/10/99 Rate 2 
 01:30:01  31/10/99 Rate 2 

• Table 10-2 DLS example 2. 

This is correct since there are two 1:30 time instances on 31/10/99.   
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6) To display standard time on the LCD use register F03D.  Register F061 gives 
daylight saving time, but cannot be written.  All time settings to the meter are done 
using standard time to avoid ambiguous times.  EziView converts daylight saving time 
to standard time when writing the time to the meter. 

7) Modem power cycle times and GPRS push timings are based on standard time. 

Time Statistics 
The meter maintains a set of statistics about when it was operating.  These can be useful 
in fault and outage tracking, and in tamper detection. The Screens → Online Variables 
→ Date Time dialog in EziView displays this information (see Figure 10-1). 

The Power On/Off panel gives accumulated power on and power off times since they 
were last cleared.  To clear the on and off times click associated Clear button.  The off 
time count can be used to monitor the usage of the meter’s battery. 

The Last Power On/Off panel gives statistics about when and how long ago that power 
was last lost and applied. 
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Chapter 11 Alarms 
During operation the meter monitors a variety of internal and external conditions.  If a 
problem is detected an alarm is raised called an Equipment Failure Alarm, or EFA.  
These tests are designed to detect measurement faults, tampering attempts, and 
hardware failure. 

 
• Figure 11-1 EziView Status screen 

The alarm status can be viewed on the Screens → Status, EFA tab screen using EziView 
(see Figure 11-1).  Unique alarms are raised for different types of monitored conditions.  
In this case there is a series of active measurement and tamper alarms (indicated by 

), and a latched Pulsing Output Overflow alarm (indicated by ).  The EFA tab 
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flashes when there are active alarms.  Latched alarms can be cleared using the Clear 
button. 

Alarm States 
There are 17 different alarms, each representing a different type of fault.  Each alarm has 
a corresponding flag letter that represents it, listed in Table 11-1.  There is also an alarm 
code, which ties in with MultiDrive alarm handling. 

Flag Letter Alarm Name Alarms Page Code 
E Analog Reference Failure A003 
S Asymmetric Power on Mk10 

Neutral current Mismatch on Mk7 
A000 

V Voltage Tolerance Error. A006 
F VT Failure. A007 
R Incorrect Phase Rotation. (not on Mk7) A002 
T Lid Tamper A005 
C Clock Failure. A017 
M Reverse Power. A004 
L Calibration Data Lost. A001 
H Modem Failure. A012 
X RAM Failure or LCD Failure. A015  
Y Program Flash Failure. A015  
Z Data Flash Failure. A015  
N Pulsing Output Overflow. A008 
D Battery Failure A016 
U Tamper A005 
O Overcurrent (Extra EFAs group)  

• Table 11-1 Alarm names and flag letters. 

An alarm flag can have one of 3 states.  The active state means that the alarm has been 
detected and is still occurring.  The latched state means that the alarm was active but 
isn’t now.  The inactive state means that the alarm is not active and has not been in the 
past.   

Latched alarms stay latched even if power is removed from the meter.  They may be 
cleared using the Clear Flags button on the Screens → Status screen in EziView. 

Alarms that should not cause an EFA may be disabled.  Each alarm has a mask that 
stops it from causing an EFA when set. 

When reading the alarm state from a register a string format is used.  The alarm status is 
displayed as a string of 16 characters, with each alarm’s flag letter used to indicate an 
alarm.  An inactive or masked alarm is represented by a full stop.  An active flag is 
represented by upper case.  All flags active looks like “ESVFRTCMLHXYZNDU”.  
The full stop represents an unused alarm position.  The letters always appear in the same 
locations.   
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In version 1.40 firmware space for an extra 16 flags was added, the first of these being 
the Overcurrent alarm.  This second set of flags has its own registers for display. All 
active for the second set looks like “O……………”. 

EFAs can be displayed on the LCD Screen. Please refer to Chapter 6 under the “LCD 
Setup” section.  Pulsing outputs and enunciators can also be used to indicate a particular 
EFA being raised (refer to Chapter 13). 

When an EFA is raised and indicated on the LCD Screen, it may not mean that the 
meter itself is malfunctioning.  Some EFAs are caused by external abnormalities – 
check which EFA is active.  

Alarms 
There are 17 types or alarms available. 

 

• Figure 11-2 Alarm masks 

The EFAs and Extra EFAs tabs at the top of the screen allow selection between the first 
16 and second 16 alarms. 

The checkboxes at the top half of the screen define a series of 7 alarm masks.  When the 
checkbox for an alarm is checked, that alarm is allowed to trigger that EFA.  The EFA 
Alarm mask is used to generate the generic EFA alarm.  The Event Log mask affects 
which alarms will generate an event in the event log.  The Load Survey masks affect 
which alarms will cause the respective EFA flags to be set in the load survey entry’s 
status field. The last two are for general use with output or enunciator control. 
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The All button will set all checkboxes for that row, and the None button will clear all the 
checkboxes (note it does not set the checkboxes on the other tab). 

Normally when an event log EFA is raised, it is recorded in the event log only if the 
alarm is not already latched.  If the Log Already Latched Alarms box is checked, the 
meter will log the occurrence of an EFA even if it is already latched. 

The Load Survey U Flags Record Setup Changes option causes the U flag in load 
surveys to be set if a setup change occurs in that interval.  This is in addition to any EFA 
flags that may be configured in the settings above to activate the U flag.   This feature 
requires firmware version 1.18 or later. 

The Load Survey P Flag on all Intervals with a Power Outage option causes the P flag 
in load surveys to be set for all intervals where power was lost, restored, or absent.  The 
default mode of operation is to only set the P flag for intervals where power was lost. 
This feature requires firmware version 1.18 or later. 

The Calendar is Used to Change Relay State option will put entries into the system 
event log (code 60) when a relay is switched by a calendar program, such as setting a 
relay to turn on and off for a certain time period every day. 

The Relay Physical Switch Used to Change Relay State option will put entries into the 
system event log (code 61) whenever the relay physically changes state.  This is in 
addition to the other relay change log entries, and signals exactly when the relay 
physically changed state. 

Many of the alarms have options as to when they will trigger.  Figure 11-3 shows the 
available options. 
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• Figure 11-3 Alarm settings 

The Nominal Current is the nominal secondary current of the meter.  This is the 
nominal current at the meter terminals.  Alarms Disabled Below sets a condition 
(referred to as Imin) that stops alarms from activating when the current is very low – 
useful to stop false triggers. 

The Nominal Voltage is the nominal secondary line to line voltage of the Mk10 meter.  
This is the nominal voltage at the meter terminals.  For example, a 110V/63.5V system 
the Nominal Voltage should be set to 110V, regardless of whether the meter is 
connected in 2 element or in 3 element mode.  The voltage is always specified as a line 
to line voltage – the meter adjusts it automatically based on the element mode. 

The Nominal Voltage is the nominal secondary line to neutral voltage of the Mk7 meter.  
This is the nominal voltage at the meter terminals.  For example, a 415V/240V system 
the Nominal Voltage should be set to 240V. 

Voltage and Current Setting 

Many of the alarms have settings relative to the Nominal Voltage and Nominal Current.  
These are Asymmetric Power, Voltage Tolerance, and VT Failure.  All these plus 
Incorrect Phase Rotation and Reverse Power have a time they must be active for, and a 
current that must be flowing before they are active (Alarms Disabled Below setting).  
These factors are used to prevent false triggering. 

The Asymmetrical Power setting gives the limit in percent for the unbalance in power.  
The Voltage Tolerance figures set the allowable voltage range, given as upper and lower 
percentages of nominal.  The VT Failure setting gives the minimum VT voltage 
(referred to as VT fail), given as a percentage of nominal. 

Battery and Reference Settings 

The Minimum Battery Voltage is the setpoint in volts at which a low battery alarm will 
be triggered.  The Reference Drift setting is used for the Analog Reference Failure EFA. 

THD and Unbalance Settings 

These set the level at which a THD or Unbalance event is added to the event log,  The 
Power Quality Delay sets the time that these limits must be exceeded continuously 
before an event is registered.  The THD event is calculated from the voltage THD’s, and 
the Unbalance event is calculated as ((voltage negative sequence) / (voltage positive 
sequence))  * 100 = %.  The maximum setting for the limits is 25.5%, in 0.1% steps. 

See Power Quality on page 12-11 for more information. 

Over Current 

The Over Current settings give the setpoint in Amps which if exceeded will trigger an 
Over Current EFA.  The setting can be made per phase, or per element for Mk7 meters.  
There is a separate delay control for each phase/element. 
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Power Factor Lag Limit 

These settings configure the Power Factor monitor, which monitors the per phase (not in 
2 element mode) and total power factor of the meter.  If a power factor when in lag is 
less than the first setting for the delay period, a low severity lag power factor start event 
is added to the event log.  When less than the second setting for the delay period a high 
severity lag power factor start event is added to the event log.  When the power factor 
returns within limits an end event is added to the log.  The event includes the phase 
affected, and operates independently per phase and total. 

Only available in firmware version 1.40 and later on enhanced processor meters.  If all 4 
(high/low, lag/lead) limit settings are zero the feature is disabled. See Power Factor on 
page 12-16 for more information. 

Power Factor Lead Limit 

As per the Power Factor Lag Limit, but for leading power factors. 

Magnetic Tamper 

Setting a non-zero value here will cause the meter to register that much power while a 
magnetic tamper is detected.  The idea is to make the meter read maximum if a tamper 
is detected to discourage tampering the meter. 

Alarm Types 
A detailed description of each alarm is provided below. 

Note that where a programmed delay time is specified, this means that the fault must 
exist continuously for the set time before an alarm will be raised.  Meter reset/loss of 
power will restart the timers. 

Analog Reference Failure - E 

This is a check of the meter’s measurement reference.  If it has shifted by a significant 
amount the alarm is triggered.  The allowed variation may be set.  Variations of several 
percent are normal, as the reference is checked against a regulated voltage.  

Calibration Data Lost - L 

This is a check for valid calibration data in the meter.  If the calibration data has been 
lost or cleared a “Calibration Data Lost” alarm will be raised.  This will occur if a unit 
has never been calibrated, or if a major fault causes both the non-volatile RAM and 
FLASH to be corrupted. 

Asymmetric Power - S 

Power Symmetry (Pu) is defined as the amount of unbalance between the individual 
phase powers.  The calculation of this figure depends on the measurement configuration 
(2 or 3-element) as detailed below.  This test is not performed if all of the input currents 
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are below the minimum current threshold, Imin.  This test is not done on the Mk7, 
though space is reserved for neutral current detection. 

If the value Pu is greater than or equal to the set limit, then a power symmetry error is 
considered to be present.  Unbalance must exceed the bounds for a programmed time 
(default 1 minute) before an alarm is raised. 

For 3 Element configuration: 

The calculation of power unbalance (Pu) is based on the maximum and minimum power 
levels from the three phases (Pmax and Pmin): 

min)max( −
P( max)abs

PPabs
=Pu

 
For 2 Element configuration: 

The voltages must be in tolerance, and: 
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Voltage Tolerance Error - V 

The voltage input levels on each phase are tested to ensure that they remain within the 
limits set by Vmax and Vmin.  Only those phases with at least Imin current are tested.  
Vmax and Vmin are specified as a percentage of the nominal voltage, Vn.  For 3-
element measurements, Vn = line to line nominal / √3, for 2-element measurements, Vn 
= line to line nominal.  In 2-element mode, only inputs Va and Vc are tested.  A 
programmed time delay (default 1 minute) is applied to this test. 

VT Failure - F 

A VT failure is indicated if the voltage measured by any input is less than Vfail and the 
corresponding current input is at least Imin.  Phase B is not tested in 2-element mode.  A 
programmed time delay (default 1 minute) is applied to this test. 

Reverse Power - M 

A reverse power alarm is indicated if power is negative on any phase (provided the 
phase is carrying current and the voltage is within tolerance).  In 2-element mode this 
test is applied to the total power.  A programmed time delay (default 1 minute) is 
applied to this test. 
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Incorrect Phase Rotation - R 

The phase rotation of the applied signals is tested to ensure that the correct phase 
rotation is maintained.  The method of determining the phase rotation is dependent upon 
the measurement configuration.  For both methods, the test is applied only if all of the 
voltages are between the limits of Vmin and Vmax. A programmed time delay (default 1 
minute) is applied to this test.  (An error condition must be present for more than the 
programmed time delay (default 1 minute) before the alarm is activated.)  This test is not 
performed on the Mk7. 

2-Element - For 2-element measurements, the angle between the two applied voltages 
(Vab to Vcb) must be between +30 and +90 degrees. 

3-Element - For 3-element measurements, the angles between each successive voltage 
input (Vab, Vbc, Vca) must be between -90 and -150 degrees. 

In meter firmware versions prior to 1.19, tests were also carried out on the currents.  
This measurement has been removed to avoid false triggering in cases of highly 
unbalanced loads. 

Clock Failure - C 

This alarm will be triggered if the clock information was lost while the meter was turned 
off.  This means the clock is probably wrong, and may indicate a weak battery. 
Available in firmware v1.21 and later. 

Tamper - U 

This alarm indicates that a strong magnetic field was detected, most likely due to an 
attempted tamper.  The magnetic sense factory option must be fitted. 

Modem Failure - H 

This alarm is generated if the modem is found to be faulty.  This would generally be 
indicated by no response from the modem. 

RAM or LCD Failure - X 

The RAM is checked for corruption, and the LCD controller is monitored for correct 
operation.  If any faults are found, then an alarm is raised.  This test is performed 
continuously. 

Program Flash Failure Y 

The content of the program Flash memory is tested using a checksum.  If the checksum 
calculated is different from that stored with the program an alarm is raised.  These tests 
are performed continuously. 
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Data Flash Failure Z 

The data memory contains information about the system configuration and calibration 
data.  Erases and writes are monitored, and the alarm is raised if an erase, read or write 
fails to operate correctly.  This may indicate a possible error with the device. 

Pulsing Output Overflow - N 

A pulsing overflow alarm is generated if the rate of pulses to be output is such that the 
off time between pulses violates the specified minimum off time for pulsing outputs.  
The pulses will still be output, but the off time will be less than the specified minimum, 
and in extreme overflows the off time will be zero, resulting in a permanently on output. 
This alarm provides a warning that the settings for the pulsing outputs may need to be 
changed.   

This alarm will also trigger if the TOU demand or load survey interval accumulators 
overflow.  In this event energy is “missed” as the accumulators are full.  This can occur 
if the scaling for these has been pushed beyond EziView’s default settings. 

Battery Failure - D 

The battery is tested roughly once a minute.  If the measured voltage is less than the 
minimum battery voltage setting an alarm is raised. 

Lid Tamper - T 

On meters fitted with a lid tamper switch, this alarm will be raised if the lid is opened.  
The switch may be built in (eg Mk7C), or controlled by an input (‘Input Setup’ on page 
14-1). 

Over Current - O 

The meter monitors the current on each phase, or element for Mk7 meters.  If the Over 
Current limit is exceeded for the corresponding delay the Alarm will become active, 
and will remain active while the condition continues.  This is useful to flag if a site is 
using too much current for the meter or CT rating (eg over 100A for a 100A meter), or 
if some phases show current when there should be none (tamper).  It could also be used 
to detect situations where a predictable load such as a hot water system has additional 
loads connected. 

Note that this alarm does not show up on the Status screen in EziView 4.21. 

Push Alarms 
Push alarms is a feature where an alarm message can be sent via GPRS or displayed on 
the LCD when certain events occur.  This is used by the Mk10 UPS meter, and is now 
also available in other editions. 
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This system uses the tamper log and diagnostics log to buffer events.  The diagnostics 
log is renames to the Push Alarm log and holds messages to be sent via GPRS.  In UPS 
meters the tamper log is renamed the LCD Alarm log and holds alarms to be displayed 
on the LCD - it must be set to 10 entries.  In other meter types with events enabled the 
tamper log serves its usual purpose (tamper events).  The Push Alarm log should be 100 
entries. 

To configure the events to trigger the Events page is used (Figure 11-4).   

 

• Figure 11-4 Event Push settings 

When GPRS is selected the event will be added to the queue and pushed via GPRS.  
When LCD is selected the selected event will be added to the LCD alarm display. 

Double clicking on an event will edit it, or create a new event if it is the bottom blank 
entry.  This brings up the Events Setup page shown in Figure 11-5. 
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• Figure 11-5 Events Setup 

Most of the events listed are normal event log events.  There are some special entries 
though, listed in Table 11-2. 

Event Name Code Description 
UPS Alarm - Power 
Outage, UPS engaged 

B200 Indicates that the UPS was started in response to loss of supply. 

UPS Alarm - Power 
restored before UPS went 
off 

B201 Indicates that power returned while the UPS was still active (ie 
the meter never shutdown). 

Unable to successfully 
send an alarm 

B210 We tried to send an alarm to the server but no acknowledge was 
received. 

Latched input alarm B22X The state of Input X changed from off to on. 

Unlatched input alarm B23X The state of Input X changed from on to off. 

Momentary input active 
alarm 

B24X The state of Input X changed (either from off to on, or on to off) 

• Table 11-2 Alarm Push extra events 

The LCD Desc field is used to enter a 3 letter code which is displayed when showing the 
alarm on the LCD. 

The actually display the alarms on the LCD then some LCD screens need to be 
configured to display the last alarms.  These can be selected on the Status page (Figure 
11-6).  “Last UPS Event” gives the most recent event.  “2nd Last” gives the second most 
recent, etc. 
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• Figure 11-6 Last UPS Event settings 

When the alarm is shown on the LCD it is shown with the number of the alarm (from 
newest to oldest), a 3 letter alarm code, and the date and time of the alarm.  For example 
“01 BAT 12:30:00”, where BAT is the three letter code entered in the description, and 
the date and time alternate every second.   

To clear an alarm press and hold the Select button for 10 seconds while the alarm is 
shown.  The LCD will display “ALARM CLEARED” and will shuffle a new alarm into 
that position of the queue. 

To clear the alarms remotely clear the LCD Alarm Log (from Online Variables→ 
Memory Map, Figure 12-2).  This clears all the alarms. 

While there are alarms on the LCD the UPS LCD Alarm Active output is on, which can 
be used to light an LED or enunciator, or set an output.  See Chapter 13: Outputs and 
Enunciators. 
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Chapter 12 Event Logs 
The meter keeps a variety of logs of events that occur to the meter.  The size of these 
logs may be configured. 

Event setup 

 
• Figure 12-1 Event log size setup 

The size of each event log can be configured on the EventLog page, Figure 12-1.  Each 
entry uses 6 bytes of eeprom.   

This page may be protected from editing to reduce the risk of accidental change.  To 
unprotect it select one of the Edit options at the bottom of the page.  See “Protected 
Setup” on page 3-10 for more information. 

Log Name Description 
System Log Used for system events like power on and off. 
Access Log Used to track user accesses to the meter. 
Tamper Log Records when tamper events occur. (Also used as LCD Alarm 

LOG for UPS meters, and previously was used as a billing reset 
log) 

Sag/Swell Log Records Sag and Swell events. 
Debug Log Only used for diagnostics.  Also used as the Push Alarm log for 

UPS meters and meters with Push alarming enabled. 
• Table 12-1 Event log types 

Table 12-1 lists the available event log types.  The following tables list the events in 
each log.  The event code is a 4 digit hex code that represents the event. 
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Event Name Code Description 
Power Off 100X The time the meter was turned off.  X is reserved. 

Bit 0: Set if off time not known. 

Power On 101X The time the meter powered up.  X gives more information: 
Bit 0: Set if the clock was recovered. 
Bits 1-3: Reserved. 

Recovered 102X 
 

Some copies of the indicated parameters were lost, but the 
information was retrieved.  Bits 2 and 3 may indicate a low 
battery.  X is 0 to F 
Bit 0 – Flash backup was bad 
Bit 1 – reserved 
Bit 2 – Energy accumulation restored 
Bit 3 – Control data restored 

Initialised 103X 
 

Both the battery backed up copy and the data FLASH copy of 
the indicated parameters was lost.  The parameters have been 
initialised to default values.  May indicate a fault in the FLASH, 
shutdown sequence setup, or power supply.  
Parameter X is as per 102X message above 

Run Time 104X Meter runtime statistics changed. 
0: On time changed. 
1: Off time changed. 
2: Number of powerups changed. 
3-F reserved. 

Relay Event 1YXX Y is the physical relay number: 1, 2, 3. 
XX has the form abcccccc 
a is 1 if the relay is enabled, 0 if it is disabled. 
b is 1 if the relay is connected, 0 if it is disconnected. 
cccccc is the reason for the log entry.  This is either the reason 
code given when a relay change is made by an external 
command, or is one of several internal events: 
57 – Simple command.  Relay control via register F050-8 report 
as this since they have no option for a reason code. 
58 – Disconnect button was pressed 
59 – Connect button was pressed 
60 – Calender (Tariff) changed 
61 – The physical relay changed state 
62 – If a user set reason code is >62, it is changed to this. 
63 – Relay Stuck recorded if a relay should be open, but current 
is still flowing on the switched element (where a relay switches 
all current on an element).  Tested 30 seconds after the switch.  
Events 60 and 61 are disabled by default – see “Alarms” on 
page 11-3. 

PORT Changing System 
Time… 

20CX Time changed from a port, time sync, or internal command. 
Bit 4/5 for port #.  Bits 0-3 give reason. 
0: From command on port. 
1: From pulsing input 
2: From Ripple Control 
3-F reserved.  F is used for the “to” case below. 
The system time was changed from this time… 

...System Time Changed. 20CF …to this time. 

Firmware changed 40XX The meter’s firmware was changed. 
XX is the revision number it was changed to. 

Bootloader changed 4100 The meter bootloader was upgraded. 

• Table 12-2 System event log types 
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Event Name Code Description 
Automatic Billing Reset 5000 An automatic billing reset occurred. 

Manual Billing Reset 
Button 

5001 A manual billing reset occurred from the Billing Reset button.  

Manual Billing Reset 
Command 

5080 Bits 4/5 indicate port.   

EFA XXXX Latched 
EFA Conditions Cleared 
EFA XXXX Active 
EFA XXXX Inactive 

30XX The indicated EFA was latched. 
EFA is a number in the bottom 6 bits (5 to 0).  
 
63 O Overcurrent 
32-62  Reserved 
16-31  Advanced Tamper 
15 E  Reference failure              
14 S  Asymmetric Power.              
13 V  Voltage Tolerance Error.       
12 F  VT Failure.                    
11 R  Incorrect Phase Rotation.      
10 T  Tamper                         
9 C  Clock Failure.                 
8 M  Reverse Power.                 
7 L  Calibration Data Lost.         
6 H  Modem Failure.                 
5 X  RAM Failure or LCD Failure.    
4 Y  Program Flash Failure.         
3 Z  Data Flash Failure.            
2 N  Pulsing Output Overflow.       
1 D  Battery Failure                
0 U  User Defined / Magnetic Tamper  
 
Bit 6/7 indicate: 
0: condition latched 
1: Latched conditions cleared (bits 0-5 are zero) 
2: Condition became active (already latched) 
3: Condition became inactive (already latched) 

Power Factor Alarm 32XX Indicates the power factor limits have been exceeded. 
Bits 0/1 indicate phase 0:A, 1:B, 2:C:, 3:Total 
Bit 2 indicates 0:start or 1:stop 
Bit 3 indicates the limit exceeded. 0:Lower, 1:Higher 
Bit 4 indicates 0:lag or 1:lead 

UPS State  B20X UPS control information. 
X: 0 Meter running full powered from the UPS battery.  
1 Mains power restored while running on the UPS. 

Input Alarms B2XY X the input the alarm comes from. 
Y: 2 latched alarm, 3 unlatched alarm, 4 momentary 
pulse alarm. 

UDP alarm failed B210 The meter attempted to send a UDP alarm but never got 
an acknowledgement from the server. 

• Table 12-3 System event log types 
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Event Name Code Description 
Radio Module Tamper 
Alarm 

31XX This indicates the radio channel was tampered. 
 
The XX is the LSB and has the following meaning. 
Bit 0-5: radio channel number (32 radio input channels 
supported, 64 numbers possible) 
Bit 6: 0 – alarm went inactive 
1 – alarm went active 
Bit 7: reserved 

Radio Module Low Battery 
Alarm 

32XX This indicates the radio channel has low battery 
 
The XX is the LSB and has the following meaning. 
Bit 0-5: radio channel number (32 radio input channels 
supported, 64 numbers possible) 
Bit 6:0 – alarm went inactive 
1 – alarm went active 
Bit 7: reserved 

Radio Module Time Out of 
Sync Alarm 
 

33XX This indicated that the radio channel time is out of sync with the 
datahub timing by a significant amount. 
 
The XX is the LSB and has the following meaning. 
Bit 0-5: radio channel number (32 radio input channels 
supported, 64 numbers possible) 
Bit 6: 0 – alarm went inactive 
1 – alarm went active 
Bit 7: reserved 

• Table 12-4 System event log types for Datahub 
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Event Name Code Description 
PORT: Logon User 
USERNUMBER 

200X User USERNUMBER logged on via the indicated port.  A 
USERNUMBER of 0 means the user name is not known. 
Bit 4/5 for port (0 for optical, 1 for modem,2/3 reserved) 
Bits 0-3 are user number. 

PORT: changed XX 204X User changed a setting in the XX group, via the indicated 
port. 
Settings are: setup1, setup2, setup3,  
Bit 4/5 for port (0 for optical, 1 for modem,2/3 reserved) 
Bits 0-1 are the number of the setup stage, 0 to 2. 

PORT: Logoff: Access 
Denied 

2080 A user was logged off the indicated port because of a bad 
password. 
Bit 4/5 for port. 

PORT: Logoff: User 
Request 

2081 A user was logged off the indicated port because a log off 
was requested by the X command. Bit 4/5 for port. 

PORT: Logoff: Timeout 2082 A user was logged off the indicated port because of an 
inactivity timeout. Bit 4/5 for port. 

PORT: Logoff: Lost 
Connection 

2083 A user was logged off the indicated port because of a lost 
connection. Bit 4/5 for port. 

PORT: Logoff: User ID 
change 

2084 A user was logged off the indicated port because a login 
under another name occurred. Bit 4/5 for port. 

PORT: Logoff: Requested 2085 A user was logged off the indicated port because a logoff 
was requested via a register write. Bit 4/5 for port. 

PORT: Logoff: Upgrade 
Attempt 

2086 A user was logged off the indicated port because a logoff 
was requested via a register write attempting to do a 
firmware upgrade. Bit 4/5 for port. 

Setup Change AXYY YY is a bitmask of database changes / clear commands. 
The bottom 2 bits of X are the 8 bit chunk this represents. 
The top 2 bits are the port it was done from. 
0: Event Logs Cleared 
1: Load Survey 1  
2: Load Survey 2  
3: TOU Setup Changed – TOU registers cleared. 
4: Billing History Cleared (usually appears with TOU setup) 
5: Pulsing Generator reset 
6: TOU Calender changed 
7: Reserved 
8: Hardware Setup changed 
9: Calibration Changed 
10: Scaling Factors Changed (transformer ratios changed) 
11: Transformer Ratios Changed 
12: Pulse Factors Changed 
13: Pulsing Inputs setup Changed 
14: Pulsing Outputs setup Changed 
15: Enunciators Changed 
16: Optical port setup changed 
17: Modem port setup changed 
18: LCD screens changed 
19: Alarm setup changed. 
20: Security setup changed. 
21: Timer setup Changed. 
22: Time Setup Changed. 
23: SCADA port setup changed 
24-32: Reserved 
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• Table 12-5 Access event log types 

Event Name Code Description 
Tamper Event 3XYZ The indicated tamper occurred.  X log entries are 

recorded (including this one) with further information. 
Bits 7 to 6 indicate the tamper state: 
0 Tamper Detected 
1 Tamper Restored 
2-3 Reserved 
 
The bottom 6 bits (5 to 0) represent the Tamper Event.  
Note that codes 0-15 and 63 are used for normal EFA’s.  
 
16 VT Lost Phase A 
17 VT Lost Phase B 
18 VT Lost Phase C 
19 VT Surge Phase A 
20 VT Surge Phase B 
21 VT Surge Phase C 
22 VT Phase Bridge 
23 VT Phase Order 
24 CT Lost Phase A 
25 CT Lost Phase B 
26 CT Lost Phase C 
27 CT Phase Order 
28 CT Current Reversal A 
29 CT Current Reversal B 
30 CT Current Reversal C 

Tamper Entry Details 8XYZ Tamper extended information record.  Time is a coded 
quantity, not actually a time/date. These records follow 
a tamper entry start record immediately and provide 
additional information about the tamper. 
Bits 11 to 9 indicate the type of record. 
0 Phase A record 
1 Phase B record 
2 Phase C record 
3 TOU record 
4-7 Reserved 
 
For phase records data on the phase angle is packed into 
the bottom 9 bits of the event code.  The time field is 
packed with the voltage (11 bits) , current (15 bits), and 
part of the voltage to voltage angles.  
For TOU records the scaling factors and the source TOU 
channel are stored in this space.  The time field holds the 
TOU value. 

• Table 12-6 Tamper event log types 

Tamper events are made up of a Tamper Event which indicates that a tamper started or 
stopped, and what type of tamper occurred.  The Details entries include more 
information about the meter situation at the time of the tamper. 
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  Retrieving an Event Log 

Event Name Code Description 
Voltage change start. 
Start Time 
 
Also stores 
THD/Unbalance triggers 

6XYY Start time of sag/swell or PQ event. 
The meter may optionally record a start event both when the 
event started, and when it finished (default is only when 
finished).  Bit 10 is set if this entry recorded at the start of the 
event, clear if recorded at the end. 
Bit 11 is zero: Sag/Swell 
Bits 8-9 indicate phase A, B, C, or 3=power outage. 
Bits 0-6 used for detailed 10ms time resolution.  Bit 7 1 for  
surge, 0 for sag. 
Bit 11 is one: THD/Unbalance 
Bits 8-9 indicate phase A, B, C for THD, or 3=Unbalance. 
Bits 0-6 used for detailed 10ms time resolution.  Bit 7 is 1 for  
surge (no sag definition) 

Voltage change end. 
Duration and Magnitude 
 
Also stores 
THD/Unbalance triggers 

7XYY 
SPECIAL 

Bit 11 is zero: Sag/Swell 
Bits 8-9 indicate phase A, B, or C, or 3=power outage.  
Bottom byte indicates percent relative to nominal (like mk3).  
Time is a duration instead of a date/time. This entry marks 
the end of the preceding start event – reading software 
should match them up, channel for channel.  
Bit 10 indicates that the top 8 bits of the duration are actually 
an average reading over the disturbance, in percent. 
Bit 11 is one: THD/Unbalance 
Bits 8-9 indicate phase A, B, C for THD, or 3=Unbalance. 
Other bits as per Sag/Swell 

• Table 12-7 Sag/Swell event log types 

A Sag/Swell occurrence is made up of two entries – a start and a stop.  EziView lines 
them up automatically to produce complete events. 

Event Name Code Description 
Meter Restart B30X The meter restarted.  This may indicate a flat or missing 

battery. 

• Table 12-8 Diagnostics log types 

Retrieving an Event Log  
Event Logs can be downloaded using a readings file (advanced usage), from the 
memory map page of online variables (Figure 12-2, see Flash/EEPROM Memory 
Usage on page 4-3 for more information), or from the Status screen. Only the memory 
map and status screen methods are discussed here.  
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• Figure 12-2 Online Variable Memory Map 

Right-click on the log to download, and select either Download and select a filename to 
download to, or use the Send to option. Programs to use with Send to can be entered 
using the Make New… command in the Send to menu.  

The log is downloaded as a text file with a tab delimited format, similar to Figure 12-3. 
The header section is used by EziView to track download progress. Each record has a 
unique number starting from when the survey was started, which is only reset if the 
survey is cleared.  The Last Record column of the Memory Map screen shows the last 
available entry for each log. The “=>” numbers at the end of each line are the actual 
event codes.  Note that tamper and sag/swell logs use a slightly different format. 

[LoadSurvey]  
LastRecord=0000000061  
StartTime=01/01/1996 00:20:50  
 
Record No  DateTime   Event  

(0x0000F03D)   (0x0000FFFF)  
34   01/01/1996 21:39:50  User: 1 changed database stage: Misc=>2041  
35   01/01/1996 21:39:55  User: 2 changed database stage: Pulse=>2042  
36   01/01/1996 21:39:57  Log off port: Optical=>2081  
37   03/01/1996 07:56:58  User: 0 logged in on port: Optical=>2000  
38   03/01/1996 07:56:58  Bad password on port: Optical=>2080  
39   03/01/1996 07:56:58  User: 0 logged in on port: Optical=>2000  
40   03/01/1996 07:57:28  Inactivity timeout on port: Optical=>2082  

• Figure 12-3 Downloaded Event Log 

 
To clear a log simply right-click on the log and select Clear. Each log can be cleared 
individually.  
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  Retrieving an Event Log 

To use the Status screen method first bring up the status screen - right click on the 
connected meter and select Screens → Status.  Go to the Surveys tab, and select an event 
log from the Survey Name drop down box (see Figure 12-4). 

 
• Figure 12-4 Status Screen Log download 

A date range can be selected to download only a certain portion of the log.  The Go 
button starts the download, which is shown in the bottom pane of the screen.  The Clear 
button clears the selected log (deletes the contents in the meter).  The Save As… button 
saves the downloaded data into a text file in the format as shown in Figure 12-5 

Record DateTime Event 
3088 2009-02-20 09:43:23.000 Power on=>1010 
3089 2009-02-24 08:33:34.000 Power off=>1000 
3090 2009-02-24 08:33:34.000 Power on=>1010 
3091 2009-02-24 08:33:34.000 Firmware changed to=>408C 
3092 2009-02-24 08:33:35.000 System time change on port : Optical=>20C0 
3093 2009-02-24 08:36:18.000 System time changed=>20CF 
3094 2009-02-24 08:37:12.000 Power off=>1000 
3095 2009-07-08 10:09:23.000 Power on=>1010 
3096 2009-07-10 17:59:05.000 Power off=>1000 
3097 2009-07-20 14:58:21.000 Power on=>1010 
3098 2009-07-20 15:04:06.000 EFA alarms cleared=>3040 

• Figure 12-5 Status Screen Downloaded Event Log 
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Sag/Swell 
The sag/swell log records excursions of the voltage away from a nominal figure.  The 
meter records: 

• The phase, A, B, or C.  A total supply failure (power outage) is recorded as its 
own event type (power outage event introduced in firmware version 1.30).  
Resolution is only 1 second in this case. 

• The time of the occurrence with a resolution of 10ms. The voltage is measured 
every 5 cycles over the last 5 cycles - thus the time only has an accuracy of 
100ms. The logged time is that of the end of the disturbance, at the end of the 5 
cycle measurement that detected the excursion.   

• The duration of the occurrence counted in cycles, with a resolution of 5 cycles.  
Maximum duration is 13.6 years.  The duration is displayed in seconds. 

• The worst excursion, as a percentage from 0% to 255% of the nominal setting. 

• The average excursion, as a percentage from 0% to 255% of the nominal 
setting.  If the duration is longer than 4 hours, the average will only be over the 
first four hours.  If the duration is over 19 days, the average is not recorded. 

Since the Mk7 only has one voltage phase, sag/swell disturbances are only reported on 
‘phase A’. 

 
• Figure 12-6 Sag/swell setup 
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The AlarmSagSwell page configures how the system triggers (Figure 12-6).  Vn is the 
nominal voltage that the other settings are referred to.  The returned worst excursion and 
average excursion is a percentage relative to this as well. 

The Sag Start and Swell Start settings set the points at which an event is deemed to have 
started, relative to Vn.  The Hysteresis settings force the voltage to return within the set 
points before the event is considered finished.  These help prevent repeated nuisance 
triggers. 

[LoadSurvey]  
LastRecord=0000000034  
StartTime=18/05/2004 21:07:29  
 
Record No  DateTime  Phase Amplitude  Duration Swell  Average Amplitude  
  (0x0000F03D)(0x0000FFFF)(0x0000FFFF)(0x0000FFFF)(0x0000FFFF)(0x0000FFFF)  
19  03/06/2004 16:45:05.180  0  61  0.4  False  70  
20  03/06/2004 16:45:05.180  1  61  0.4  False  70  
21  03/06/2004 16:45:05.180  2  62  0.4  False  70  
25  03/06/2004 16:45:17.480  0  74  0.3  False  81  
26  03/06/2004 16:45:17.580  1  75  0.2  False  78  
27  03/06/2004 16:45:17.580  2  75  0.2 False  78  
31  03/06/2004 16:45:20.000  0  111  0.3  True  110  
32  03/06/2004 16:45:20.000  1  112  0.3  True  111  
33  03/06/2004 16:45:20.000  2  112  0.3  True  111  

• Figure 12-7 Downloaded sag/swell log  

Figure 12-7 shows a log downloaded from a meter. Note a swell is recorded as true 
in the Swell column, a sag is recorded as false.  An average amplitude of -1 is 
recorded if the average amplitude is not available (duration too long).   

When downloaded using the Status screen a swell is indicated by 128, a Sag by 0. 

Power Quality 
The power quality log records power quality problems in a similar way to sag/swell.  
They are recorded in the same log as sag/swell events.  Note that the Sag/Swell system 
must be active for power quality log events to be recorded.  The meter records: 

• The phase, A, B, or C is recorded for THD triggers.  Unbalance of course has 
no phase. 

• The time of the occurrence with a resolution of 10ms.  The factors are measured 
every 5 cycles over the last 5 cycles - thus the time only has an accuracy of 
100ms. The logged time is that of the end of the disturbance, at the end of the 5 
cycle measurement that detected the excursion.   

• The duration of the occurrence counted in cycles, with a resolution of 5 cycles.  
Maximum duration is 13.6 years.  The duration is displayed in seconds. 
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• The worst excursion, as a percentage from 0% to 25.5%.  An excursion beyond 
this will record 25.5% 

• The average excursion, as a percentage from 0% to 25.5% of the nominal 
setting.  If the duration is longer than 4 hours, the average will only be over the 
first four hours.  If the duration is over 19 days, the average is not recorded. 

• If a delay for triggering is specified, the time of occurrence is the time the event 
triggered at the end of the delay.  The delay is not included in the duration, and 
the readings during the delay are not included in the average. 

Since the Mk7 only has one voltage phase, THD disturbances are only reported on 
‘phase A’, and unbalance serves no use. 

 

 
• Figure 12-8 Power Quality Events setup 

The AlarmSettings page configures how the system triggers (Figure 12-8).   

The THD event is calculated from the voltage THD’s, and the Unbalance event is 
calculated as: 

100% ×=
nceitiveSequeVoltagePos
nceativeSequeVoltageNegUnbalance  
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  Tamper 

These limits set the level at which a THD or Unbalance event is added to the event log.  
The maximum setting for the limits is 25.5%, in 0.1% steps. A setting of 0 disables that 
event.  

The Power Quality Delay sets the time in seconds that these limits must be exceeded 
continuously before an event is registered.  A setting of 0 means there is no delay. 

[LoadSurvey] 
LastRecord=0000000006 
StartTime=06/02/2008 10:00:30 
 
Record No DateTime         Phase  Amplitude Duration Swell Average Amplitude 
        (0x0000F03D)(0x0000FFFF)(0x0000FFFF)(0x0000FFFF)(0x0000FFFF)(0x0000FFFF) 
0 06/02/2008 10:00:30.440 4 6.2 0.3 True 5.4  
2 06/02/2008 10:47:29.000 4 2.6 0.2 True 2.6  
4 06/02/2008 10:51:13.000 4 2.7 0.8 True 2.6  
6 06/02/2008 10:51:31.070 4 2.6 1.5 True 2.6   

• Figure 12-9 Downloaded THD log  

Figure 12-9 shows a log downloaded from a meter.  Note that swell is always true 
for power quality events.  A phase of 4, 5 or 6 indicates THD events on phase A, B, 
or C respectively.  A phase of 7 indicates an Unbalance event. 

Tamper 
The tamper log system gives a level of tamper detection beyond that afforded by the 
EFA system. The tamper log also records much more information about the tamper 
event to allow easier investigation.  

The following features are monitored:  

• The meter is able to detect a missing and restored potential on the meters' VT.  

• Detect reversal of CT phase rotation.  

• The meter is able to detect CT phase reversal and also log when the phase order is 
restored. This type of detection also includes cases where the CT polarity is 
exchanged. The restoration is logged.  

• Detect abnormal reductions in the current with the CT's and their restoration. This 
will normally detect most CT shorts. 

The following information can be recorded: 

• Start and stop time for the tamper event 

• The type of tamper 

• A snapshot of the 3 phase voltages, currents, and phase angles. 
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• A snapshot of a TOU accumulated energy register. 

 

The Tamper log requires the firmware with the advanced tamper edition to function. If 
this is not present no tampers will be recorded. 

 

The Mk7 does not support the tamper log system at this time as most of the alarms are 
designed for 3 phase systems. 

 

Various states of the tamper system can be displayed on the LCD.  Registers D8C0  - 
D8C4 allows the last 5 tamper start events to be displayed, D8C0 being the most recent.  
D8D0 – D8D4 displays the time and date of those events.  The codes shown for the 
tamper start events are numbers from 16 to 30, as per Table 12-6. 

 
• Figure 12-10 Tamper setup 

The configuration of the Tamper system is via the Alarms→ AlarmTamper page.  This 
allows each tamper source to be enabled and configured separately.  

The Nominal Voltage, Nominal Current, and Alarms Disabled Below settings are taken 
from the AlarmSetting page. 

The Survey Settings option enables logging of a TOU accumulated energy register when 
a tamper starts or stops.  The TOU channel to be monitored may be selected, and 
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whether a Total or Current Period value is recorded. This uses one more tamper log 
entry for each tamper recorded. 

The Voltage, Current, Phase Angle Snapshot option enables recording of the 3 phase 
voltages, currents, and phase angles - including the voltage to voltage phase angles.  
This gives enough information to reconstruct the phasor diagram at the time the tamper 
started or stopped.  This uses three more tamper log entries for each tamper recorded. 

The other settings on this page allow each tamper type to be enabled and configured 
separately.   

The Delay Time specifies the length of time, in seconds, that the tamper has to persist 
for before it is logged. For example, the Delay Time in VT Surge specifies the number 
of seconds after which a tamper will be recorded in the case of a voltage surge.  

VT Phase Lost 

This tamper detection test will check each phase to see whether any phase has drop 
below the pre-calculated Threshold value. Essentially this determines whether the 
customer has removed a connection from the meters VT or other techniques to 
dramatically reduce the detected phase voltage.  

If the nominal phase voltage is 240V, and the voltage threshold is 10% then when the 
voltage falls below 216V (240 x 0.9), a tamper event is logged.  

VT Surge 

This test determines whether the phase voltage has risen over a present voltage 
Threshold. It is performed for each phase. Voltage surge is designed to pickup cases 
where any of the meter’s VT’s are artificially supplied a large over voltage so that it can 
be argued that the billing information must be incorrect.  

VT Phase Bridge 

This test checks to see whether a phase voltage line is connected to two or more VT’s. 
Essentially the test will check to see if two phases have their absolute voltage phase 
angles below a small angle Threshold. Since phase A phase voltage is the reference then 
the only comparisons that need to be made are between phases A-B and phases A-C. 
It is also important to note that once this tamper has been triggered or is in a triggered 
state then the VT phase order tamper is ignored, though  version 1.27 firmware does not 
do this.  

VT Phase Order 

The VT phase rotation test checks to see whether the voltage lines are swapped on the 
meters VT’s. Rotation reversal is checked by finding the difference of two adjacent 
voltage angles and then removing their nominal offset (120 degrees) so that the 
remaining angle should be zero. The remaining voltage angle permitted is set by 
Threshold. 
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If the Threshold is set so that both a VT phase rotation reversal tamper and VT bridge 
tamper are both met then the VT bridge tamper will take priority over the VT phase 
rotation reversal tamper. This will occur when the Threshold > (120 - VT Bridge 
Threshold).  Version 1.27 firmware does not do this. 

CT Phase Lost 

Lost phase current aims to pick up some CT shorts or cases where the CT connection is 
removed. This type of tamper is very hard to accurately determine. This is because 
current drawn by different customers at different times of the day or week can be so 
greatly varying in magnitude. Current comparison Threshold should be set 
conservatively according to the customers load requirements. 

CT Phase Order 

This tamper test aims to detect cases where the CT phases have been exchanged. 
Testing for this type of tamper is quite difficult since different customers can draw 
diverse amounts of inductive energy from any different phase. 
 
The tests performed to determine phase order reversal are based around finding the 
difference between two adjacent absolute current angles. This nominal angle (120 
degrees) is removed, and the remaining angle is compared with the user adjustable 
Threshold.  At least the Alarms Disabled Below current must be present for this test to 
trigger. 

Reverse Current 

The reverse current tamper test checks to see if active energy is importing (energy 
received by the supplier). This type of tamper will only be logged if there is no CT and 
VT phase reversal (including the time the tampers' persistence is counting). The logic is 
designed in such a way so that a reverse current tamper can still be restored even though 
a CT or VT tamper is persisting or occurring but won’t trigger a tamper until both CT 
and VT tampers are restored. During this time the reverse current persistence counter 
will not be reset. At least the Alarms Disabled Below current must be present for this 
test to trigger. 

Power Factor 
The Power Factor monitor adds events to the System log if programmed limits for 
power factor are exceeded.  It is available in firmware version 1.40 and later on 
enhanced processor meters. 

There are two limits each for lagging and leading power factors.  The low and high 
limits allow the severity of the event to be indicated.  The limits are configured on the 
AlarmSettings setup page in EziView (Figure 11-3 on page 11-5). 

The meter monitors all three phases and the total individually.  An event is generated if 
any of them exceed (power factor less than the limit) one of the limits for the 
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programmed delay time.  The event records the phase, which limit was crossed (high or 
low), lead or lag, and if this is the start or the end of an occurrence. 

 If all four (high/low, lag/lead) limit settings are zero the feature is disabled.  The 
individual phases are not monitored in 2 element mode.  For Mk7 meters the phases 
reported relate to the different measuring elements of the meter. 

Log Download 

Figure 12-11 shows a log downloaded from a meter after a tamper event.  Phase B 
voltage was dropped to 30 volts.  It can be seen from the logs the voltage dropping, and 
what else was affected.  The recovered phase B voltage is a little low as the voltage is 
still rising back up to nominal when the entry was recorded, but is within the allowed 
limits. The Finished column is 0 for a started event, -1 for a finished event. 

[LoadSurvey] 
LastRecord=0000000010 
StartTime=23/02/2007 14:53:37 
 
Record No DateTime Event  Finished  V PhA V PhB V PhC  
 (0x0000F03D) (0x0000FFFF) (0x0000FFFF)(0x0000FFFF)(0x0000FFFF)(0x0000FFFF) 
4 23/02/2007 14:53:37 Voltage Lost PhB 0 239.77  30.01 239.77   
9 23/02/2007 14:54:15 Voltage Lost PhB -1 239.77 158.97 239.77   
 
Columns continued… 
I PhA I PhB I PhC Angle PhA Angle PhB Angle PhC Angle Vab Angle Vac TOU Value TOUChannel 
(0x0000FFFF)(0x0000FFFF)(0x0000FFFF)(0x0000FFFF)(0x0000FFFF)…(0x0000FFFF) 
1.00   1.00   1.00   0.00            0.00   1.41           -120.94     119.53      5853.00  1  
1.00   1.00   1.00   0.00            0.00   1.41           -120.94     119.53      5858.00  1   
 

• Figure 12-11 Downloaded Tamper log  
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Chapter 13 Outputs and Enunciators 
This chapter covers the setting of outputs and enunciators.  These allow energy pulses to 
be generated, as well as provide indication of a variety of states.  Enunciators provide a 
subset of the output features. 

Each model of the meter has different output options. 

There are up to 6 outputs available on the Mk10.  The exact number depends on the 
ordered model.  The first 4 outputs are also connected to the LEDs under the LCD. 

There are up to 4 outputs on the Mk10 Special I/O and the Mk10A, and up to 2 LED’s 
which are independent of the outputs. 

There are up to 4 outputs on the Mk10D, and up to 2 LED’s which are independent of 
the outputs.   

There are up to 4 outputs on the Mk10E, and up to 2 LED’s which are independent of 
the outputs.  In addition an expansion card may be fitted for more outputs.   

There are up to 4 outputs on the Mk7A, and up to 2 LED’s which are independent of the 
output.   

There are up to 4 outputs on the Mk7C, and up to 2 LED’s which are independent of the 
outputs.   
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Output Setup 

 

• Figure 13-1 Mk10 Output setup page 

Figure 13-1 shows the pulsing output setup in EziView.  

The Reserve Pulsing Output Memory option means that space is always reserved for all 
available outputs.  This allows the configuration of the pulsing outputs to be changed 
without clearing the load survey or TOU structures.  Uncheck this option to free up 
more space for load survey and TOU functionality. 

Changing any pulsing output settings may cause the meter to clear load survey or TOU 
data, since the meter optimises memory use between these systems.  Using the Reserve 
Pulsing Output Memory option can be used to avoid this. 

This page may be protected from editing to reduce the risk of accidental change.  To 
unprotect it select one of the Edit options at the bottom of the page.  See “Protected 
Setup” on page 3-10 for more information. 

Outputs that are not fitted are marked in red.  Note that the order of the outputs listed is 
different to the physical arrangement.  The PO numbers line up with the PO numbering 
in the hardware description for each meter.  The inputs labelled as LED inputs is as a 
guide only - it does not mean that an LED is actually fitted. 

Each line gives the current settings for that output.  To edit the output double-click on 
the setting.  This brings up the detailed setup form as shown in Figure 13-2. 
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• Figure 13-2 Pulsing Output Setup 

Active Time controls the length of each energy pulse, from 1 to 100ms.  Inactive Time 
sets the minimum time between pulses – if the rate of pulses is too fast then the gap 
between pulses will fall below this and an alarm will be generated (also see “Pulsing 
Output Overflow - N”, page 11-9). 

EziView also does some checking of the pulse factors.  Enabling this checking is done 
via the Tools → Options → General →  Check Pulsing Output Overflow setting. 

The Active Time, Inactive Time, and P/S settings are common between all outputs.  Thus 
changing them for one output will change them for all other outputs. 

The Energy tab is used to setup the output to indicate energy as a series of pulses.  The 
energy quantity to output is selected by highlighting the required combination of factors. 
Each pulse represents the amount of energy entered at the bottom of the form in the kWh 
Per Pulse field.  This is entered as a primary value or a secondary value depending on 
the setting of P/S.  When the secondary mode is used the secondary kWh Per Pulse 
value will be maintained at the setting, even with changing the transformer ratio.  When 
the primary mode is used the primary kWh Per Pulse value will be maintained at this 
setting, even with changing the transformer ratio.  If the mode is changed the kWh Per 
Pulse setting on this page will remain the same, which means the rate from the meter 
will change by the transformer ratio. 

The  button brings up a calculator that can be used to help calculate suitable pulse 
rates.  Figure 13-3 shows the calculator page.  Note that this page assumes 3 phase 
measurement. 

 

 Outputs and Enunciators 13-3   



 

   

13-4 

 

• Figure 13-3 Pulsing Output Calculator 

The voltage and current settings come from the nominal voltage and nominal current, 
but they can be changed here to help calculate appropriate quantities.  The Load Rating 
is the anticipated amount of load.   

The last 4 fields are linked together.  They show up green when the settings are within a 
reasonable range, and turn red if the setting is out of range. 

The Test Energy tab selects a special energy source that produces a constant “energy 
output”.  It is useful for testing equipment when there is no load connected.  

 

• Figure 13-4 Pulsing output Output Control setup 

The Output Control tab (Figure 13-4) gives access to a wide variety of control options 
for the output. Some of these relate to the current meter state, while others relate to the 
current LCD being shown on the LCD (useful for use with enunciators).  
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Table 13-1 lists the available direct output controls.  These are independent of the 
displayed LCD screen. 

Status Type Description 
User Set, 
Temporary 

Available only for outputs, this allows the output state to be 
controlled remotely by writing to a register.  If power to the meter is 
removed, the output will revert to the off state when power returns.  
Refer to the following Output Status section for how to control this 
from EziView. 

User Set, 
Persistent 

As for User Set, Temporary above, except that if power to the meter 
is removed and returned, the output state will be kept. 

Mode Power On Used to control power to an external modem.  The meter will drop 
power to the modem if there are communications problems, or 
programmed to on a daily basis. 

UPS Provides an indication that the meter is “Running On Mains” rather 
than the UPS battery, or that the meter is “Running On UPS”.  The 
last option “LCD Alarm Active” indicates that one of the UPS 
alarms set to be shown on the LCD are active. (See Push Alarms 
on page 11-9) 

Relay This includes the options for use with disconnect or load control 
relays.  The State setting indicates the relay state – on for relay on, of 
for relay off, or flashing (0.5 Hz) for enabled but disconnected.  The 
Drive On will give a pulse to turn on a bistable contactor, and the 
Drive Off setting will give a pulse to turn off a bistable contactor.  
The Drive On/Off setting will be on when the relay is on. 

PLC Service Pin 
or Service Pin 

Mirrors the state of the PLC service pin. 

End Of 
Demand/Interval 

This can be used to generate a 1.5 second pulse at the end of an 
interval.   
The End Of Interval setting is for use with surveys. Select the survey 
it is to trigger from (EX1 and EX2 are survey 1 and 2).  It will give a 
pulse when the survey interval ends and another begins, including if 
caused by a time jump or power outage. 
The End of Demand setting is for use with TOU.  Select the TOU 
group it is to trigger from (TOU Group 1 or 2).  It will give a pulse 
when the demand period ends, when time crosses a period 
boundary, or when a billing reset occurs. 
Only one output can be setup for this at any one time. 

EFA Active 
Alarms Masked 

Will set the output if the selected EFA mask has active alarms. 

EFA Latched 
Alarms Masked 

Will set the output if the selected EFA mask has latched alarms. 

TOU Rate Active 
Binary 

Allows the active rate to be indicated as a binary number.  The Rate 
group to use, and the “bit” to output must be selected. 
For example, to display the state of 4 rates with only 2 enunciators, 
the right hand one would be set to bit 0, and the other to bit 1. 

TOU Rate Active Allows an indication when a particular rate is active.  The Rate 
group to use must also be selected.  The Ex1 and Ex2 groups are 
designed to be used with this option to allow the creation of complex 
time controlled outputs. 

EFA Active Will set the output if the selected EFA is active, independent of any 
mask.  The second group EFAs are not available in this form, if 
needed it could be put in its own mask group and that option used. 

EFA Latched Will set the output if the selected EFA is latched, independent of any 
mask. The second group EFAs are not available in this form, if 
needed it could be put in its own mask group and that option used. 
• Table 13-1 Direct enunciator definitions 
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The Inverted option causes the output state to be inverted.  This is implemented in 
firmware v1.32 and onwards.  Understand that if power is removed from the meter the 
output will turn off regardless of setting. 

Table 13-2 lists the available LCD related output controls.  These depend on the LCD 
screen being shown – most useful when used with enunciators. 

Status Type Description 
[LCD]TOU Channel Set when values from the selected TOU channel are displayed. 
[LCD]Previous Period Set when values from the selected TOU period are displayed. 
[LCD]Rates Set when values from the selected TOU rate are displayed. 
[LCD]Basic Unit Set when the displayed value is of the selected unit. 
[LCD]Quadrant Set when the displayed value is in the selected quadrant. 
[LCD]Phase Set when the displayed value is measured on the selected 

phase.  The last option is for pure pulsing energy quantities. 
[LCD]Measurement 
Mode 

Set when the type of TOU reading (Accumulated, max 
demand, time of max demand) matches the selected type. 

[LCD]Total Reading Set when the displayed value is a total of all phases.   
[LCD]Energy Type Set when the value is an energy quantity (Wh,varh,VAh, m3) 
[LCD]Power Type Set when the value is a power quantity (W,var,VA, m3/h) 

• Table 13-2 LCD related enunciator definitions 

Enunciators have a similar configuration to outputs, but cannot be set to pulsing modes, 
a user set state, or an end of demand/interval pulse (Figure 13-5).  Generally settings on 
this screen should match text or symbols on the label at the bottom of the LCD.  The 
Mk10 and Mk10E have 12 enunciators, while the Mk7 has 5.  The Mk10D has 11 
usable enunciators – the 5th enunciator across cannot be used. 

 

• Figure 13-5 Enunciator configuration 
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Output Status 
EziView has an Online Variables page for output control.  Go to the Online Variables 
→ IO Screen as shown in Figure 13-6. 

 

• Figure 13-6 Pulsing output online status 

 

Each input and output is listed, with its current state.  Pulsing inputs and outputs will 
generally not show up here reliably as the update rate is too slow to see them.  Outputs 
that are configured as User Set can be controlled by selecting the output and checking or 
unchecking the checkbox at the bottom. 

A slightly simplified version of this page is shown for lower level users (users without 
permission to read setup). 
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Chapter 14 Inputs 
This chapter covers the setup of pulsing inputs.  These allow energy pulses from an 
external pulsing source to be accumulated by the meter. 

Input Setup 
Each model of meter has options for a number of inputs.  See the respective hardware 
section in the Atlas Hardware Reference Manual for details of the options.  The exact 
number of inputs depends on the ordered model.  

Figure 14-1 shows the pulsing input setup in EziView.  Inputs that are not fitted are 
marked in red.  Note that the order of the inputs and outputs listed is different to the 
physical arrangement.   

 

• Figure 14-1 Inputs setup page 
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Each line gives the current settings for that input.  To edit the output double-click on the 
setting.  This brings up the detailed setup form as shown in Figure 14-2. 

 

• Figure 14-2 Pulsing input detailed setup 

Clicking OK saves these settings.  The configured inputs can then be recorded by the 
TOU and load survey systems. 

This page may be protected from editing to reduce the risk of accidental change.  To 
unprotect it select one of the Edit options at the bottom of the page.  See “Protected 
Setup” on page 3-10 for more information. 

Energy 

The Energy Per Pulse setting is used to set the energy that each incoming pulse 
represents.  The drop down list has several defaults, but any value can be entered.  It is 
preferred that the magnitude of energy pulses coming into the meter are a similar 
magnitude to what the meter is measuring, as this results in a uniformity of scaling – the 
meter uses the same scaling as measured energy quantities. 

The Unit allows the unit of the incoming pulses to be selected.  The energy units of Wh, 
varh and VAh are available, but there is also a km^3 and a kpulse setting.  These simply 
provide support for quantities other than energy. 
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Fixed Inputs 

 

• Figure 14-3 Fixed Pulsing input detailed setup 

The Set as Lid Tamper Input option will use this input to trigger the Lid Tamper alarm 
(‘Lid Tamper - T’, page 11-9). The switch closes when a tamper is detected. 

The Alarm Input options are used with the UPS Mk10 to initiate an alarm transmission.  
Momentary generates an event when an input becomes active, Latch/Unlatched 
generates an event when the input becomes active or inactive.  These require the UPS 
edition feature. 

Tariff Changer 

 

• Figure 14-4 Rate Changer Pulsing input detailed setup 

The Tariff Changer option allows an input to control the active rate in the TOU system, 
overriding the calendar operation.  Time Control specifies which time controller/rate 
group to control from this input.  The Rate field specifies what rate to change to when 
the input becomes active.   

This requires the Tariff Changer edition of firmware to have an effect. 
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Relay 

 

• Figure 14-5 Rate Changer Pulsing input detailed setup 

The Relay option allows an input to control a relay in the meter by pulsing an input.   
Relay specifies which relay to control from this input.  The State of Relay field specifies 
what operation to perform on that relay.   

This is only available on enhanced processor meters, though it is always shown in 
EziView 4.08.  It requires the Relay Change on Input edition of firmware to have an 
effect (EziView 4.20 and later) 
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Chapter 15 Security 
The security systems of the meter and of EziView allow for fine control over who is 
allowed to do what with the meter.  Each user has their own user name and password.  
This grants them access to their user group, which defines what they can and can’t do.   

User’s Perspective 
Security is controlled by EziView using usernames and passwords on a meter by meter 
basis.  When EziView loads it will ask for a username and password (Figure 15-1). 

 
• Figure 15-1 EziView login dialog 

Enter your username and password, and then click OK.  Clicking Cancel will not log 
you in.  To avoid entering your username and password every time you start EziView, it 
can be remembered by using the Tools → Options → General → Save Main Password 
checkbox (Figure 15-2).  Note that this reduces the security of EziView as no password 
need be entered when starting EziView to access meters. 

 
• Figure 15-2 Save Main Password setting 
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The username and password may be changed within EziView using the Tools 
→ Current User option.  If the Save Main Password option has been selected then a 
Save Password checkbox will also be displayed.  Checking this box remembers the 
entered username and password. 

Additionally there is a Tools → Alternate Logon option.  This allows for the provision 
of an alternate password to use if the main password fails.  This can be useful for 
instance where meters are to be configured with a new set of usernames and passwords, 
but the existing password to access the meter is not part of the new configuration.  This 
can be entered as the alternate logon, while the normal password remains set to your 
normal password. 

The Link Security field in a login is used when you don’t have an account in the meter 
and are attempting to map the site.  Select the MTR file of a meter in which you belong 
to a group.  EziView will use the group username and password from that meter to map 
the site. 

Meter Security Overview 
Before going into how to configure security using EziView, this section covers the 
security features of the meter.  This should be read first. 

The meter allows for up to six users.  Generally before any operations may be 
performed a user must log on.  Each user has a user name and a password, each up to 7 
and 15 characters long respectively.  Sending a valid user name and password to the 
meter logs on the user.  The user remains logged on until logged out by whatever 
means. 

Each user has a user level, also called a user group.  When a user logs on, the user group 
they belong to is used to decide what they can access. 

There are seven user groups numbered 0 to 6.  Table 15-1 lists the access levels and 
what each level can do.  Each successive level can do all that the lower levels can do, 
with the exception that levels 4 and 5 are swapped – level 4 has slightly more access 
than level 5.  There is an 8th user group (level 7) which provides access to calibration 
settings and is for factory use only. 

Number Access Description 
0 Read only Only allows values to be read 
1 Read All/ 

Limited Timeset 
Also allows the time to be set by a limited amount, as per the 
shift limit setting. 

2 Read All/Billing Reset Also allows a billing reset to be performed. 
3 Read All/Clear  Clear EFA alarms, surveys and other systems.  Control user 

programmable pulsing outputs.  Unlimited timeset ability. 
4 Read All/+Setup/ 

Write User  
Allows the setup to be read, and allows limited setup change. 
Added in firmware version 1.27 

5 Read All/+Setup Allows the setup to be read, but not written. 
6 Read/Write All Allows the setup of the meter to be changed. 

• Table 15-1 Meter access levels 
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By default (unless ordered otherwise), meters are usually shipped with a single user 
“EDMI”, which has a password of “IMDEIMDE”.  This user has level 6 access.  This 
user may and should be deleted after you have configured your own administrator user. 

In addition to this the access to the setup for a level 6 user can be fine tuned for each 
user to limit access to different sections of the setup. 

Note that users below level 4 cannot read the setup out of the meter. 

Level 4 was added in firmware version 1.27.  Versions prior to this will treat level 4 as 
level 3 type access. 

As described above, the internal security provisions of the meter are substantial.  
EziView uses these capabilities, and adds more of its own. 

EziView Security 
Each meter in EziView has its own separate security settings – there are no program 
wide settings.  The Security page is used to configure the settings for the meter. (See 
Figure 15-3)  

 
• Figure 15-3 EziView Security setup page 

The tree diagram shows the user groups and the users within those groups.  Properties 
for the selected item appear to the right of the tree view.  The plus and minus boxes may 
be used to expand or collapse parts of the tree view.  The Expand and Collapse buttons 
affect the entire tree view. 
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When group changes are made OK and Cancel buttons appear just above the Additional 
Security box.  Settings are not validated until OK is clicked.  Clicking Cancel cancels 
the changes.  If an attempt is made to leave the settings page without clicking OK or 
Cancel, a dialog will ask if the changes should be made (Figure 15-4).  Cancel returns to 
the settings page.  The Yes and No buttons act the same as the OK and Cancel buttons 
discussed. 

 
• Figure 15-4 Security change confirmation 

If all users with level 6 access are deleted, EziView will display a warning as shown in 
Figure 15-5. 

 
• Figure 15-5 No User warning 

User Groups 

The user groups in the meter are predefined as mentioned earlier in Table 15-1.  
EziView also adds some flexibility to the higher levels. Each group has a Name and a 
Description – these are not stored in the meter, but EziView keeps track of them in the 
MTR file.  The name is what appears in the tree view.  Users belong to one of the 
groups – the settings of a group affect all users belonging to the group.   

Permissions allow the access permissions of the user group to be changed.  The use of 
this is covered in the “Permissions” section later in the chapter. 
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• Figure 15-6 Users not in the meter settings 

Users in meter allows for selection between two types of security restrictions. When the 
Users in Meter box is checked, the username and password of a user is used both for 
EziView and for the meter. If the box is unchecked (Figure 15-6), a logon username and 
password for accessing the meter must be entered for the group.  This is the username 
and password that is stored in the meter.  Users belonging to this group do not have their 
usernames and passwords stored in the meter – these details are only kept in the 
EziView meter setup (in the MTR file).  When these users log into EziView, EziView 
looks up the group username and password to log into the meter. 

This feature is useful where it is undesirable to give users the ability to perhaps use other 
programs to access the meter. Without the meter username and password, the only way 
the user can access the meter is via EziView, with the meter setup MTR file. The other 
advantage is that the meter only supports up to six users. By only having one user 
account in the meter for a group of users, the number of users in that group is unlimited. 
The disadvantage is that the meter can only log the connection of the user account in the 
meter (where the meter user name is displayed). This affects that ability to track 
individual access.  

With this type of group, the permissions should be set to disallow access to the security 
setup to prevent the users in the group from finding out the login password.   

From the example in Figure 15-6, the logon name ‘READ’ is stored in the meter – 
anyone knowing this username and password can log into the meter using EziView 
without the MTR file.  The ‘READ1’ and ‘READ2’ users are not stored in the meter – 
the only way these users can access a meter is if they have the original MTR file, so 
EziView can confirm their passwords then logon to the meter using the ‘READ’ 
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username and password.  Since the ‘READ1’ and ‘READ2’ users do not know the 
‘READ’ username and password, they cannot access the meter without using the 
original MTR file, and any restrictions it imposes. 

Note that if the setup is read from the meter by a user (with setup read access) without 
the original MTR file, the users of each group will not be shown, and the groups will 
appear as normal users.  This is because the users in the group are only stored in the 
original MTR file. 

Fill in the additional user information for the group as for a user (see the following 
section). This is the username and password that will be used to log into the meter.  

Right-clicking on a group gives a number of options. New Group (Ctrl-G) creates a new 
blank group. New User adds a new user to the group. Copy creates a new group with the 
same settings, and Delete deletes the group and its users.  

Users 
Users may be added to a group from the groups pop-up menu, or from another user’s 
pop-up menu. Users may be dragged from one group to another. The position of a user 
within a group makes no difference. The meter supports up to 6 users. For groups with 
user accounts in the meter each user counts as one user. For groups with user accounts 
not in the meter the group counts as one user.  

 

• Figure 15-7 EziView user setup 
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Figure 15-7 shows the settings for a user. The Username may be up to 7 characters long 
(A to Z and 0 to 9). The Full Name and Description fields are kept by EziView (not the 
meter) and are for information only.  

The Password may be from 5 to 10 characters (A to Z and 0 to 9). Enter the password 
into both the Password field and the Confirm Password field – they must match or 
EziView will not accept the new password. The password will usually be starred out. 
The Show/Hide button may be used to display the password text.    

EziView will try to protect you from writing a setup to the meter that has no 
administrator user. Care should be taken that there is always a user capable of changing 
user information. 

 

Permissions 

Clicking on the Permissions button displays the main permissions edit screen (Figure 
15-8). The security groups are arranged under a tree diagram that follows the 
arrangement of the setup pages.  

 
• Figure 15-8 Permissions Edit screen 

There are three check boxes for each security group. The left-most box allows reading 
when checked. The middle box allows writing when checked, and the right-most box 
allows modifying when checked. The Modify setting is used to prevent users from 
modifying settings in EziView. If a user is not permitted to modify or write a setting, it 
is greyed out and cannot be changed. If all of the modify settings for a setup page are 
cleared, the setup page is not displayed. Note that the bottom 3 groups Instantaneous 
Registers, Reserved, and General are always accessible.  
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When a new user group is created, it is given a default set of permissions based on the 
user level, but these can be modified to suit exact requirements.  

There are 23 security groups that affect meter setup, generally defined around setup 
pages in EziView. In addition there are another few groups that control access to 
EziView functions such as the meter Properties menu. See Table 15-2 for details.  

Security Group Description Shared 
Alarms Alarm setpoint and masks 
AlarmSagSwell Sag/Swell settings 
AlarmTamper Tamper settings 

1 

Calibration Meter Calibration (cannot be written) 
Hardware Meter Hardware (cannot be written) 

2 

Communications Optical and modem port settings 3 
TOU TOU Channel Configuration 4 
LoadSurvey LoadSurvey 1 and 2 Configuration 5 
PulseOutput Pulsing Output Settings 6 
Enunciators Enunciator Settings 
LCD LCD screens, formatting, and cycle times 

7 

PulseInput Pulsing Input Settings 
RadioInput Radio logger inputs for the wireless datahub 

8 

EventLog Event Log memory allocations 
ChinaLog China Log Options 

9 

MiscellaneousString Miscellaneous String setting 
CustomerPlantNo Plant Number (if permitted by factory setup) 

10 

Transformer Transformer Ratios 11 
TimeSetup Time source, time calibration, and Daylight Savings 12 
MemoryRemoteUpgrade Reserved memory for remote upgrade usage 13 
SecurityBillingReset Billing Reset button deactivation control 
Security Security access to the meter 

14 

TariffSetup TOU tariff calendar 
TariffChangeOver TOU changeover date 
TariffBillingReset TOU automatic billing reset settings 
TariffDemand TOU demand forgiveness settings 
RelaySetup Relay configuration 
TariffRelayDayType Relay schedule configuration 

15 

Properties EziView meter properties setting 
Also controls the meter lock icon  

All Levels 

GeneralRegister EziView General register reads and writes Level 3+ 
DisplayBillingReset EziView show Billing Reset button Level 2+ 
DisplayDateTime EziView Date/Time change Level 3+ 
DisplayDateTimeLimited EziView Date/Time change by limited amount Level 1+ 
DisplayDebug EziView allows user to change to binary mode (serial port 

diagnostics) 
Level 3+ 

DisplayNumberofBillingR
esets 

EziVIew show number of billing resets Level 3+ 

Display PulsingOutputs EziView pulsing output control in online variables Level 3+ 
Display PowerOnOffTime EziView show power on/off time Level 3+ 
Display Waveform EziView display waveform Level 3+ 

• Table 15-2 Meter permission groups 

The meter itself only stores 15 security groups, and does not store modify flags. This 
means that if a meter setup is simply read out of a meter that is not known by EziView, 
some of the permissions are not unique. The “Shared” column of Table 15-2 indicates 
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which permissions are shared. If one of a set of shared permissions is accessible to a 
user originally, then all of the shared permissions will be accessible in the setup read out 
of the meter. The modify flags are set equal to the write flags. The EziView groups (at 
the bottom of the table) are set based on the security level indicated.  

Note that to write/read setup to/from the meter you still need the basic security level 
access to do so. These permissions simply allow fine tuning of what is allowed to be 
changed by a user.  

Alternate Permissions Control 

In addition to the tree view of permissions, there is another display that simply lists the 
security groups.  They both allow the same things to be done, but are simply presented 
in a different way.  This way may be more useful when working with registers directly. 

Right-clicking on the Permissions button brings up a small menu with options for Read, 
Write and Modify.  Selecting one of these will display the setup for that type of flags 
(Figure 15-9). 

 
• Figure 15-9 Alternate permissions setup method 

All security groups are listed, along with their security group number in brackets.  The 
left hand pane shows the enabled security groups, while the right hand pane shows the 
disabled ones.  Selecting entries and selecting Enable or Disable will move them as 
directed one side to the other.  The Enable All and Disable All buttons move all entries, 
regardless of selection.  OK saves the changes, Cancel ignores the changes. 
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Permission Schemes 

With the large number of security groups it can become tedious to keep on setting up the 
same security for several users.  To overcome this EziView has Permission Schemes.  
This allows permission setups to be stored and reused.  The schemes are stored in a 
single file, the location of which may be setup in Tools → Options →Perm.Scheme 
(Figure 15-10). 

 
• Figure 15-10 Permission scheme options 

To create a permission scheme, first setup the permissions as normal.  Then enter a 
name for the scheme into the Perm. Scheme field on the Security setup page.  A save 
button will appear to the right of the field – click this button to save the new scheme.  It 
will be added to the drop down Perm. Scheme list. 

To apply a permission scheme simply select it from the drop down list.  When a scheme 
is selected, a delete button will appear to the right.  Clicking this button will delete the 
scheme. 

In order to reduce the risk of accidentally changing a scheme, the options page (Figure 
15-10) has a Read Only check box.  Checking this box stops the display of the Save and 
Delete buttons and thus prevents the schemes from being changed. 

Note that the Permission scheme does not change the Access Level – an appropriate 
access level should be selected.  The default ‘Meter Reader’ scheme would generally be 
used with a Read Only access level. 

Additional Security 

The Billing Reset Button Disable check box may be checked to disable the operation of 
the Billing Reset button on the front of the meter. The Hide Billing Reset message from 
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LCD is purely cosmetic – it simply hides the “Billing Reset” message normally shown 
on the LCD when a reset occurs.  

The Incorrect Password Attempts per Hour (0 = unlimited) setting allows a limit on the 
number of unsuccessful logins in an hour, in accordance with UK COP5 requirements.  
If the number of failed logins (due to bad username/password) during an hour exceeds 
the limit programmed here, the meter will deny any further logins until the end of the 
hour.  The count of bad logins is not reset when a successful login is made, or if power 
is lost.  It will only be reset if the meter is powered on at the end of an hour. 

Writing a new Lockout Limit to the meter does not clear the existing count of failed 
logins.  This means that if a meter for example has a Lockout Limit of 0 and already has 
had 10 bad logins in the last hour, setting the Lockout Limit to 5 will cause the meter to 
be locked out until the next hour. 

 

Config Jumper 

When the Config jumper is not fitted in the meter, there are a number of limitations 
imposed on the setup. The calibration and hardware setup cannot be written in any way. 
It also blocks lost password recovery. This is designed to offer a level of hardware 
security that only breaking the meter seals can override.  

The Configuration Jumpers button views the configuration jumper limitations, which 
are a factory setting ((introduced in firmware version 1.26).  The page shown in Figure 
15-11 is displayed, which indicates what login levels are allowed with and without the 
Config jumper. 

 
• Figure 15-11 Config Jumper Limits 

These settings would be specified at time of order, generally to control access to a level 
6 user.  The example in Figure 15-11 indicates that the Config Jumper does not block 
any normal logins (level 6 and below), but is protecting the calibration and hardware 
configuration settings.   

If ‘Level 6’ was checked then a level 6 user could not log in. 
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Clear Masks 

Users lower than a level 6 user can be blocked from clearing certain types of data. This 
was introduced in firmware version 1.26, prior to that the clear mask settings will have 
no effect.  

The Clear Masks button views the mask settings.  The page shown in Figure 15-12 is 
displayed, which indicates what sections of the meter cannot be cleared.  Of most 
interest are the Event Log, TOU, and Load Survey options.  Preventing clearing of the 
Pulsing Generators will prevent partial pulses from being cleared.   

 
• Figure 15-12 Clear Masks 

Note for EziView versions prior to 4.20 – do not block masks from Recalculate TOU 
calendar to Reset LCD Screens.  

Lost Passwords 
Care should be taken that at least one user has permission to change user security 
information.  Contact EDMI if you do manage to lock yourself out of the meter. 
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Chapter 16 Relay Outputs 
Relay outputs are a special type of output, designed to control a disconnect relay or a 
load control relay.  They are generally separate from the regular pulsing output system.  
The meter has the ability to control up to 3 relays, which may be either internal or 
external to the meter.  

Where relays are internal, they have a fixed relay number.  In the Mk7A, Relay 1 is the 
disconnect relay and Relay 2 is the load relay.  In the Mk7C and Mk10D Relay 1 is the 
disconnect relay.  Unused relay controllers can be used to drive external relays using 
pulsing outputs. 

The difference between a disconnect relay and a load control relay is subtle.  A 
disconnect relay is assumed to control an entire customer, and there are safeguards when 
turning it on or off.  A load relay is assumed to be controlling something like a hot water 
system that can be turned on and off without risk of injury, generally on a regular basis. 

Relay support is an optional edition.  The firmware edition must have the relay control 
feature for the relay settings to work.  Internal Disconnect Relays or Disconnect Via IO 
editions are needed. 
 

There are two levels that control each relay – enabled/disabled which controls if the 
relay is allowed to turn on, and connected/disconnected which controls if the relay is 
turned on.  Table 16-1 lists the possible states. 

State Description 
Disabled and disconnected The relay is not allowed to turn on, and is thus also 

off. 
Enabled and disconnected The relay is allowed to be turned on, but is off. 

Enabled and connected The relay is on. 
Disabled and connected Not possible! 

• Table 16-1 Relay states 

Depending on the relay, it can take a significant amount of energy to close or open it.  
The meter takes around 30 seconds to charge up again after a relay with these energy 
limitations has been switched, or after power on.  During this time if another switch is 
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attempted the change will be Pending, and will occur when sufficient charge has been 
reached. 

Relay Setup 
The meter supports many variations of relay organisation.  In order to handle this the 
configuration is very flexible.  Where there are internal relays in the meter their basic 
arrangement is configured in the factory.  The structure of external relays are not known 
of course, but the arrangement may be configured here. 

Figure 16-1 shows the Relay setup in EziView.  Note that the options available depend 
on what internal relays are fitted.  The heading for each relay indicates if it is internal or 
external.  The tabs select which of the 3 relays to configure. 

 

• Figure 16-1 Relay setup page 

The Current Terminal Description allows the relay to be given a name – it is 
recommended that some consistency across an installation is used here.  For instance, 
use Load 1 for hot water systems, Load 2 for pool pumps and Load 3 for heating.  This 
is effectively what the output terminal is called. 

Element sets the measurement element that measures the current going though this 
relay.  For internal relays this cannot be changed.  In the example of Figure 16-1 both 
relays are measured by the main element.  The None option is for external relays where 
the current is not measured by the meter. 
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Relay turns off all current through this element tells the meter if the current measured by 
this element should go to zero when the relay is turned off.  This is to cover situations 
where there may be a switched load and an unswitched load, both measured by the one 
element.  The meter can better detect tampering and switching faults by knowing this, 
and allows generation of the Relay Stuck event.  For internal relays this cannot be 
changed. 

Disconnect Security affects how the relay can be controlled, and the effect of the 
connect/disconnect button.  There are two sources of control – the push buttons of the 
meter, and the communications system (Remote), which includes the optical port.   

Not all options are available for each source – for example the button cannot Enable or 
Disable a relay.  These fixed settings are indicated by greyed out selections. Table 16-2 
lists the allowed options for the button.  The button always controls all 3 relays. 

Button Setting Meaning Description 

 

Button disabled The button cannot control the relay. 

 

Button can connect a 
relay 

If the relay is enabled, pushing the Connect button 
will connect it.  

 

Button can connect and 
disconnect a relay 

If the relay is enabled, pushing the Connect button 
will connect it.  If the relay is connected, pushing the 
Connect button together with the select button will 
disconnect it (but it remains enabled).   

• Table 16-2 Button Options 

Remote Options always allow a user to Enable, Disable, or Disconnect a relay.  Whether 
a relay can be connected remotely is controlled by the Connect checkbox. 

Using these setting almost any configuration of relays can be configured, whether 
internal or external.  The example of Figure 16-1 is for a Mk7C with an internal 
disconnect relay, and an external load control relay switched by a pulsing output. 

The use of pulsing outputs to control relays and indicate the state is covered in Table 
13-1 on page 13-5, using the Relay option. 

Broadcast Settings - Comms Group allows this relay to be put in part of a 
communications group.  This is to allow splitting up groups of meters in an area, so a 
single broadcast command can affect appropriate groups of meters.  0 indicates no 
group, and the range of groups is 1 to 127. 

Load Limiting configures the parameters for the load limiting functions.  These allow 
the load through the meter to be limited, and to disconnect a customer if the limit is 
exceeded for a time.  They only become active when a load control command is active 
for the relay (See Table 16-3). 

Load Limiting support is an optional edition.  The firmware edition must have the load 
limiting feature for the load limiting settings to be enabled. 
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The Source sets what quantity is measured.  The Source can be either W, var, VA, or 
current, using either a single phase/element or the maximum of all phases (I total, W 
total, VA total).  

Limit sets the maximum allowed for that quantity.  The load limiting load control 
command specifies a limit as a percentage of this settting.  This allows customers to 
have different allowed loads in a load control situation, while allowing the same load 
control command to be set out as a broadcast (eg limit all customers to 50% of there 
nominal load).  The maximum value of the limit is restricted by sensible maximums for 
the quantity – eg current on a 100A Imax meter is limited to 110A. 

Duration sets the time in seconds that the source must be over the limit for before it is 
deemed an overload and the load is disconnected.  The range is 0 to 4095 seconds 
(68.25 minutes).  The limit is tested once per second, based on a reading over 5 cycles. 

Relay Time Control 

The relays can use the abilities of the TOU calendar system to control relay switching 
times.  The RelayDayType page controls this feature as shown in Figure 16-2. 

 

• Figure 16-2 RelayDayType page 

Enabling time control for a relay allows it to be controlled by the calendar of the meter, 
in the same way the rates are controlled.  The EX2 TOU group is used for this purpose. 

The relay can be controlled either as a Load relay, or a Main relay.  As a Load relay, the 
calendar will connect and disconnect the relay when the switching time changes from 
off to on, or on to off.  If the relay state is changed between switching times, it will 
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remain in that state until the next switching state change.  This allows for the connect 
button to function as a type of boost button. 

As a Main relay, the calendar will enable and disable the relay.  In this way the times 
that the relay may be connected and disconnected can be controlled.  An example usage 
would be a holiday house which only allowed electricity to be turned on during 
weekends. 

The type of operation can be selected separately for each relay, and each relay’s switch 
times operate completely independently.  In the Day Type section, the relay to edit times 
for is selected.  In a similar way to programming rates, switching times for the 8 
different day types can be programmed.  The difference is that there is only an on and an 
off state.  The ‘Tariff Calender Setup’ section starting on page 8-10 covers the options in 
greater detail. 

The Week Type, Annuals, Specials, Seasons and Change Over Set configuration all 
affect the choice of daytype as for normal TOU rate switching.   

The relay switching times show up in the EX2 row on the WeekType configuration page 
(Figure 16-3).  The three bands show relay 1, 2, and 3.  Do not use the DayType page to 
edit the EX2 group, as it is not spit into individual relays. 

 

• Figure 16-3 Week Type page showing Relay settings 
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Online Control 

 

• Figure 16-4 Relay Control page 

The Screens→  Online Variables→  Relay Control page allows direct control of the 
meter relays, providing that appropriate permission is given.  

The relay to control is selected from the Relay ID field.  To send a command to any 
relay in a specific group check the Send to Relay Group checkbox, and select the group 
with the command.  To send a command to all relays check the Send to All Relays 
checkbox. 

Current Status shows the current state of the relay.  Current Command, Reason, Group, 
and Start show the current command, or the last command if no new command has been 
received. 

Clicking on the Enabled/Disabled or Connected/Disconnected buttons will send a 
command to change the state.  Pending will be shown if the relay needs time to charge. 

The relays are controlled by commands, and each relay can have one command queued 
up to occur, as shown in the Current Status panel. The Select an operation part of the 
screen allows various commands to be given to the relay. 

If the Relay Group is other than 0 then only those relays with that group will listen to the 
command.  The Reason Code is a number from 0 to 255 which can be used to indicate 
why the command is issued.  For instance, 1 could mean ‘non-payment’, and 2 could 
mean ‘customer moving out’. 

The available commands are listed in Table 16-3.  Note that the remote commands 
allowed are controlled by the Control Used setting on the Relay configuration page. 
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Command Description 
Connect Now The relay will be connected immediately if it is 

enabled. 
Connect Later A time is given, and at that time the relay will be 

connected if it is enabled. 
Enable Now The relay will be enabled immediately. 
Enable Later A time is given, and at that time the relay will be 

enabled. 
Disconnect Now The relay will be disconnected immediately. 
Disconnect Later A time is given, and at that time the relay will be 

disconnected. 
Disable Now The relay will be disabled immediately, which will 

also cause a disconnection if the relay is connected. 
Disable Later A time is given, and at that time the relay will be 

disabled, which will also cause a disconnection if the 
relay is connected. 

Load Control % A start and stop time is given, and a load percentage. 
During this period if the meter load goes above the 
indicated percentage of the limit then the relay will 
be disconnected. 
EziView 4.04 does not support the setting of the 
limit. 

Load Control On->Off Period A start and stop time is given, and during this time 
the load is kept off. 

Load Control Off->On Period A start and stop time is given, and during this time 
the load is kept on. 

• Table 16-3 Relay Commands 

Once the command and parameters are set, clicking the Execute button sends the 
command. 

LCD, Button and LED Interface 

These form an interface for an end user to interact with the relays.  They allow the state 
to be displayed, and the relay to be connected and disconnected. 

Pressing the ‘Connect’ button for a second will connect any relays which are 
disconnected but enabled, providing this is enabled by the setup (Table 16-2).  The LCD 
will show ‘CONNECT’ for a brief period as feedback to the user. 

Pressing the ‘Connect’ button and the ‘Select’ button together for a second to disconnect 
(but not disable) any relays which are connected, providing this is enabled by the setup 
(Table 16-2).  The LCD will show ‘DISCONNECT’ for a brief period. 

LED’s and enunciators may be configured (Outputs and Enunciators, page 13-1) to 
indicate if a specific relay is connected or disconnected.  They can also indicate the state 
- on if the relay is connected, off it is disconnected, or flashing if the relay is enabled but 
disconnected. 

A Vendor Name and Number to contact for reconnection of supply can be automatically 
displayed when the main relay is disconnected by setting them on the SystemParameters 
page (System Parameters, page 6-11). 
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Appendix AUpgrading Firmware 
The meter allows its internal software (firmware) to be upgraded in the field.  This 
allows support of new features or allows alternative features to be installed, while 
retaining the investment in hardware.   

 
• Figure A-1 System information 

While connected to a meter the Screens→  Online Variables→  System screen (Figure 
A-1) shows information about the meter.  The Hardware and Production sections 
display information used to track the meter during production.  The Software section 
gives the version of firmware currently installed (in this case 1.17).  The Edition 
indicates if this is a particular edition of the firmware, such as a Chinese language 
edition.  The edition is shown in hexadecimal (eg [00D10000] ) and with a description if 
available.  The revision is an internal tracking number. 

New versions of firmware are released from EDMI as a small file which can be loaded 
into the meter using EziView.  Upgrading a meter does not destroy data in the meter, 
nor will it affect the calibration of the meter.   
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Editions 
Editions allow multiple builds of the same firmware version to be released.  Each 
edition tailors the functionality available to support certain applications.  For instance 
support for GPRS communications may be omitted in one edition to make room for a 
different protocol.  

The edition code is represented as a hexadecimal number, eg D10000.  Each part of the 
edition code represents a different feature.  The bottom 4 digits are related to a hardware 
platform (eg the Mk10 and the Mk7 are different) – in this case, only the edition 
designed for your hardware may be used. The top digits (up to 4) are for software 
functionality (such as supporting certain communication protocols) – different editions 
can be loaded into the same meter, as long as the hardware part of the edition matches.  
The edition code and the version uniquely identify the firmware. 

Firmware is released in two formats.  The older format is a separate release file for each 
edition.  In this case the filename looks like “mk10_(0xd10000)_v119.rel”.  This is 
firmware for the Mk10, version 1.19, edition d10000.  

There is a newer format in which there is a single file that contains all editions for a 
meter type.  The filename looks like “mk10_v119.rel”, which is a Mk10 release of 
version 1.19.  This can make it simpler to distribute new firmware versions, and is the 
much preferred method as it includes extra safeguards against loading a version into the 
meter that does not match the hardware. 

There are two ways to upgrade the firmware – locally and remotely.  Locally is faster 
and does not use extra memory, while remotely is the only way to upgrade a meter via 
the modem port or remotely. 

Local Upgrade 
This mode of operation can only be used when connected locally to the meter using the 
optical port.  During the upgrade process the meter will stop for around a minute while 
the new firmware is uploaded. 

On screen of Figure A-1 there is a small icon next to the version that looks like .  If 
this icon is not present, EziView is most likely in standard mode.  Go to the Tools → 
Options →  General page.  The Level setting needs to be set to Advanced, rather than 
Standard.  

Clicking the  icon will bring up a section dialog to allow a firmware release file to 
be selected, generally with a filename extension of REL.  Clicking Open will progress to 
an information screen (Figure A-2) that allows some details of the upgrade to be 
selected. 
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• Figure A-2 Upgrading information 

The Upgrade Mode should be set to Local Upgrade in this case.  In this mode the 
Resume option has no effect.  The Info window gives some information about the 
version that is to be loaded into the meter. 

The Edition setting allows different editions of the firmware to be loaded into the meter.  
In versions of EziView before v4.03 only the same edition as is in the meter can be 
chosen.  Versions of EziView 4.03 and after allow different editions for the same 
hardware to be selected. 

Clicking Continue will start the upgrade process – a progress bar will be displayed after 
a few seconds (Figure A-3) 

 

• Figure A-3 Local upgrade progress 
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The process will take approximately 80 seconds for standard processor meters, 160 
seconds for enhanced processor meters.   During this time the meter is not recording any 
energy, and the clock is stopped.  The LCD will show “Erasing” then “Loading” during 
the process.  Once the upgrade is complete the clock should be set to account for the 
“gap” in time (EziView will generally do this automatically).  The Software fields will 
update to show the new version of the meter. 

Do not break communications during the upgrade process! 
 
If the upgrade is interrupted (e.g. communication is lost) the meter will show a message 
such as “boot 2.0  Error”, or “bl35 Error” on meters with 4 or 5 id digits (Mk7, Mk10D).  
This indicates that the meter cannot start due to an error in the firmware image (caused 
by an incomplete loading).  If this happens please contact EDMI for a program to 
recover from this situation. 
 

Remote Upgrade 
This method works by first uploading the new firmware into spare memory on the 
meter.  Once complete the meter then upgrades itself from the image.  This method can 
be used remotely as the meter will not be left in a non-working state if communications 
are lost. 

Follow the steps as per a local upgrade (“Local Upgrade” page A-2) until the Upgrading 
Information screen is displayed (Figure A-4). 

 

• Figure A-4 Remote upgrade information page 
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Select the Upgrade Mode as being Remote Upgrade.  There must be at least 56kB of 
available EEPROM memory to fit the image (56 blocks), which translates to 57344 
bytes.  For enhanced processor meters 115kB must be available.  The free blocks in the 
meter and the required blocks are both shown on this screen.  See the section “Reserved 
EEPROM” on page 4-4 for more information. 

Resume Mode is an option to allow the firmware upload to resume where it left off, 
useful if the communications link to the meter is unreliable.  It should only be used if 
upgrading from version 1.18 or later firmware. 

Enabling the Full Duplex transmission mode in the Site Properties→ Advanced page 
(Figure 2-13) can speed up transfer dramatically over a GSM modem by streaming the 
data - it overcomes much of the lag involved.  This should not be used on 2-wire 485 
connected meters, or meters located behind gateway meters. 

Clicking Upgrade will start the process.  EziView first uploads the image to the meter, 
during which time the meter operates normally.  This can take some time, several 
minutes at least.  When the upload is complete, the meter stops normal operation 
(including energy measurement), checks the image, and reprograms itself.  The LCD 
will show the progress, this takes around 50 seconds (66 seconds for enhanced 
processor meters).  If power or communications is lost at any time the meter will either 
abort the upgrade (if the programming stage had not been reached), or complete the 
upgrade when power returns.   

Note that during the reprogramming process the clock will stop for approximately 50 
seconds (66 seconds for enhanced processor meters), so the clock should be set after the 
upgrade has completed.   
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